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The LabVIEW Data Acquisition Basics Manual includes the
information you need to get started with data acquisition and
LabVIEW.

This manual supplements the LabVIEW User Manual, and assumes that
you are familiar with that material. You should also be familiar with
the operation of LabVIEW, your computer, your computer's operating
system, and your data acquisition (DAQ) board.

Organization of This Manual

The LabVIEW Data Acquisition Basics Manual is organized by parts,
which in turn are made up of chapters. The parts in this manual are as
follows.

© National Instruments Corporation

Part 1, Before You Get Started, contains all the information you
should know before you start learning about data acquisition with
LabVIEW.

Part 2, Catching the Wave with Analog Input, contains basic
information on acquiring data with LabVIEW, including acquiring
a single point or multiple points, triggering your acquisition, using
outside sources to control acquisition rates, and using control
loops for analog input and output.

Part 3, Making Waves with Analog Output, contains basic
information on generating data with LabVIEW, including
generating a single point or multiple points.

Part 4, Getting Square with Digital I/0, describes basic concepts
on how to use digital signals with data acquisition in LabVIEW,
including immediate and handshaked digital I/O.

Part 5, SCXI—Getting Your Signals in Great Condition, contains
basic information on setting up and using SCXI modules with your
data acquisition application, special programming considerations,
common SCXI applications, and calibration information.

Part 6, Counting Your Way to High Precision Timing, describes the
different ways you can use counters with your data acquisition
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application, including generating a pulse or pulses, measuring
pulse width, measuring frequency, and period, counting events,
and dividing frequencies for precision timing.

Part 7, Debugging Your Data Acquisition Application, contains a
brief explanation of ways you can debug your data acquisition
application to make sure your application is accurate and runs
smoothly.

Appendix A, Common LabVIEW Data Acquisition Questions, lists
answers to questions frequently asked by LabVIEW users.

Appendix B, Customer Communication, contains forms you can
use to request help from National Instruments or to comment on
our products and manuals.

The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric
prefixes, mnemonics, and symbols.

The Index contains an alphabetical list of key terms and topics in
this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

In Help window pictures of VI inputs and outputs,
square brackets enclose parameters whose values
you rarely need to set.

Angle brackets enclose the name of a key on the
keyboard—for example, <shift>.

A hyphen between two or more key names
enclosed in angle brackets denotes that you should
simultaneously press the named keys—for example,
<shift-delete>. Key names are lowercase.

Al device An analog input device that has Al in its name,

such as the NEC-AI-16E-4.

Am9513-based These MIO devices do not have an E- in their
device names. These devices include the NB-MIO-16,

NB-MIO-16X, NB-A2000, NB-TIO-10, and
NB-DMA2800 on the Macintosh; and the
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AT-MIO-16, AT-MIO-16F-5, AT-MIO-16X,
AT-MIO-16D, AT-MIO-64F-5 in Windows.

bold Bold text denotes menus, menu items, or dialog
box buttons or options. In addition, bold text
denotes VI input and output parameters. In the
Help window pictures of VI inputs and outputs,
boldfaced parameters are parameters whose values
you must specify.

bold italic Bold italic text denotes a note, caution, or warning.

configuration utility Configuration utility refers to NI-DAQ on the
Macintosh, WDAQCONF . EXE in Windows, and
dagconf on the Sun.

driver Driver refers to the NI-DAQ data acquisition
device driver.

DIO devices DIO devices refer to all devices with the letters
DIO in their name, unless otherwise noted.

italic Italic text denotes emphasis, a cross reference, or
an introduction to a key concept.

monospace Text in this font denotes text or characters that you
should enter literally using the keyboard. Sections
of code, programming and syntax examples, and
the proper names of files also appear in this font.

Warning: This icon to the left of bold italicized text denotes a warning, which alerts
? you to the possibility of damage to you or your equipment.

W Caution: This icon to the left of bold italicized text denotes a caution, which alerts
you to the possibility of data loss or a system crash.

Note: This icon to the left of bold italicized text denotes a note, which alerts you
to important information.
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LabVIEW Data

Types

Each VI description gives a data type picture for
each input and output parameter, as illustrated in

the following table.

Control

Indicator

Data Type

Signed 8-bit integer

Signed 16-bit integer

Signed 32-bit integer

Unsigned 8-bit integer

Unsigned 16-bit integer

Unsigned 32-bit integer

Single-precision floating-
point number

Double-precision floating-
point number

Extended-precision floating-
point number

String

1l B B EEEEEEE

Boolean

[x132]

Array of signed 32-bit
integers

Cluster

HE

HE EEE B B EEEEEEE

File Refnum

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and
terms are listed in the Glossary.
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Related Documentation

The following documents contain information that you may find
helpful as you read this manual.

e The user manuals for the data acquisition boards you use
e LabVIEW Data Acquisition VI Reference Manual

e LabVIEW Tutorial

e LabVIEW User Manual

e LabVIEW Networking Reference Manual

*  Application Note 025, Field Wiring and Noise Considerations for
Analog Signals

e Application Note 005, Thermocouples and Temperature
Measurements

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with
our products, and we want to help if you have problems with them. To
make it easy for you to contact us, this manual contains comment and
configuration forms for you to complete. These forms are in
Appendix B, Customer Communication, at the end of this manual.
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Before You Get Started

This section contains all the information you should know before you
start learning about data acquisition with LabVIEW.

Part 1, Before You Get Started, contains the following chapters.

Chapter 1, How to Use This Book, explains how this manual is
organized.

Chapter 2, Installing and Configuring Your Data Acquisition
Hardware, gets you up and running with LabVIEW and your Data
Acquisition hardware.

Chapter 3, Basic LabVIEW Data Acquisition Concepts, explains key
concepts in understanding how data acquisition works with
LabVIEW.

Chapter 4, Where You Should Go Next, serves as your map to this
manual, directing you to the chapter or chapters that discuss your
particular application.



How To Use This Book

This manual includes the basic information you need to get started with
data acquisition and LabVIEW. You should have a basic knowledge of
LabVIEW before you try to read this manual. If you have never worked
with LabVIEW, please read through the LabVIEW Tutorial Manual
before you begin. This manual shows you how to configure your
software, teaches you basic concepts needed to accomplish your task,
and refers you to common example VIs in LabVIEW. If you have used
LabVIEW for data acquisition before, you can use this book as a
troubleshooting guide. The following outline shows you what kind of
information you can find in this manual.

Part 1:

Part 2:

Part 3:

Part 4:

Part 5:

© National Instruments Corporation

Before You Get Started

How to Use This Book

Installing and Configuring Your Data Acquisition Hardware
Basic Data Acquisition Concepts

Where You Should Go Next (your map to this manual)

Catching the Wave With Analog Input

Things You Should Know about Analog Input

One-Stop Single-Point Acquisition

Buffering Your Way through Waveform Acquisition
Taking Control of Your Acquisition with Triggers
Letting an Outside Source Control Your Acquisition Rate
Using Analog I/0 Control Loops

Making Waves with Analog Output

Things You Should Know about Analog Output
One Stop Single Point Generation

Buffering Your Way through Waveform Generation

Getting Square with Digital I/0

Things You Should Know about Digital I/O
When You Need It Now - Immediate Digital I/O
Shaking Hands with a Digital Partner

SCXI—Getting Your Signals in Great Condition
Things You Should Know about SCXI
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Chapter 1

Part 6:

Part 7:

Hardware and Software Setup for Your SCXI System

Special Programming Considerations for SCXI

Common SCXI Applications

SCXI Calibration—Increasing Signal Measurement Precision

Counting Your Way to High Precision Timing
Things You Should Know about Counters
Generating a Square Pulse or Pulse Train
Measuring Pulse Width

Measuring Frequency and Period

Counting Signal Highs and Lows

Dividing Frequencies

Debugging Techniques

If you have already started a LabVIEW DAQ application, please refer
to Chapter 2, Installing and Configuring Your Data Acquisition
Hardware, to check your configuration, the appropriate application
section for information on common errors, and Part 7, Debugging
Techniques. The following flowchart shows the steps you should follow
before running your application.

LabVIEW Data Acquisition Basics Manual

( Install and Configure Your Hardware

l

Learn Basic Data Acquisition Concepts

l

Go to Your Specific Application Section

l

Review LabVIEW Example Applications

l

Learn How to Debug Your Application

)

)

)
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1. Install and Configure Your Hardware. When you install
LabVIEW, the program prompts you to have the data acquisition
(DAQ) drivers already installed. This manual guides you through
setting up NI-DAQ software with your DAQ device and SCXI
hardware. You should read any unique installation instructions for
your platform in Chapter 2, Installing and Configuring Your Data
Acquisition Hardware.

2. Learn Basic Data Acquisition Concepts. Chapter 3, Basic
LabVIEW Data Acquisition Concepts, shows you the location of
DAQ example VIs; DAQ VI organization; VI parameter
conventions; default and current value conventions; common VI
parameter definitions; error handling; channel, port and counter
addressing; limit settings, and data organization for analog
applications.

3. Go to Your Specific Application Section. Chapter 4, Where Should
You Go Next, shows you where to find information in this manual
for your application.

4. Review LabVIEW Example Application. The remaining chapters
teach you basic concepts in analog input and output, digital I/O,
counters, and SCXI. Each application section first lists example
VIs, then discusses the basic concepts needed to understand these
example VIs. Whenever possible, you should have the VI open as
you refer to these examples.

5. Learn How to Debug Your Application. Chapter 27, Debugging
Techniques, discusses the different ways you can debug your
application. This chapter helps you trouble-shoot for common
programming errors.

Now you can begin the rewarding adventure of data acquisition with
LabVIEW.
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Installing and Configuring Your
Data Acquisition Hardware

Note:
Note:
INFO

Get DAQ Device
Information VI

This chapter will get you up and running using data acquisition with
LabVIEW. The chapter contains hardware installation and
configuration instructions and some general information and
techniques.

If you are using Windows 95, please refer to the NI-DAQ Configuration
Utility online help file for installation instructions.

(Windows) The LabVIEW installer prompts you to have the NI-DAQ driver
software already installed. All National Instruments data acquisition
(DAQ) devices are also packaged with NI-DAQ driver software. The
version of NI-DAQ packaged with your DAQ device may be newer than the
version installed by LabVIEW. If you select the LabVIEW upgrade option
in the NI-DAQ installation program, it will compare the NI-DAQ versions
and it will only install the NI-DAQ drivers again if they are newer. You can
determine the NI-DAQ version in LabVIEW by running the Get DAQ
Device Information VI, located in Functions»Data
Acquisition»Calibration and Configuration.

After installing LabVIEW, follow the steps in Figure 2-1 to install your
hardware and complete the software configuration. LabVIEW uses the
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Chapter 2 Installing and Configuring Your Data Acquisition Hardware

software configuration information to recognize your hardware and to
set default DAQ parameters.

~
Install Plug-in Devices
\ 4
Use Your Configuration Utility
to Configure Devices
No Yes

\ 4

[ Install and Configure SCXI )

\ 4
[ Read Chapter 3, Basic Data Acquisition Concepts, )

and Chapter 4, Where You Should Go Now

Figure 2-1. Installing and Configuring DAQ Devices

NI-DAQ driver software provides LabVIEW with a high-level
interface to DAQ devices and signal conditioning hardware.
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Figure 2-2 shows the relationship between LabVIEW, NI-DAQ, and
DAQ hardware.

LabVIEW Vis

NI-DAQ Drivers

Data Acquisition Devices

Figure 2-2. How NI-DAQ Relates to Your System and DAQ Devices

(Macintosh) NI-DAQ for the Macintosh device drivers are bundled in
a single file that determines which drivers to load. When you restart
your computer, this file, called NI-DAQ, determines which devices are
installed in the system and loads their corresponding drivers. NI-DAQ
uses its control panel settings to determine what SCXI hardware is
configured and what the default device settings are for devices in the
computer. If you are using DMA, NI-DAQ also communicates with
NI-DMA/DSP for DMA services. When you install LabVIEW, the
installer places both of these files on your hard drive.

Note: (Windows) If you are using an EISA-A2000, you use a separate utility to
install a . CFG file from a diskette that accompanies the device.

(Windows) The NI-DAQ Driver, called NIDAQ.DLL, is installed in
your Windows system directory.

Note: (Windows NT) The NI-DAQ driver consists of two files, NIDAQ .DLL and
NIDAQNT. SYS. During installation, LabVIEW copies the NIDAQ . DLL
file to your Windows system32 directory, and the NIDAQNT . SYS file to
your Windows driver directory.
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Installing and Configuring Your Data Acquisition Hardware

LabVIEW Data Acquisition Hardware Support

National Instruments periodically upgrades LabVIEW to add support
for new DAQ hardware. To make sure that this version of LabVIEW
supports the hardware you are going to use, refer to the following

tables.
Table 2-1.  LabVIEW DAQ Hardware Support for Windows
AT Series PC Series EISA NEC External PCMCIA SCXI
Devices! Devices! Devices | Devices! Devices! Cards! Modules!
AT-A2150 Lab-PC+ EISA- NEC-AI- AMUX-64T DAQCard- SCXI-1000
AT-AO-6/10 PC-AO-2DC A2000 16E-4 SC-2040 500 SCXI-1001
AT-DIO-32F PC-DIO-24 NEC-AI- SC-2042-RTD DAQCard - SCXI-1100
AT-DSP2200 PC-DIO-96 16XE-50 SC-2043-SG 700 SCXI-1102
AT-MIO-16/16D PC-LPM-16 NEC-MIO- DAQPad-1 2002 DAQCard- SCXI-1120
AT-MIO-16DE-10| PC-OPDIO-16 16E-4 DAQPad-MIO- 1200 SCXI-1121
AT-MIO-16E-1 PC-TIO-10 NEC-MIO- 16XE-502 DAQCard- SCXI-1122
AT-MIO-16E-2 16XE-50 AO-2DC SCXI-1124
AT-MIO-16E-10 DAQCard - SCXI-1140
AT-MIO-16F-5 DIO-24 SCXI-1141
AT-MIO-16X SCXI-1160
AT-MIO-16XE-50 SCXI-1161
AT-MIO-64E-3 SCXI-1162
AT-MIO-64F-5 SCXI-
1162HV
SCXI-1163
SCXI-1163R
SCXI-12002

1LabVIEW for Windows NT does not work with the SCXI-1102, SCXI-1122, SCXI-1124, SCXI-1141, SCXI-1162HV,
SCXI-1163R, SCXI-1200, DAQPad-1200, PC-AO-2DC, PCMCIA cards, E Series devices, SC-2040, SC-2042-RTD,
SC-2043-SG, and PC-OPDIO-16.

2The SCXI-1200, DAQPad-MIO-16XE-50, and DAQPad-1200 do not work with NEC PC-9800 Series computers.
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Table 2-2.  LabVIEW DAQ Hardware Support for Macintosh

Plug-In Devices! External SCXI Modules!
Devices

DAQCard-500 NB-DIO-32F NB-AO-6 AMUX-64T SCXI-1000 SCXI-1140
DAQCard-700 NB-DIO-96 NB-A2150 SC-2040 SCXI-1001 SCXI-1141
DAQCard-1200 NB-DMA-8-G NB-A2100 SC-2042-RTD | SCXI-1100 SCXI-1160
DAQCard-DIO-24 NB-DMA2800 NB-A2000 SC-2043-SG SCXI-1102 SCXI-1161
DAQCard-AO-2DC NB-MIO-16 PCI-1200 SCXI-1120 SCXI-1162
Lab-LC NB-MIO-16X PCI-DIO-96 SCXI-1121 SCXI-1162HV
Lab-NB NB-TIO-10 PCI-MIO-16XE-50 SCXI-1122 SCXI-1163
NB-DIO-24 SCXI-1124 SCXI-1163R

If you have any other questions regarding hardware support for
LabVIEW, refer to Appendix B, Hardware Capabilities, in the
LabVIEW Data Acquisition VI Reference Manual.

Installing Your National Instruments Device

Some DAQ devices have jumpers to set analog input polarity, input
mode, analog output reference, and so on. Before you install your
device, check your hardware user manuals to see if your device has
jumpers and how to change its settings. Then, you can determine
whether you need to change any jumper settings. Be sure to record any
jumper settings that you change so that you can enter the information
correctly in the configuration utility.

(Windows) If you are using multiple DAQ devices, you might have to
change the base address switches so that the address ranges of the
devices do not overlap. You might also need to change the DMA and
IRQ level jumpers to avoid conflicts. For devices that do not have base
address switches or DMA and IRQ jumpers, these settings can be
assigned in the configuration utility, or through the operating system if
you are using Windows 95.

After you have checked and recorded your jumper settings, turn off
your computer and insert your National Instruments devices.

Note: (Windows) You may insert PCMCIA cards without turning off your
computer.

The next step depends on what type of computer you have. Go to the
appropriate section below to continue the configuration of your
devices.
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Configuring Your DAQ Device in Windows

Configuring Your DAQ Device for ISA and PCMCIA
Bus Computers

Turn your computer back on.

LabVIEW DAQ software comes with a configuration utility for
establishing all of the configuration parameters on ISA and PCMCIA
bus computers. This utility, WDAQCONF, saves the configuration
parameters in a file named WDAQCONF .CFG. In Windows NT,
WDAQCONF saves the configuration parameters in the system registry.
Use WDAQCONF to assign a device number and set the base address,
interrupt level, and DMA channels for your device.

When you install LabVIEW, the software puts WDAQCONTF in the same
directory as the LabVIEW executable. Figure 2-3 shows how your
LabVIEW program window might look in Windows after installing
WDAQCONF.

IEN

Power Up

\E

unlnztall
Labt1E

-

Power Diovan

WDADCOMF

@ﬁ

Figure 2-3. Locating WDAQConf£ in Windows

Run WDAQCONF by double-clicking on its icon in Windows.
Figure 2-4 shows the NI-DAQ Configuration Utility window, which
appears on your screen after you run WDAQCONF-.
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NI-DAQ Version 4.8.5 Configuration Utility
Options BResources 5CXI! Help

Select A Device Number

1: AT-MIO-16F-5 Dovice # ]

Configuration
2: Empty
3: Empty
4: Empty
h: Empty
6: Empty
7. Empty
8: Empty
9: Empty
10: Empty
11: Empty
12: Empty

Device Selected

Device name |AT—MID—1 6F-5

Base address
DMA channelleI EI
IRQ levels EE

Configure/Test Device # 1

Figure 2-4. NI-DAQ Configuration Utility Window

The Select a Device Number box to the left of the window shows all
the available device numbers you can use to configure your device.
Initially, all the boxes next to the device numbers read Empty. If you
have DAQ devices in your system that are already configured, they will
show up in the Select a Device Number box. When you highlight a
particular device number, the settings for that device appear in the
Device Selected area to the right. To configure your device, highlight
the device in the Select a Device Number box and click on the
Configure/Test Device # n button (n is the number of the device you
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have selected). Figure 2-5 shows the Device Number n window that
should appear.

= Device Number 1 |v | -
Configuration Device DMA JRQ Test Hardware! Help!

Device Base address DMA IRQ
AT-MIO-16F-5 [hex] 220 6}7 11
On
Off
1234%6%

Figure 2-5. Device Number N Window

Select your device type from the Devices menu. If you are using an
AT-MIO-16, AT-MIO-16D, or AT-MIO-16DE-10 device, be sure to
select the correct device subtype. If your base address, DMA, or IRQ
settings have changed from the factory defaults, select the correct
settings. Select the base address by clicking the dip switch box until the
switch positions match those on your device. Select your DMA and
IRQ settings from the choices listed in the DMA and IRQ menus.

Save these settings by choosing Configuration»Save. WDAQCONF tests
your settings at this time. If a test fails, a message appears explaining
the reason for the failure. If all tests are successful, LabVIEW saves
your settings and the device you selected appears in the Select a Device
Number box in the NI-DAQ Configuration Utility window. You have
now configured your DAQ device and saved the information.

When using WDAQCONF, you cannot assign a base address, DMA, or
IRQ setting that conflicts with another DAQ device unless you disable
the resource checking feature. Disable this feature by selecting
Options»Resource Checks, which removes the check mark beside this
menu item. You should never share base address space between
devices. You can share DMA and IRQ resources as long as the devices
sharing a resource do not attempt to use it simultaneously.
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You cannot change the Resource Checks option if you are currently
changing the configuration of any device, including SCXI modules. Make
sure all your Device Number windows and your SCXI Configuration
windows are closed before you select this option.

Refer to the Configuring and Testing Your DAQ Devices with
WDAQCONF in Windows section of this chapter for more information
on WDAQCONF.

Configuring Your DAQ Device for EISA Bus
Computers

The SETUP program shipped with the EISA bus DAQ devices copies
the EISA configuration files. The names of these files follow the
format, ! NICxxxx.CFG, where xxxx is the number in your system
that identifies each device. You must copy these files into the directory
that contains your EISA system configuration utility. If your utility is
on a disk, copy the files to that disk. The name of this utility varies with
different devices. Consult your software user manual that came with
your software for the correct utility name for your device.

If you are using an EISA-A2000, use a separate utility to install a . CFG
file from a disk that accompanies the device.

Follow these steps after you have installed your device.

1. If your system configuration utility resides on a disk, insert that
disk into drive A.

2. Turn on your computer.

Use the system configuration utility to record the base address,
DMA, and interrupt settings.

4. Restart your computer.

Start the WDAQCONF utility by double-clicking on its icon and
continue with the Configuring and Testing Your DAQ Devices
with WDAQCONF in Windows section of this chapter.

If you are installing any of the following devices, you must bypass
running the EISA system configuration utility and directly install the
devices in WDAQCONF from the Devices menu.

* All DAQCard Devices
e All DAQPad Devices

National Instruments Plug and Play devices
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Refer to the Configuring Your DAQ Device for ISA and PCMCIA Bus
Computers section of this chapter for instructions on non-switchless
devices. For Plug and Play (or switchless) devices, read the next
section.

Configuring Plug and Play (Switchless) DAQ
Devices in Windows

National Instruments MIO-E Series devices support switchless and
jumperless configuration. All resources on these devices—including
base address, DMA channels, and IRQ levels—are fully software
configurable. No dip switches or jumpers are needed to configure any
resources on these devices.

When you begin installation, the NI-DAQ installer installs a
stand-alone executable called NI-PNP . EXE in the root directory of
your boot drive. This program detects and configures any Plug and
Play devices you have in your computer. The program runs every time
you boot from your AUTOEXEC . BAT file. After configuring the Plug
and Play hardware in your system, the program generates a
NI-PNP.INT file in the same directory. This file contains
information about all the National Instruments devices in your system,
including Plug and Play devices.

The DAQ configuration utility, WDAQCONF, reads this NI-PNP.INI
file for information and automatically configures any Plug and Play
devices you have put in your computer from the last time you
configured the system. This utility also deconfigures any Plug and Play
device you have removed from your computer since the last
configuration.

You must run the appropriate DAQ configuration utility for your
system after installing a new Plug and Play device to obtain a mapping
for the newly-installed device to an NI-DAQ device number.

When your DAQ configuration utility detects a new Plug and Play
device in your computer, it assigns the first available device number to
the new device. Then, the utility assigns the default resources to the
new device (e.g., I/O address, DMA channels or IRQ levels). When
you remove your device from your computer, the configuration utility
deallocates these resources and puts an “Empty” string in the Select a
Device Number box.
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You must run your DAQ configuration utility after you install or
remove any National Instruments Plug and Play devices.

Configuring Devices with Plug and Play Software

If you already have Plug and Play software in your system, the DAQ
configuration utility operates significantly differently.

If the Plug and Play software in your system has its own separate
configuration utility, you must use the system configuration utility to
configure all National Instruments devices in your system.
Subsequently, you must run the DAQ configuration utility to assign an
NI-DAQ device number to the new device.

You must run the DAQ configuration utility after running the Plug and
Play configuration utility, or you cannot configure any system
resources for the device. Your Plug and Play configuration utility
assigns the system resources for the device.

Examples of Plug and Play software that might be already in your
system are the Plug and Play BIOS or the Intel Plug and Play Kit,
which includes the Intel Configuration Manager and has its own
configuration utility.

Configuring and Testing Your DAQ Devices with
WDAQCONF in Windows

This section describes how to use WDAQCONF to configure and test
your plug-in DAQ hardware before you write a VI. This information
applies to ISA and EISA bus computers only.
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If you have an ISA bus computer, you should have just finished saving
your device settings. A Test and Hardware menu should now be
activated in the Device Number » menu bar, as shown in Figure 2-6.

=| NI-DAQ Version 4.8.5 Configuration Utility [+]~
Configuration Options BResources SCXI! Help

Select A Device Number

1: AT-MIO-16F-5 +
: Empty L Device #

. Empty III

. Empty Device name |AT—MIO—1BF—5

2

3

4

5. Em

G Em::g Base address |[hex] 220
7

8

9

Device Selected

Emgg DMA channels IEI EI
1u§ Eﬁ.‘ig IRQ levels E E

11: Emp
12: Emnh o ConfiqurefTest Device # 1
= Device Number 1 - L]
Configuration Device DMA IRQ Test Hardware! Help!
Device Base address DMA IRQ
AT-MIO-16F-5 [hex] 220 67 11
On
off
12345

Figure 2-6. Device Configuration Window in WDAQCONTF on an ISA Bus Computer
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Clicking on the Hardware menu opens a Hardware Configuration
window, as shown in the Figure 2-7.

='| Device Number 1 | - | -
Configuration Device DMA JRQ Test Hardware! Help!

Device Base address DMA IRQ
AT-MIO-16F-5 [hex) 220 617 11

On

off
123465

= Device #1: AT-MIO-16F-5 - |*
Configuration Modify Help!

ANALOG INPUT CONFIGURATION

Polarity/Range Selected Values

E Polarity : BIPOLAR

Range :10V¥
Mode

Differential | *

Accessory: |Nnne |t

Figure 2-7. Hardware Configuration Window in WDAQCONF

In this window, you can establish default settings for parameters, such
as analog input polarity and range on a per-device basis. You can also
specify if you have an SC-2040, SC-2042-RTD, or SC-2043-SG
device, or up to four AMUX-64T devices cabled to your MIO device.
If you have an SC-2043-SG device cabled, you can click on the
Configure Accessory button and select gains on a per-channel basis.
LabVIEW uses these settings when initializing the devices instead of
the default settings listed in the descriptions of the hardware
configuration VIs. You can use the hardware configuration VIs to
override any settings already recorded by WDAQCONF . EXE.

T Note: Some DAQ devices, such as the Lab-PC+, AT-MI10-16, and AT-MIO-16D,
require hardware jumper changes in addition to software configuration.
Consult the hardware reference manual for your device for more
information.
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Note:

You can use the Test menu in the Device Number window to verify the
configuration or perform single-point analog input or output operation,
a digital input or output to specified port (or grouping of digital
channels), and/or counter measurements. When you select
Test»Analog I/0, a Test window appears as shown in the following
figure.

=] Device Number 1 ME

Configuration Device DMA IRQ Test Hardware! Help!

=] Dev #1 [+]=
Device
AT-MIO-16F-5 Analog I}O Tests for AT-MIO-16F-5
| Analog Input | | Analog Output |

Channel IE Channel IE[

Gain l:l Voltage

The errors returned by the Test window are NI-DAQ status codes—not
LabVIEW status codes. You can find the explanation for both kinds of
codes in Appendix C, Error Codes, of the LabVIEW Data Acquisition VI
Reference Manual.

Special Considerations for LabVIEW for Windows NT

Changing I/0 Page Lock Limit

Windows NT limits the total amount of memory that is non-swappable
(page-locked). The default amount of memory is determined according
to the total amount of physical memory available in your system. If you
are working with large DAQ buffers, you can increase the default I/O
page lock limit in WDAQCONF . EXE. To change the page lock limit,
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select Options»IOPageLockLimit and enter a new page lock limit.
Your changes will go into effect when you reboot and restart
Windows NT.

User Privilege Level When Using NI-DAQ

Windows NT provides different security levels for different kinds of
users. Depending on your privilege level, you have limitations on what
you can do with NI-DAQ in LabVIEW.

By default, LabVIEW DAQ applications load the NI-DAQ kernel
mode device driver on demand. Windows NT loads the NI-DAQ device
driver when you run your first LabVIEW DAQ application. Windows
NT unloads the driver when you exit LabVIEW. This default behavior
saves memory when you are not running LabVIEW DAQ applications.
Loading and unloading device drivers require the highest privilege
level, administrator level.

However, you may not want to always run your LabVIEW DAQ
application in the highest privilege level. To change the default
behavior, you need to change the NI-DAQ driver load option in the
Control Panel palette as follows.

1. Choose Control Panel»Devices.

2. Use the scroll bar and scroll down the driver list until you see
NIDAQONT.

Highlight NIDAQNT by clicking on it once.

3

4. Click on the Startup button on the right.

5. Change the startup type to Automatic and press OK.
6

Close the Devices window and the Control Panel palette.

The next time you reboot and restart Windows NT, the program
automatically loads the NI-DAQ driver when it boots. You can then log
in as any type of user and run LabVIEW DAQ applications.

Note: WDAQCONF needs to be able to load and unload the NI-DAQ device driver
on-the-fly in order to configure DAQ devices. After you change the driver
load option to automatic, you will not be able to configure any DAQ
devices through WDAQCONF. You can run WDAQCONF only in read-only
mode. If you need to configure a DAQ device, you must change the
NIDAQNT driver Startup button back to Manual and reboot Windows NT.
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Configuring Your DAQ Device Using NI-DAQ on the Macintosh

HIDA Double-click on this icon to launch NI-DAQ.
—1—]

M1 - DALl When you launch the program, NI-DAQ displays a list of all of the
devices in your computer. Each device has a small list of attributes, as
shown in Figure 2-8. The number specified in the “device” line is the
logical device number that NI-DAQ assigned to the device. You will
use this number in LabVIEW as the device number to select the device
for any operation.

= NI-DA0 "am=—0—=—]
v 4.8.0
#* [Help]|Devices |
Active Devices ki
device: 4
niame HE-RAZ000
type: 12
bus: HuBus=s
sochkeat: [
address: Oz foc00000
OMA socket: E
RTS1 bus: 1
device: 22
niame FCI-1200
type: 353
bus: FCI
sochkeat: Fz2 h
address: Q2000 1000 L]
-
Figure 2-8. NI -DAQ Device Window Listing
LabVIEW Data Acquisition Basics Manual 2-16

Turn your computer back on. You can find NI-DAQ in your control
panels folder. The NI-DAQ icon looks like the one shown to the left.
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Now show the Device Configuration window by selecting the Device
Configuration option from the menu as shown in Figure 2-9.

SO=—— NI-Dil =—=—r1—
v 4.8.0 |
’ Help | |+ Devices
- g Device Configuration
Active Deuvi : ? :
SCHI Configuration
device: Errors
name : HE=H.ZLLIL
type: 12
bus: HuBus
socket: [
address: 0z fize 00000
OMA socket: E
RTSI1 bus: 1
devijce: 22
niame FC1-1200
type: 353
bus: FCI
socket: Fz2
address: Q2000 1000
A

Figure 2-9. Accessing the Device Configuration Window in NI -DAQ

Figure 2-10 shows the NI-DAQ Device Configuration window. When
you are in the Device Configuration window of the utility, you can edit
the default settings for parameters such as analog input polarity
(bipolar—negative and positive voltages, and unipolar—only positive
voltages) and range on a per-device basis. If you are using AMUX-64T
or signal conditioning devices with your DAQ device, select the
appropriate device with the Accessories menu. LabVIEW uses these
settings when initializing the device instead of the default settings
listed in the descriptions of the hardware configuration VIs. (You can
use these VIs to change any setting recorded by NI-DAQ.) When you
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click on the name of the device, NI-DAQ displays the I/O connector for
the device, as shown in Figure 2-10.

Al GHD [ 1] 2 ]A1 GHD
ACHO [ = | 4 |ACHS
ACH1 [ 5|6 |ACHD
v 4.8.0 ACHz [ 78 |ACHIO
Help | |Device Configuration ACH31 9110 JACH11
4 [ p]| J | ACH4 [ 11 ] 12 |ACH12
- - ACHS | 13 | 14 |ACH13
NBEMID 16HL ACHE [ 15 | 16 |ACH14
1/0 Subsystem|ADC 0 | ACH? | 17 [ 18 ACH1S
Al SEMSE [ 19 [ 20 |DACO ouT

Polarity ipular Mude Differ.. DACT OUT | 21 | 22 |EXTREF
AD GMD [ 22 [ 24 |DIG GHD
HangemSpeed 42 usec ADIOOD | 25 | 26 |EDIOO
AOIOT [ 27 [ 28 |BDIOd

Accessories|None ADIOZ [20 | =0 |EDIOZ

AOIOE |31 | =2 |BOIOS
Ehannel_ DIG GHD [ 23 | 24 |+5 U
+5 U [ 35 | 36 |SCAMNCLE
Euupllng- EEIHD EXTSTROBE* | 37 | 28 |STARTTRIG*
STOPTRIG |29 | 40 |ExTCOMU+
- 344 Gainl SOURCE1 [ a1 | 42 |GATE!
auT1 [ 43 | 44 |SOURCEZ
GATEZ | 45 | 46 |ouTz
SOURCES | 47 | 48 |GATES
auTs (49 [ S0 |FouT

HE-N10-16X

Figure 2-10. Device Configuration and I/0 Connector Windows in NT -DAQ

You can also find helpful information by clicking on the Help button.
If at any time during configuration you need to view a list of the
LabVIEW DAQ error codes and their meanings, you can do so by
pulling down on the NI-DAQ menu bar, located to the right of the Help
button, and choosing Errors.

Note: Some DAQ devices, such as the Lab-NB and NB-MI10-16 devices, require
hardware jumper changes in addition to software configuration. Consult
your DAQ device hardware reference manual for more information.

Installing and Configuring Your DAQ Device in Unix

Your operating system creates an entry in the /dev directory. For
example, /dev/dag0 would mean that your first DAQ device would
be device 1,/dev/dagl would be device 2, and so on. All you have to
do is assign a device number to the device. You do this by editing the
dagconf.cfgfilein the /daqg (or the install) directory. For example,
if you wanted to assign /dev/daqg0 to device 3, you would type in
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device 3 SB-A2200 dag 0 (where SB-A2200 is your device
type).

Installing NI-DAQ Software in Unix

This section contains instructions for installing and configuring the
NI-DAQ UNIX software for the Sun SPARCstation (for SunOS 4.x and
Solaris 2.x).

Before you install the NI-DAQ, consider the following:
*  You must have super-user privilege to install the software.
*  The distribution disk is in TAR format.

Perform the following steps to install NI-DAQ.

1. Log on as a super-user (root).

2. Create a directory by entering the following command.
mkdir /usr/dag <Enter>

3. Change to this directory by entering the following command.
cd /usr/dag <Enter>

4. Copy the files from the distribution disk to this directory by
entering the following command.

tar xvf /dev/rfdOa<Enter>

5. Load the Solaris driver. Because the Solaris driver is loadable, you
do not need to link the driver with the kernel object files, rebuild
the kernel, or restart the system.

Run daginstall in your working directory and follow the
instructions in the shell script. Enter the following command.

./daginstall <Enter>

(= Note: If there is a problem with the driver software, you must unload the driver.
To unload the driver, you must have super-user privilege, and the driver
must not be in use. Unload the driver by entering the following command.

./dag_remove <Enter>

Configuring Your DAQ Device in UNIX

NI-DAQ includes a configuration utility, dagconf, to create and
modify the system configuration file that the NI-DAQ software
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requires. When you change the system configuration, you need to run
dagconf to update the system so it reflects the new configuration.

When running, dagconf displays a window that shows the current
system configuration. The box on the left side of the window displays
a list of the configured devices and their ID numbers that you use
whenever calling NI-DAQ functions. You can assign a device to any
given ID number. On the right side of the window, dagconf displays
the settings for the selected device. You set the device type and the
device file.

The device file is the file in the /dev directory that acts as the interface
between applications and the driver. When an application needs to
make a driver call, the application writes to the device file. The system
automatically creates these files. The system names the device files in
the form dagX, where X is 0 through 15. The system starts numbering
device files with dag0 and adds one for each non-data acquisition
device you install. The system numbers each device in the order the
computer probes the slots when it boots. For instance, if in a three slot
computer, you install a device in slot 1 and another device in slot 3, the
computer names the device file for the device in slot 1, dag0, and the
device file for the device in slot 3, dagl. Refer to the user manual for
your computer to determine what order your computer probes the slots.

The configuration file dagconf . c£g must be in a place when
executing NI-DAQ functions in an application. From an application,
NI-DAQ searches for the configuration file in the following places, in
the order listed.

1. current working directory

2. Jusr/dag

Installing and Configuring Your SCXI Chassis in Windows or on the
Macintosh

Hardware Configuration

Your SCXI hardware kit includes the Getting Started with SCXI
manual, which contains detailed instructions for assembling your SCXI
system, module jumper settings, cable assemblies, and terminal blocks.
The following are the basic steps to assemble your SCXI system.

1. Check the jumpers on your modules. Generally, you will leave the
jumpers in their default positions. However, the Getting Started
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with SCXI manual has a section for each module type that lists
cases where you may want to change the jumper settings.

Turn off the chassis power. Plug your modules in through the front
of the chassis. You can put the modules in any slot. For simplicity,
start with slot 1 on the left side of the chassis and move right with
each additional module. Be sure to screw the modules tightly into
the chassis frame.

If you are using an SCXI-1180 feedthrough panel, you must install
the SCXI-1180 in the slot immediately to the right of the module
that you will cable to the DAQ device. Otherwise, the cable
connectors may not fit together conveniently.

If you have more than one chassis, select a unique jumpered
address for each additional chassis by using the jumpers directly
behind the front panel of the chassis.

Plug the appropriate terminal blocks into the front of each module
and screw them tightly into the chassis frame.

If you are using a DAQ device in your computer to control your
SCXI chassis, connect the mounting bracket of the SCXI-134x
(where x is a number) cable assembly to the back of one of the
modules and screw it into the chassis frame. Connect the other end
of the cable to the DAQ device in your computer. In multiplexed
mode, you only need to cable one module to the DAQ device. In
most cases it does not matter which module you cable. The
following are two special cases where you should cable a specific
module to the device.

a. If you are using SCXI-1140 modules along with other types of
modules, you need to cable one of the SCXI-1140 modules to
the DAQ device.

b. If you are using analog input modules and other types of
modules, you need to cable one of the analog input modules to
the DAQ device.

Refer to the Getting Started with SCXI manual for more
information on related topics, such as multichassis cabling.

(Windows) If you are using the SCXI-1200 module to control your
chassis, connect one end of the parallel port cable to the back of
the SCXI-1200 and connect the other end of the cable to the
parallel port on your PC.

Turn on your chassis power.
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Software Configuration in Windows

To use SCXI with LabVIEW, you must enter the configuration for each
SCXI chassis using WDAQCONF. Click on the SCXI menu in the
WDAQCONF to bring up the SCXI Configuration window shown in
Figure 2-11.

= SC¥I Configuration v |-
Configuration Help!

Chassis ID
Chassis Type
Chassis Address

Communication Mode ‘Sg[ial using DIO port |1|

Communication Path |[Dev # 1] AT-MIO-16F-5 |!|

rSlot Configuratio

Chassis Slot
Module Type

Configure Module 1

Figure 2-11. SCXI Configuration Window in WDAQCONF

1. Leave the Chassis ID set to 1 if you have only one chassis. Use
this number to access the SCXI chassis from your application. If
you have multiple chassis, advance the Chassis ID to the next
chassis every time you finish configuring a chassis.

2. Select the appropriate Chassis Type for your chassis. This enables
the remaining fields on the panel.

3. The Chassis Address field applies only to the SCXI-1001 chassis.
If you have only one chassis, leave this field and the address
jumpers on your SCXI-1001 set to 0. If you have additional
chassis, you need to select a unique hardware-jumpered address
for each chassis and enter it in the Chassis Address field.
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Leave the Communication Mode and Communication Path
fields alone. WDAQCONTF sets these fields automatically after you
enter the module information in step 5.

Enter the configuration for each slot in the chassis. The fields in
the Slot Configuration sections of the window reflect the settings
for the selected Chassis Slot number. Refer to your SCXI chassis
hardware manual to determine how the slots in a chassis are
numbered. You must set the following fields for each SCXI
module you install.

Module Type. Select the correct module type for the module
installed in the current slot. If the current slot does not have a
module, leave this field set to empty and advance the Chassis Slot
number to the next slot. Click on the Configure Module n (where
n is your module number) button to bring up the Module
Configuration window for the remaining fields. Figure 2-12 shows
this window.

1= Configuring chassis slot 1

Cabled Device |[Dev # 1) AT-MID-16F-5 |+ |

Operating Mode | Multiplexed | * |

Terminal Block |13l]l] |+| Return

hannel Configuration™

Gain « 1.0
Ftter

* Lab¥IEW only

© National Instruments Corporation

Figure 2-12. SCXI Module Configuration Window in WDAQCONF

a. Module Type. This number reflects the number of the SCXI
Module that you chose in the main SCXI Configuration window.
If you want to change the Module Type, you must do so from the
SCXIT Configuration window.
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Cabled Device (or Logical Device for SCXI-1200). If the
module is an SCXI-1200, WDAQCONTF selects a logical device
number. Otherwise, if the module in the current slot is directly
cabled to a DAQ device in your computer, set this field to the
device number of that DAQ device. Leave the Cabled Device
field at None if the module in the current slot is not directly
cabled to a DAQ device. If you are operating your modules in
multiplexed mode, you only need to cable one module in each
chassis to your DAQ device. If you are not using multiplexed
mode, refer to the SCXI Operating Modes section of

Chapter 17, Hardware and Software Setup for Your SCXI
System, for instructions about module cabling.

Operating Mode. The system defaults to the multiplexed
operating mode, which is recommended for almost all SCXI
applications. The operating modes available for each SCXI
module type are discussed in the SCXI Operating Modes
section of Chapter 17, Hardware and Software Setup for Your
SCXI System.

For the SCXI-1200, two modes are available—SCXI
multiplexed and stand-alone. In the SCXI multiplexed mode,
you can use the SCXI-1200 to communicate with other
modules in the same chassis. In stand-alone mode, you can
use the SCXI-1200 only as a stand-alone DAQ device. You
cannot communicate with other modules in stand-alone mode,
but using this mode does make the digital ports normally
reserved for SCXI operation available.

If the module in this slot is an SCXI-1200, you must also
configure the following fields.

Connected To... .The parallel port address to which the
SCXI-1200 is cabled. You must select which parallel port you
have cabled the module to (LPT1, LPT2, and so on), and
WDAQCONF will detect the addresses of the parallel ports in
your system.

IRQ Level. The interrupt level used by the parallel port.
During a data acquisition or waveform generation on the
SCXI-1200, NI-DAQ services parallel port interrupts to
transfer data between the SCXI-1200 and your PC memory.
This IRQ level must correspond to the IRQ level used by the
parallel port to which the SCXI-1200 is connected. On most
PCs, LPT1 uses IRQ Level 7 and LPT2 uses IRQ Level 5. If
you are using an EPP parallel port card, you can choose the
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IRQ level by setting a jumper on the card; then enter the IRQ
Level in this field.

If the module in the slot is not an SCXI-1200, you must
configure the following fields.

Terminal Block. Select the terminal block you are using with
this module, if any.

If the module is an analog input module, enter the gain
settings and the filter settings (if applicable for your module
type) in the Channel Configuration section. If your terminal
block applies gain to your SCXI input channels, enter those
gain settings in this section as well.

Press the save button to save this module configuration. To go
back to the SCXI Configuration window to configure the next
module, press the return button.

The SCXI Configuration window has a Help window with entries for
each input field that you can refer to if you have other questions.

Software Configuration on the Macintosh

To use SCXI with LabVIEW, you must enter the configuration for each
SCXI chassis using NI-DAQ. Select SCXI Configuration in the
NI-DAQ menu bar to bring up the SCXI Configuration window as
shown in Figure 2-13.

© National Instruments Corporation
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SO=—— NI-DAQ =——
v Devices

- v Device Configuration
GENSL Errors

SCHI Configuration ;.
1/0 SubsystEMATC O

|
Polarity|Bipolar |Mode|Differ... |
Range|20 |Speed|42 psec |
Accessories|None |

Channell]| 0 [
Coupling|DC | Gain|1 |
L - FEREE Gaind

Figure 2-13. Accessing the NI-DAQ SCXI Configuration Window on the Macintosh

Figure 2-14 shows NI-DAQ with the SCXI Configuration window
selected.

SO0=—— NI-DAil —=———"rD0—

w[ _ _4.B.I]

Help ] [SCHI Configuration

|
Chassis[=] 1 [=]]:[scH1-1001 |

HddressEl
Method[Serial | Path[None |
Module[<] 1 [&z):[scHI-1120 |

Cabled I]eui[:e

Operating Mude
Channel=] 0 [

Filter[4Hz____ | Gain[1000

fnpul Mods

Figure 2-14. SCXI Configuration Window in NI -DAQ
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Leave the Chassis set to 1 if you have only one chassis. You will
use this number to access the SCXI chassis from your application.
If you have multiple chassis, advance the Chassis to configure the
next chassis after you finish configuring the first chassis.

Select the appropriate chassis type for your chassis. This enables
the remaining fields on the panel.

If you have only one chassis, leave the Address field and the
address jumpers on your SCXI chassis set to 0. If you have
additional chassis, you need to select a unique hardware-jumpered
address for each chassis and enter it in the Address field.

Leave the Method set to Serial, which means that LabVIEW
communicates with the chassis serially using a DIO port of the
plug-in DAQ device. The Path sets itself automatically to the
device number of the appropriate DAQ device when you enter the
Cabled Device information in step 5b.

Enter the configuration for each slot in the chassis. The fields in
the bottom two sections of the window reflect the settings for the
selected Module number. Refer to your SCXI chassis hardware
manual to determine how the slots in a chassis are numbered. You
must set the following fields for each SCXI module you install.

a. Module type. Select the correct module type for the module
installed in the current slot. If the current slot does not have a
module, leave this field set to None and advance the Module
number to the next slot.

b. Cabled Device. If the module in the current slot is directly
cabled to a DAQ device in your computer, set this field to the
device number of that DAQ device. Leave the Cabled Device
field set to None if the module in the current slot is not
directly cabled to a DAQ device. If you are operating your
modules in Multiplexed mode, you need to cable only one
module in each chassis to your DAQ device. If you are not
using multiplexed mode, refer to the SCXI Operating Modes
section of Chapter 17, Hardware and Software Setup for Your
SCXI System, for instructions about module cabling.

c. Operating Mode. The system defaults to the multiplexed
operating mode, which is recommended for almost all SCXI
applications. The operating modes available for each SCXI
module type are discussed in the SCXI Operating Modes
section of Chapter 17, Hardware and Software Setup for Your
SCXI System.
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If the module is an analog input module, enter the gain and
filter settings for each channel in the bottom section of the
window. The system disables the Channel control for any
modules that use only one gain and filter setting for the entire
module.

Now that you have successfully installed and configured your DAQ
hardware for LabVIEW, read Chapter 3, Basic Data Acquisition
Concepts, for more information on data acquisition with LabVIEW.

LabVIEW Data Acquisition Basics Manual
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Basic LabVIEW Data Acquisition
Concepts

Before you start building your data acquisition (DAQ) application, you
should know some of the following basic LabVIEW DAQ concepts.

* Location of Common Examples

e Locating the Data Acquisition VIs in LabVIEW
* DAQ VI Organization

e DAQ VI Parameter Conventions

*  Default and Current Value Conventions

e Common DAQ VI Parameters

e  Error Handling

e Channel, Port, and Counter Addressing

e Limit Settings

e Data Organization for Analog Applications

If you do not already understand basic programming concepts in
LabVIEW, refer to your LabVIEW Tutorial Manual and LabVIEW User
Manual for help with programming in LabVIEW.

Location of Common DAQ Examples

The DAQ examples address many common applications involving data
acquisition in LabVIEW. You can find these examples in
labview\examples\daq. The following list briefly describes the
VI libraries (designated by “library name”.1l1lb) and directories
located in the daq directory.

anlog_io.1l1lb contains VIs for analog I/0O control
loops.
anlogin contains VIs that perform analog input

and can write or stream the acquired
data to disk.
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anlogout.1llb contains VIs that generate single
values or multiple values (waveforms)
to output through analog channels.

counter.1llb contains VIs that count the rising and
falling edges of TTL signals, generate
TTL pulses, and measure the
frequency and period of TTL signals.

digital contains VIs that perform immediate
digital I/O and digital handshaking.

run_me.llb contains VIs that perform basic
operations concerning analog I/O,
digital I/0, and counters.

Each chapter in this manual teaches the basic concepts behind several
of the DAQ examples. For a brief description of any example, open the
example VI and choose Windows»Show VI Info for a text description
of the example. You can also choose Help»Show Help to open the Help
window. When the Help window is open, you can put your cursor over
any front panel or block diagram item and see a description of that item
in the window.

Locating the Data Acquisition Vis in LabVIEW

You can find the Data Acquisition VIs in the Functions palette from
your block diagram in LabVIEW. When you put your cursor over each
of the icons in the Functions palette, LabVIEW displays the palette
name you are about to access at the top of the Functions palette. You
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can find the Data Acquisition icon near the bottom of the Functions
palette, as shown in Figure 3-1.

] Functions

Data Acquisition Display of Palette Name
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Figure 3-1. Accessing the Data Acquisition Palette
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The Data Acquisition palette contains six subpalette icons that take
you to the different classes of DAQ VIs. Figure 3-2 shows what each
of the icons in the Data Acquisition palette means.

Analog Output VIs  Digital /0 Vs
ED Data Acquisiti

] ] ]
= “ul E""‘: E""‘: l——1 Counter Vls

k
Analog Input Vis —mt
0o
k

k
Calibration and _._E" £
Configuration Vis e,
 —

Signal Conditioning Vls

Figure 3-2. Data Acquisition Palette Description

DAQ VI Organization

In most of the DAQ subpalettes, the VIs are arranged in different levels
according to their functionality. You can find some of the following
four levels of DAQ VIs within the DAQ VI subpalettes.

e Easy VIs

e Intermediate VIs
* Utility VIs

e Advanced VIs
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A good example of a palette that contains all of the available levels of
DAQ VIs is the Analog Input palette. Figure 3-3 shows this palette.

EEQ] Analog Input

Al Al Al Al e—— Easy Analog Input Vis
HULT T || HOLTET || OME FT || OME FT

Al Al Al Al Al H
cobris | | =TART || READ ||s-scan || cLERR K‘;‘;omgemﬁ\”s
A28 acBl | a8l B B
Advanced
Analog Input Vis

Analog Input Utility VIs

Figure 3-3. Analog Input VI Palette Organization

Easy Vls

The Easy VIs perform simple DAQ operations and are typically the
first row of VIs in the DAQ palettes. You can run these VIs from the
front panel or use them as subVIs in basic applications.

These VIs are stand-alone in that you only need one Easy VI to perform
each basic DAQ operation. Unlike intermediate- and advanced-level
VIs, Easy VIs automatically alert you to errors with a dialog box that
asks you to stop the execution of the VI or to ignore the error.

The Easy VlIs are actually composed of Intermediate VIs, which are in
turn composed of Advanced VIs. The Easy VIs provide a basic,
convenient interface with only the most commonly used inputs and
outputs. For more complex applications, you should use the
intermediate- or advanced-level VIs for more functionality and better
performance.

Refer to your particular type of VI in the LabVIEW Data Acquisition VI
Reference Manual for specific VI information.

Intermediate Vls

The Intermediate VIs have more hardware functionality and efficiency
in developing your application than the Easy VIs. Actually, the
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Utility Vis

Advanced Vis

Intermediate VIs contain groups of Advanced VIs, but they use fewer
parameters and do not have some of the more advanced capabilities.

Intermediate VIs give you more control over error-handling than the
Easy VIs. With each VI, you can check for errors or pass the error
cluster on to other VIs.

The Utility VIs, found in many of the LabVIEW DAQ palettes, are also
intermediate-level VIs and thus have more hardware functionality and
efficiency in developing your application than the Easy VIs. Read the
previous Intermediate VIs section for more information on how these
operate.

The Advanced VIs are the lowest-level interface to the DAQ driver.
Very few applications require the use of the Advanced VIs. Use the
Advanced VIs when the Easy or Intermediate VIs do not have the
inputs necessary to control an unusual DAQ function. Advanced VIs
return the greatest amount of status information from the DAQ driver.
This manual primarily focuses on applications using the Easy or
Intermediate VlIs.

VI Parameter Conventions

In each LabVIEW DAQ VI front panel or Help window, the
appearance of the control and indicator labels denote the importance of
that parameter. Control and indicator names in bold typically must be
wired to a node on the block diagram for your application to run.
Controls and indicators not necessary for your program to operate
appear in plain text. You rarely need to use the parameters with labels
in square brackets ([ ]). Keep in mind that these conventions apply only
to the information in the Help window and on the front panel. Both this
manual and the LabVIEW Data Acquisition VI Reference Manual list
all parameter names in bold to distinguish them from other elements of
the text. The default inputs appear in parentheses to the right of the
parameter names.

Figure 3-4 illustrates these Help window parameter conventions for
the AI One Scan VI. As the window text for this VI indicates, you
should wire the device, channels, error in, and iteration input
parameters and the voltage data and error out output parameters. In
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order to pass error information from one VI to another, connect the
error out cluster of the current VI to the error in cluster of the next VI.
The coupling & input config, input limits, and output units input
parameters and the binary data output parameter are optional
parameters. You rarely need to use the number of AMUX boards
parameter.

coupling & input config (no change :0) =
input limits (no change) e

device o = rvoltage data
channels (0) ¥ 1'5': - hinary data
output units Cvolts (1) ——— ™
error in {no error) ':l\—JL_' error out
iteration (init:0)
[nurnber of ALY boards] (0) ——

Figure 3-4. LabVIEW Help Window Conventions for the Al Single VI

Default and Current Value Conventions

To use the DAQ VIs, you should know the difference between a default
input, a default setting, and a current setting. A default input is the default
value of a front panel control. When you do not wire an input to a terminal
of a VI, the default input for the control associated with that terminal
passes to the driver. In the Help window, default inputs appear in
parentheses to the right of the parameter names. A default setting is a
parameter value recorded in the driver. The current setting is the value of
a control at any given moment. The default setting of a control becomes
the current setting and remains so until you change the value of the control.

In many cases, a control input defaults to a certain value (most often
0), which means you can use the current setting. For example, the
default input for a parameter may be do not change the
current setting, and the current setting may be no AMUX-64T
boards. If you change the value of such a parameter, the new value
becomes the current setting.

Common DAQ VI Parameters

The device input on analog 1/0, digital I/O, and counter VIs specifies
the number assigned to your DAQ device in the DAQ configuration
software. Your software assigns a unique number to each DAQ device.
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The device parameter usually appears as an input to the configuration
VIs. Another common configuration VI output, task ID, assigns your
specific I/0 operation and device a unique number that identifies it
throughout your program flow. The task ID can also contain group
information about the channels and gain used in your operation. For
basic tests and calibrations, you can wire the device parameter into the
task ID.

Some DAQ VIs perform either the device configuration or the I/O
operation, while other DAQ VIs perform both configuration and the
operation. The VIs that handle both functions have an iteration input.
When your VI has the iteration set to 0, LabVIEW configures the
DAQ device and then performs the specific I/0 operation. For iteration
values greater than 0, LabVIEW uses the existing configuration to
perform the I/O operation. You can improve the performance of your
application by not configuring the DAQ device every time an I/O
operation occurs. Typically, you should wire the iteration input to an
iteration terminal in a loop as shown in the following illustration.

|l5.l wWaveform Scan.vil

Ear =
‘WAYE

Wiring the iteration input this way means the device is only
configured on the first I/O operation. Subsequent I/O operations use
the existing configuration.

Error Handling

Each Easy VI contains an error handling VI. A dialog box appears
immediately if an error occurs in an Easy VI.

Every Intermediate and Advanced VI contains an error in input cluster
and an error out output cluster as shown in Figure 3-5. The clusters

LabVIEW Data Acquisition Basics Manual 3-8 © National Instruments Corporation



Chapter 3  Basic LabVIEW Data Acquisition Concepts

contain a Boolean that indicates whether an error occurred, the code for
the error, and source or the name of the VI that returned the error. If
error in indicates an error, the VI passes the error information to error
out and does not execute any DAQ functions.

error in (no error) error out

code code

source source

Figure 3-5. The Error In Input and Error Out Output Error Clusters in LabVIEW

For more information on error handling, refer to Part 7, Debugging
Your Data Acquisition Application, in this manual.

Channel, Port, and Counter Addressing

The Analog Input and Analog Output VIs have a channel list parameter
where you can specify the channels from which the VIs read or to
which they write. The Digital Input and Output VIs have a similar
parameter, called port list and the equivalent value is called counter
list for the Counter VI’s. For ease of understanding of channel
addressing concepts, the channel list, port list, and counter list
parameters are referred to as channel list in this section. Any special
exceptions for these parameters will be noted.

Each channel you specify in the channel list becomes a member of a
group. For each group, you can acquire or generate data on the
channels listed in the group. VIs scan (during acquisition) or update
(during generation) the channels in the same order they are listed. To
erase a group, pass an empty channel list and the group number to the
VI or assign a new channel list to the group. Changing groups can only
be done at the Advanced VI level. Refer to the LabVIEW Data
Acquisition VI Reference Manual for more information.

The channel list can be an array of strings or, as with the Easy VlIs, a
scalar string control. If you have a channel list array, you can use one
channel entry per array element, specify the entire list in a single
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element, or use any combination of these two methods. For instance, if
0, 1, and 2 are your channels, you can specify a list of channels in a
single element by separating the individual channels by commas—for
example, 0, 1, 2. Or, because O refers to the first channel in a
consecutive channel range and 2 refers to the last channel, you can
specify the range by separating the first and last channels with a
colon—for example, 0:2.

Note: Keep in mind that some Macintosh devices require either 1 or an even
number of channels.

Some Easy and Advanced Digital VIs and Intermediate Counter VIs
only need one port or counter to be specified. Refer to the LabVIEW
Data Acquisition VI Reference Manual for more information or choose
Help»Show Help and put your cursor on the VI to view the VI Help
window for the VI you intend to use.

LabVIEW recognizes three types of analog channels on a DAQ device:
onboard, AMUX-64T, and SCXI channels. It recognizes two types of
digital ports and counters: onboard and SCXI. This section discusses
addressing onboard channels, ports, and counters. AMUX-64T
addressing is discussed later in Chapter 5, Things You Should Know
about Analog Input. SCXI channel, port, and counter addressing is
discussed in Chapter 16, Things You Should Know about SCXI.

Onboard channels refer to analog or digital I/O channels provided by
the plug-in DAQ device. If x is an onboard channel, you can specify
this by entering x or OBx as the channel list element. Refer to the
description of your device in your hardware user manual for
restrictions on channel order. The following illustration shows several
ways you can address onboard channels 0, 1, and 2. The top three
examples apply to VIs whose channel parameters are string arrays. The
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bottom two examples apply to VIs whose channel parameters are scalar
strings.

|I2hanne-1 String Array I:u:-ntr'-:nll

|I2hann91 String A ay D:-ntr'-:-]l
O [e—

|I:hannel String I:u:nntr-:|1|
o= |

|I:hannel String Contraol
a,1.2

Note: Refer to Appendix B, Hardware Capabilities, in the LabVIEW Data
Acquisition VI Reference Manual for the number of channels your device
can acquire data from at one time.

Limit Settings

Limit settings are the maximum and minimum voltages of the analog
signal(s) you are measuring or generating. The pair of limit setting
voltages can be unique for each analog input or output channel. For
analog input applications, the limit setting voltages must be within the
voltage range for the device. For more information on the voltage range
for your device, refer to Chapter 5, Things You Should Know about
Analog Input.

Each pair of limit setting voltages forms a cluster. (Analog output
limits have a third member, the reference source; but, for simplicity,
LabVIEW refers to limit settings as a pair of voltages.) LabVIEW uses
an array of these clusters to assign limits to the channels in your
channel string array.
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As the previous Channel, Port, and Counter Addressing section
explains, LabVIEW uses an array of strings to specify which channels
belong to a group. Also, remember LabVIEW lists as few as one
channel to as many as all of the device’s channels in a single array
element in the channel string array. LabVIEW also assigns all the
channels listed in a channel string array element the same settings in
the corresponding limit settings cluster array element. Figure 3-6
illustrates one case of this.

Channel

String

Array

Limi't h1gh Tirnit h1gh Tirnit h1gh Tirnit
s : :
Array Towr Timnit 1|:-w Tirnit Tovwr Tirnit

Figure 3-6. Limit Settings, Case 1

In this example, channels 0:3 (or 0, 1, 2, and 3) are assigned limits of
10.00to-10.00 volts. Channel 4 has limitsof 5.00to -5. 00 volts.
Channels 5, 6, and 7 have limit settings of 1.00 to 0.00 volts.

If the limit settings cluster array has fewer elements than the channel
string array, LabVIEW assigns any remaining channels the limit
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settings contained in the last entry of the limit settings cluster array.
Figure 3-7 illustrates this case.

Channel
String
Array

Limit
Settings
Cluster
Array

Tow Tirmit

;|

Figure 3-7. Limit Settings, Case 2

In this example, channels 0, 1, 2, and 3 have limits of 10.00 to
-10.00 volts. There are more channels left, but the limit settings
cluster array is exhausted. Therefore, the remaining channels (4, 5, 6,
and 7) are also assigned limits of 10.00 to -10.00 volts.

The Easy I/O Analog Input VIs have only one pair of input limits. This
pair forms a single cluster element. All channels scanned with these
VIs have identical limit settings. The Easy Analog Output VIs do not
have limit settings. All the Intermediate VIs, both analog input and
output, have the channel string array and the limit settings (or input
limits) cluster array on the same VI. Assignment of limits to channels
works exactly as described above. Refer to the LabVIEW Data
Acquisition VI Reference Manual for more information on how to assign
limit settings to a particular analog channel using the Advanced Vls,
the Group Config VI and the Hardware Config VI.

In analog applications, you not only specify the voltage range of the
signal, you must also specify the voltage range and the polarity of the
device. A unipolar voltage range is a range containing either positive
or negative voltages, but never both. A bipolar voltage range is a range
that has both positive and negative voltages. When a device uses
jumpers or dip switches to select its voltage range and polarity, you
must enter the correct jumper setting in the configuration utility. In
DAQ hardware manuals and in the configuration utility, you may find
the word gain. Gain is the amplification or attenuation of a signal.
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Most National Instruments DAQ devices have programmable gains (no
jumpers), but some SCXI modules require the use of jumpers or dip
switches. For all DAQ devices used with LabVIEW, the gain is
determined by limit settings, so you never have to figure out the gain.
However, for some SCXI modules, you must enter the gain in the
configuration utility.

Data Organization for Analog Applications

If you acquire data from more than one channel multiple times, the data
is returned as a two-dimensional (2D) array. If you were to create a 2D
array and label the index selectors on a LabVIEW front panel, the array
might looks like Figure 3-8.

row
column

Figure 3-8. Example of a Basic 2D Array

The two vertically-arranged boxes on the left are the row and column
index selectors for the array. The top index selects a row and the
bottom index selects a column.

You can organize data for a 2D array in one of two ways. First, you can
organize the data by rows. If the array contained data from analog input
channels, this would mean that each row holds data from one channel.
Selecting a row selects a channel. Selecting a column selects a scan of
data. This ordering method is often referred to as row major order.

When you create data in a nested For Loop, the inner loop creates a row
for each iteration of the outer loop. If you were to label your index
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selectors for a row major 2D array, the array might look like
Figure 3-9.

channel
scan |

Figure 3-9. 2D Array in Row Major Order

You can also organize 2D array data by columns. The Analog Input VIs
in LabVIEW are organized in this way. Each column holds data from
one channel, so selecting a column selects a channel. Selecting a row
selects a scan of data. This ordering method is often called column
major order. If you were to label your index selectors for a column
major 2D array, the array might look like Figure 3-10.

scan
channel

Figure 3-10. 2D Array in Column Major Order

To graph a column major order 2D array, you must configure the
waveform chart or graph to treat the data as transposed by turning on
this option in the graph pop-up menu.

Note: This option appears in gray until you wire the 2D array to a graph. If you
need to convert the data to row major order, select Functions»Array &
Cluster»Transpose 2D Array.

If you want to extract a single channel from a column major 2D array,
use the Index Array function from Functions»Array & Cluster. Add
a dimension so that you have two black rectangles in the lower left
corner. The top rectangle selects the row and the bottom rectangle
selects the column. Pop-up on the row rectangle and select Disable
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Indexing. Now, when you select a column (or channel) by wiring your
selection to the bottom rectangle, the Index Array function produces
the entire column of data as a 1D array, as shown in Figure 3-11.

Colurnn rnajor

20 Array Index Array
Single Channel

[DBL]

Channel

Figure 3-11. Extracting a Single Channel from a Column Major 2D Array

Analog output buffers that contain data for more than one channel are
also column major 2D arrays. To create such an array, first make the
data from each output channel a 1D array. Then select the Build Array
function from Functions»Array & Cluster. Add as many input
terminals (rows) to the Build Array terminal as you have channels of
data. Wire each 1D array to the Build Array terminal to combine these
arrays into a single row major 2D array. Then use the Transpose 2D
Array function to convert the array to a column major array. The
finished array is ready for the AO Write VI, as shown in Figure 3-12.

Channel 0 Transpose _
20 Array Colurnn rmajor

20 Array
[DBL]

Build Array

Channel 1

Figure 3-12. Analog Output Buffer 2D Array

Now that you have read some basic LabVIEW DAQ concepts, you can
go to the section(s) that discuss your specific application. In the
following chapter, Chapter 4, Where You Should Go Next, you can
answer questions about your application to narrow down where you
should go next for help in this manual.
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Where You Should Go Next

This section directs you to the chapter in the manual best suited to
answer questions about your data acquisition application. You answer
a series of questions that help determine the purpose of your
application. The questions start very broad and narrow in scope until
you are referred to a specific section in the manual dealing with your
type of application.

Note: You should always read the “Things You Should Know’’ chapter preceding
the chapter specific to your application. The “Things You Should Know”
chapters teach you about basic concepts dealing with your application.

Use the following flowchart as a guide as you answer the questions that
follow it. The questions should pinpoint the sections in the manual that
you should read for your particular application.
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LabVIEW Data Acquisition Basics Manual 4-2 © National Instruments Corporation



Chapter 4  Where You Should Go Next

Questions You Should Answer
1. Measuring Device: DAQ Device or SCXI Module?

Are you working in a noisy environment? If you are, then you may
have Signal Conditioning eXtensions for Instrumentation (SCXI)
modules connected to your DAQ device or the parallel port of your
computer. SCXI modules can filter and isolate noise from signals.
They can also amplify low voltage or current signals. SCXI modules
expand the number of channels to acquire or generate data.

DAQ devices are primarily used alone when extra signal conditioning
is not necessary.

If you are using a DAQ device, then read question 2. If you are using
SCXI, go to Part 5, SCXI—Getting Your Signals in Great Condition.

2. Analog or Digital Signal Analysis?

Does your signal have two discrete values that are TTL logic signals?
If so, then you have a digital signal. Otherwise, you have an analog
signal. The type of information you would need to know from an
analog signal is the level (discrete value), shape, and frequency
content.

Analog or Digital Signal Acquisition or Generation?

If you want to measure and analyze signals from a source outside the
computer, you want to acquire signals. If you want to send signals to
an outside instrument to control its operation, then you want to
generate signals.

If you want to acquire analog signals, go to question 4. If you want to
generate analog signals, refer to question 5. If you want to acquire and
generate analog signals, refer to the Using Analog I/0 Control Loops
section of Chapter 6, One-Step Single-Point Acquisition.

If you want to acquire or generate digital signals, read the next
question.

3. Digital or Counter Interfacing?

Digital I/O interfaces primarily control events, such as turning external
equipment on or off or sense logic states, such as the on/off position of
the switch. Counters generate individual digital pulses or waves and
count digital events, like how many times a digital signal rises or falls
in value.
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If you are performing digital I/O, refer to question 7. If you need to use
counters, read question 8.

4. Single-Point or Multiple-Point Acquisition?

Do you want to acquire a voltage value(s) at one time or over a period
of time at a certain rate? If you read a value at a given instant of time,
you are performing single-point acquisition. If you read values over a
period of time at a certain rate, then you are performing
multiple-point or waveform acquisition.

If you want single-point acquisition, refer to Chapter 6, One-Stop
Single-Point Acquisition. If you answered multiple-point acquisition,
read question 6.

5. Single-Point or Multiple-Point Generation?

Are you outputting a steady (DC) voltage or voltages are you
generating a changing signal at a certain rate? A constant or
slowly-changing voltage output is called single-point generation. The
output of a changing signal at a certain rate is called multiple-point or
waveform generation.

If you want to perform single-point generation, refer to Chapter 11,
One-Stop Single-Point Generation. If you answered multiple point
generation, refer to Chapter 12, Buffering Your Way through Waveform
Generation.

6. Triggering a Signal or Using a Clock?
You can start an analog acquisition when a certain analog or digital
value occurs by triggering the acquisition.

If you want to trigger an analog acquisition, refer to Chapter 8,
Controlling Your Acquisition with Triggers.

Multiple-Point Acquisition with an Internal or External Clock?
Multiple point or waveform acquisition can be done at a rate set by an
internal DAQ device clock or an external clock. The external clock will
be a TTL signal produced at a certain rate.

If you want to acquire a waveform at the rate of an external signal, refer
to Chapter 9, Letting an Outside Source Control Your Acquisition Rate.
If not, read Chapter 7, Buffering Your Way through Waveform
Acquisition.
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7. Non-Latched or Latched Digital 1/0?

If you want your program to read the latest digital input or immediately
write a new digital output value, you should use non-latched
(immediate) digital I/O. When a DAQ device accepts or transfers data
after a digital pulse has been received, it is called latched (handshaked)
digital I/O. With latched digital I/O, you can store the values you want
to transfer in a buffer. Only one value will be transferred after each
handshaked pulse.

If you want to use non-latched (immediate) digital I/O, refer to
Chapter 14, When You Need It Now—Immediate Digital I/0. If you
need to perform latched (handshaked) digital I/0O, refer to Chapter 15,
Shaking Hands with a Digital Partner.

8. Counters: Counting or Generating Digital Pulses?

If you want to generate digital pulses from a counter at a certain rate,
read Chapter 22, Generating a Square Pulse or Pulse Trains. If you
want to measure the width of a digital pulse, refer to Chapter 23,
Measuring Pulse Width. If you want to measure the frequency or period
of a digital signal, refer to Chapter 24, Measuring Frequency and
Period. If you just want to count how many times a digital signal rises
or falls, refer to Chapter 25, Counting Signal Highs and Lows. To learn
how to slow the frequency of a digital signal, refer to Chapter 26,
Dividing Frequencies.
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Catching the
Analog Input

Wave with

This section contains basic information on acquiring data with
LabVIEW, including acquiring a single point or multiple points,
triggering your acquisition, and using outside sources to control
acquisition rates.

Part 2, Catching the Wave with Analog Input, contains the following
chapters.

Chapter 5, Things You Should Know about Analog Input, explains
basics concepts on using analog input with LabVIEW.

Chapter 6, One-Stop Single Point Acquisition, shows you how to
acquire one data point from a single channel and then one data
point from each of several channels using LabVIEW, and explains
how software-timing and/or hardware-timing affects the
performance of analog I/0.

Chapter 7, Buffering Your Way through Waveform Acquisition,
reviews the different methods of reading multiple channels and
explains how LabVIEW stores the acquired data with each method.

Chapter 8, Controlling Your Acquisition with Triggers, explains how
to set your analog acquisition to occur at a certain time using either
software or hardware triggering methods.

Chapter 9, Letting an Outside Source Control Your Acquisition Rate,
shows you how to control your data acquisition rate by some other
external source in your system.



Things You Should Know about
Analog Input

Hunting has been a part of man’s survival from the beginning of time.
People used to hunt for the things they needed to survive, like food and
water. Today, engineers and scientists use data acquisition to “hunt
down” the information they need to survive in the information age.
This chapter focuses on defining the tools you need to be a successful
hunter in the world of data acquisition.

Defining Your Signal

You and your friends plan a hunting trip for this weekend. What do you
plan to bring with you? This question is really not valid, because you
must know first what you will be hunting before you pack your fishing
pole or elephant rifle. The same idea applies to scientists and engineers
engaged in the quest for information. You must know the defining
characteristics of what you want to “hunt,” be it a wild animal or an
analog signal. You cannot just say, “I will hunt voltages,” or even “I
will hunt analog voltages.” Voltages come in various forms. This
chapter gives you the terms, tools, and techniques designed to help
show you the best way to catch your wave.

You can break down analog signals into three categories: DC, time
domain, and frequency domain. You must ask yourself, “Is the
information I seek primarily contained in the level, the shape, or the
frequency content of my signal?” Figure 5-1 illustrates what signals
correspond to certain types of signal information.

DC ADCIDAGTA_ o915 Level
(slow) t

Analog Signal —— Time Domain ADC/DAC|! [\ /| Shape
(fast) Il

— Frequency Domain  — ADC (fast)| | 4 ‘ ‘ A f Freqg. Content

Analysis

Figure 5-1. Types of Analog Signals
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You may be saying to yourself, “I know that I have a thermocouple and
that the primary information (temperature) is contained in the level of
the analog voltage. Now I am ready to go hunting!” Well, you are
almost ready to hunt, but you first must figure out a few more signal
characteristics before you can begin. For example, to what is your
signal referenced? How fast does the signal vary with time? The rate at
which you sample determines how often the A/D conversions take
place. A fast sampling rate acquires more points in a given time and
therefore can often form a better representation of the original signal
than a slow sampling rate. According to the Nyquist Theorem, you
must sample at greater than twice the rate of the maximum frequency
component in that signal. The frequency at one half the sampling
frequency is referred to as the Nyquist frequency. You must have
answers like this to all of your questions, so that you can use the proper
tools to acquire the signal.

To What Is Your Signal Referenced?

Signals come in two forms: referenced and non-referenced signal
sources. More often, referenced sources are said to be grounded
signals, and non-referenced sources are called floating signals.

Grounded Signal Sources

Grounded signal sources have voltage signals that are referenced to a
system ground, such as earth or a building ground. Devices that plug

into a building ground through wall outlets, such as signal generators
and power supplies, are the most common examples of grounded signal
sources, as shown in Figure 5-2.

Ground ///

Figure 5-2. Grounded Signal Sources
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Floating Signal Sources

Floating signal sources contain a signal whose voltage signal is not
connected to an absolute reference, such as earth or a building ground.
Some common examples of floating signals are batteries,
battery-powered sources, thermocouples, transformers, isolation
amplifiers, and any instrument that explicitly floats its output signal.
Notice that in Figure 5-3 neither terminal of the floating source is
connected to the electrical outlet ground.

T
Ground ///

Figure 5-3. Floating Signal Sources

Now that you know how your signal is referenced, read on to learn the
different systems available to acquire these signals.

Choosing Your Measurement System

Resolution

Now that you have defined your signal, you must choose a
measurement system. You have an analog signal, so you must convert
the signal with an ADC measurement system, which converts your
signal into information the computer can understand. Some of the
issues you must resolve before choosing a measurement system are
your ADC bit resolution, minimum and maximum device voltage
levels, and minimum and maximum signal voltage levels.

The number of bits used to represent an analog signal determines the
resolution of the ADC. You could compare the resolution on a DAQ
device to the marks on a ruler. The more marks you have, the more
precise your measurements. Similarly, the higher the resolution, the
higher the number of divisions into which your system can break down
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the ADC range, and therefore, the smaller the detectable voltage
change. A 3-bit ADC divides the range into 23 or 8 divisions. A binary
or digital code between 000 and 111 represents each division. The
ADC translates each measurement of the analog signal to one of the
digital divisions. Figure 5-4 shows a sine wave and its corresponding
digital image as obtained by a 3-bit ADC. Clearly, the digital signal
does not represent the original signal adequately, because the converter
has too few digital divisions to represent the varying voltages of the
analog signal. By increasing the resolution to 16 bits, however, the
ADC’s number of divisions increases from 8 to 65,536 (2!°). The ADC
can now obtain an extremely accurate representation of the analog
signal.

3-Bit ADC

1&-Bit ADC

Figure 5-4. The Effects of Resolution on ADC Precision

Device Voltage Range

Range refers to the minimum and maximum analog voltage levels that
the ADC can digitize. Many DAQ devices feature selectable ranges, so
you can match the ADC range to that of the signal to take best

advantage of the available resolution. For example, in Figure 5-5, the
3-bit ADC has eight digital divisions in the range from O to 10 volts. If
you select arange of -10.00 to 10. 00 volts, as shown in Figure 5-5,
the same ADC now separates a 20 volt range into eight divisions. The
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smallest detectable voltage increases from 1.25 to 2 .50 volts, and
you now have a much less accurate representation of the signal.

10.00 11
7.50
5.00 110
101
2.50
vV 0.00 190 Range = OV to 10V
-2.50 on
-5.00 010
7,50 001
-10.00 000
sec Range = 10V to +10V

Figure 5-5. The Effects of Range on ADC Precision

Signal Voltage Range (Limit Settings)
Limit settings are the maximum and minimum voltages of the signal
you are measuring. A more precise limit setting allows the ADC to use
more digital divisions to represent the signal. For example, using a
3-bit ADC and a device range setting of 0.00 to 10.00 volts,
Figure 5-6 shows the effects of a limit setting between 0 and 5 volts and
0 and 10 volts. With a limit setting of 0 to 5 volts, the ADC uses only
four of the eight divisions in the conversion. By changing the limit
setting to the device’s range setting, the ADC now has access to all
eight digital divisions. This makes the digital representation of the
signal more accurate.
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F

Limit Settings 0 to 10V

10.00 11

8.75
. 110
101

6.25
100

V 5.00
3.75 o1
\ 010

2.50 \

1.25 0ot
0.00 000

10.00

8.75

7.5

6.25
V. 5.00 117
3.75 \ 119
A\ 100
2.50 \\ 818
1.25 001
0.00 000

Limit Settings 0 to 5V

Limit Settings 0 to 5V

Figure 5-6. The Effects of Limit Settings on ADC Precision

Considerations for Selecting Analog Input Settings

The resolution and device range of a DAQ device determine the

smallest detectable change in the input voltage. You can calculate the
smallest detectable change, called the code width, using the following

formula.

device range
resolution
2
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For example, a 12-bit DAQ device with a 0 to 10 V input range detects
a 2.4 mV change, while the same device with a -10 to 10 V input range
detects only a change of 4.8 mV.

device range 10

: —= 24 mV
2resolutmn 212
d e e D= 48mV
2 2

A high resolution A/D converter provides a smaller code width given
a device voltage ranges shown above.

device range 10 _

- —=.15mV
2resolutmn 216

device range 20 _ 3

= —=.3mV
resolution 16
2 2

The smaller your code width, the more accurate your measurements
will be.

There are times you must know if your signals are unipolar or bipolar.
Unipolar signals are signals that range from 0 to a positive voltage (i.e.,
0 to 5 V). Bipolar signals are signals that range from a negative to a
positive voltage (-5 to 5 V). To achieve a smaller code width if your
signal is unipolar, specify that the device voltage range is unipolar, as
shown previously. If your signal range is smaller than the device
voltage range, then you should set your limit settings to values that
more accurately reflect your signal range. Table 5-1 shows how the
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code width of the 12-bit DAQ devices vary with device ranges and
limit settings.

Table 5-1.  Measurement Precision for Various Device Ranges and Limit Settings

Device Voltage Limit Settings Precision*
Range

0to 10V Oto10V 244 mV
Oto5V 1.22 mV
0t02.5V 610 uV
0to1.25V 305 uv
0tol1V 244wV
0t00.1V 24.4 UV
OmV to 20 mV 4.88 uv

-5to 5V -5to 5V 2.44 mV
-25t025V 1.22 mV
-1.25t01.25V 610 uv
-0.625t0 0.625 V 305 uv
051005V 244 uv
-50mV to 50 mV 24.4 uv
-10mV to 10 mV 4.88 uv

-10to 10V -10to 10V 4.88 mV
Sto5V 2.44 mV
-25t025V 1.22 mV
-1.25t01.25V 610 uv
dtolV 488 pv
-0.1t00.1V 48.8 uvV
-20mV to 20 mV 9.76 uvV

*The value of 1 LSB of the 12-bit ADC. In other words, the voltage

increment corresponding to a change of 1 count in the ADC 12-bit count.

For more information on the device range and limit settings for your
device, refer to the tables in Appendix B, Hardware Capabilities, in the
LabVIEW Data Acquisition VI Reference Manual. In these tables, there
is information on gain settings for each device. For more information
on gain, refer to the Limit Settings section of Chapter 3, Basic LabVIEW
Data Acquisition Concepts.

Now that you know which kind of ADC to use and what settings to use
for your signal, you can connect your signals to be measured. On most
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DAQ devices, there are three different ways to configure your device
to read the signals: Differential, Referenced Single-Ended (RSE), and
Non-Referenced Single-Ended (NRSE).

Differential Measurement System

In a differential measurement system, you do not need to connect either
input to a fixed reference, such as earth or a building ground. DAQ
devices with instrumentation amplifiers can be configured as
differential measurement systems. Figure 5-7 depicts the 8-channel
differential measurement system used in the MIO-16 series devices.
Analog multiplexers (AMUX) increase the number of measurement
channels while still using a single instrumentation amplifier. For this
device, the pin labeled AIGND (the analog input ground) is the
measurement system ground.

MUX

CHO+ O———F—0 0O

CH2+ o0—————0 0

CH1+ 0————~—0 0

° Instrumentation Amplifier
CH7+ o————+——0 0o +
MUX +
CHO- O———————0 0 -
Vm
CH2- o0———1—0 0
CH1- o0————+—0 o ; i
e}
°

CH7- o————+—o0 0!

O

AIGND

Figure 5-7. 8-Channel Differential Measurement System
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In general, a differential measurement system is preferable because it
rejects not only ground loop-induced errors, but also the noise picked
up in the environment to a certain degree. However, the single-ended
configuration allows for twice as many measurement channels and is

acceptable when the magnitude of the induced errors is smaller than the
required accuracy of the data. You should use differential measurement
systems when all input signals meet the following criteria.

e Low-Level Signals (less than 1 V)

* Long or Non-Shielded Cabling/Wiring Traveling through a Noisy
Environment

* Any of the Input Signals Require a Separate Ground-Reference
Point or Return Signal

If you have the following criteria, read the following sections on
single-ended measurements.

An ideal differential measurement system reads only the potential
difference between its two terminals—the (+) and (-) inputs. Any
voltage present at the instrumentation amplifier inputs with respect to
the amplifier ground is called a common-mode voltage. An ideal
differential measurement system completely rejects (does not measure)
common-mode voltage, as shown in Figure 5-8.

Instrumentation Amplifier

Grounded Signal Source

+
- _ Measured Voltage
—e

Common Mode Voltage, @
Ground Potential, Noise, etc.

\

Figure 5-8. Common-Mode Voltage

Referenced Single-Ended Measurement System

A referenced single-ended (RSE) measurement system, is used to
measure a floating signal, because it grounds the signal with respect to
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building ground. Figure 5-9 depicts a 16-channel RSE measurement
system.

MUX

CHO O——1—0 00—
CH2 o————0 o
CH1 o———+—0 o Instrumentation Amplifier

] +

°

+

°

CH15 o——————0 o Vm

AIGND © o i

4

Figure 5-9. 16-Channel RSE Measurement System

Nonreferenced Single-Ended Measurement System

DAQ devices often use a variant of the RSE measurement technique,
known as the nonreferenced single-ended (NRSE) measurement
system. In an NRSE measurement system, all measurements are made
with respect to a common reference, because all of the input signals are
already grounded. Figure 5-10 depicts an NRSE measurement system
where AISENSE is the common reference for taking measurements
and AIGND is the system ground. All signals must share a common
reference at AISENSE.
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MUX
CHO+ O——————0 0
CH1+ o0————0 o
CH2+ 0———F+—0 0O Instrumentation Amplifier
° +
°
+
°
CH15+ 0—————1—0 0 Vm
AISENSE 0 o i

\/ AIGND

Figure 5-10. 16-Channel NRSE Measurement System

In general, a differential measurement system is preferable because it
rejects not only ground loop-induced errors, but also the noise picked
up in the environment to a certain degree. On the other hand, the
single-ended configuration allows for twice as many measurement
channels and is acceptable when the magnitude of the induced errors is
smaller than the required accuracy of the data. You can use
single-ended measurement systems when all input signals meet the
following criteria.

* High Level Signals (normally, greater than 1 V)

e Short or Properly-Shielded Cabling/Wiring Traveling through a
Noise-Free Environment

* All Signals Can Share a Common Reference Signal at the Source

Use differential connections when your system violates any of the
above criteria.

Until now, you have learned about analog input in general. Now, you
should focus on some analog input concepts that are specific to
LabVIEW. The following section discusses these LabVIEW-specific
issues.
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LabVIEW and Analog Input
Channel Addressing with the AMUX-64T

An AMUX-64T external multiplexer device expands the number of
analog input signals a plug-in DAQ device can measure. You can
address AMUX-64T channels when you attach one, two, or four
AMUX-64T devices to a plug-in DAQ device. You can multiplex four,
eight, or 16 AMUX-64T channels into one device channel. The
scanning order of these AMUX-64T channels is fixed. To specify a
range of AMUX-64T channels, enter the device channel into which the
range is multiplexed in the channel list. For example, if you have no
AMUX-64T devices, a channel list element of 0 specifies device
channel 0. If you have a AMUX-64T device, a channel list element of
0 specifies channels O through 3 on each AMUX-64T device.

Table 5-2 shows the number of channels available on a DAQ device
with an external multiplexer.

Table 5-2.  Analog Input Channel Range

Number of Channel Range Channel Range
AMUX-64Ts (Single-Ended) (Differential)
0 0 through 15 0 through 7
1 AM1'!'0 through AM1'!'0 through
AM1!63 AM1!31
2 AM1!0 through AM1!0 through
AM1!63, AM1!31,
AM2!0 through AM2!0 through
AM2!63 AM2!31
4 AM1 !0 throughaAM1!63, AM1'!0 through
AM2 ! 0 throughAM2 ! 63, AM1!31,
AM3 !0 throughAM3!63, AM2!0 through
AM4 10 throughaM4!63 AM2131,
AM3!0 through
AM3!31,
AM4!0 through
AM4 131
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You specify the number of AMUX devices through the configuration
utility or the AI Hardware Config VI. Refer to the LabVIEW Data
Acquisition VI Reference Manual for more information on this VI.

The AMUX-64T Scanning Order

This section explains how LabVIEW scans channels from the
AMUX-64T. You must know this scanning order so that you can
determine which analog input channel LabVIEW scanned during a data
acquisition operation.

The scanning counters on the AMUX-64T and on the DAQ device
perform automatic scanning of the AMUX-64T analog input channels.
When you perform a multiple-channel scanned data acquisition with an
AMUX-64T, a counter on the DAQ device switches the DAQ device
multiplexers.

When you connect a single AMUX-64T device to the DAQ device, you
must scan four AMUX-64T input channels for every DAQ device
channel. If you attach two AMUX-64T devices to the DAQ device,
LabVIEW scans eight AMUX-64T channels for every DAQ device
input channel. For example, assume that channels O through 3 on
AMUX-64T device 1 and channels O through 3 on AMUX-64T device
2 are multiplexed together into DAQ device channel 0. In this case,
LabVIEW scans the first four channels on AMUX-64T device 1,
followed by the first four channels on AMUX-64T device 2.

If you attach four AMUX-64T devices to the DAQ device, LabVIEW
scans 16 AMUX-64T channels for every DAQ device input channel.
For example, channels O through 3 on AMUX-64T device 1, 2, 3, and
4 are multiplexed together into DAQ device channel 0. In this case,
LabVIEW scans the first four channels on device 1, followed by the
first four channels on device 2, the first four channels on device 3, and
then the first four channels on device 4.

The order in which LabVIEW scans channels depends on the channel
list you specify in the AI Group Config VI. You specify this channel
list as an array of DAQ device channel numbers indicating the order in
which LabVIEW scans the DAQ device channels. When scanning
multiple channels, list only the device channels—not the AMUX-64T
channels. (You only use the AMy ! x syntax in your channel list when
you sample a single AMUX-64T channel.) LabVIEW then scans four,
eight, or 16 channels for every device channel for one, two, or four
AMUX-64T devices, respectively. However, the AMUX-64T has a
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fixed scanning order. Table 5-4 shows the order in which LabVIEW
scans the AMUX-64T channels for every DAQ device input channel
when you use one or two AMUX-64T devices. Table 5-4 shows the
order in which LabVIEW scans the AMUX-64T channels for every
DAQ device input channel when you use four AMUX-64T devices.

If you want to scan more than one AMUX-64T channel, you must enter
the device channels in your scan list.

Table 5-3.  Scanning Order for Each DAQ Device Input Channel
with Four AMUX-64Ts
AMUX-64T Channels
DAQ
Device One Device Two Devices
Channel
Device 1 Device 1 Device 2

0 0,1,2,3 0,1,2,3 0,1,2,3

1 4,5,6,7 4,5,6,7 4,5,6,7

2 8,9,10,1 8,9,10,1 8,9,10,1

3 1,314,15 1,314,15 1,314,15
4 16,17, 18, 19 16,17, 18, 19 16,17, 18, 19
5 20, 21, 22,23 20, 21, 22,23 20, 21, 22,23
6 24,25, 26, 27 24,25, 26, 27 24,25, 26, 27
7 28, 29, 30, 31 28, 29, 30, 31 28, 29, 30, 31
8 32,33, 34, 35 32, 33,34, 35 32,33, 34, 35
9 36, 37, 38, 39 36, 37, 38, 39 36, 37, 38, 39
10 40,41, 42,43 40,41, 42,43 40, 41, 42,43
11 44,45, 46, 47 44, 45, 46, 47 44,45, 46, 47
12 48, 49, 50, 51 48, 49, 50, 51 48, 49, 50, 51
13 52,53, 54,55 52,53, 54,55 52,53, 54, 55
14 56, 57, 58, 59 56, 57, 58, 59 56,57, 58, 59
15 60, 61, 62, 63 60, 61, 62, 63 60, 61, 62, 63
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Table 5-4.  Scanning Order for Each DAQ Device Input Channel
with Four AMUX-64Ts
DAQ AMUX-64T Channels
Device
Channel Device 1 Device 2 Device 3 Device 4

0 0,1,2,3 0,1,2,3 0,1,2,3 0,1,2,3

1 4,5,6,7 4,5,6,7 4,5,6,7 4,5,6,7

2 8,9,10,1 8,9,10,1 8,9,10,1 8,9,10, 1

3 12, 13, 14, 15| 12,13, 14, 15| 12,13, 14, 15| 12,13, 14, 15
4 16,17,18,19| 16,17,18,19| 16,17,18,19| 16,17,18,19
5 20,21,22,23| 20,21,22,23| 20,21,22,23| 20,21,22,23
6 24,25,26,27| 24,25,26,27 | 24,25,26,27| 24,25,26,27
7 28,29,30,31| 28,29,30,31| 28,29,30,31| 28,29,30,31
8 32,33,34,35| 32,33,34,35| 32,33,34,35| 32,33,34,35
9 36,37,38,39| 36,37,38,39| 36,37,38,39| 36,37, 38, 39
10 40,41,42,43| 40,41,42,43 | 40,41,42,43| 40,41,42,43
11 44,45 46,47 | 44,45,46,47 | 44,45,46,47| 44,45, 46,47
12 48,49,50,51| 48,49,50,51 | 48,49,50,51| 48,49,50,51
13 52,53,54,55| 52,53,54,55| 52,53,54,55| 52,53,54,55
14 56, 57,58,59| 56,57,58,59 | 56,57,58,59| 56,57,58,59
15 60, 61, 62,63 | 60, 61,62,63 | 60,61,62,63| 60,61,62,63

To determine which AMUX-64T channels LabVIEW scans and the
scanning order, perform the following steps.

1. Locate the channel for each DAQ device channel in your channel
list in the DAQ Device Channel column in Table 1-3 or 1-4. Start
with the first device channel and continue through the list in your
specified channel order.

2. Read from left to right along the table row where you located the
channel number to find the AMUX-64T scanning order.

To read a single AMUX-64T channel, use channel specifier AMy ! x.
This specifier returns data from channel x of the AMUX-64T with ID
y. To read more than one AMUX-64T channel, use channel specifier
OBx :y. This specifier returns data from the AMUX-64T channels that
correspond to device channel x through device channel y.
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When the channel list contains a single AMUX-64T channel, you must
also specify the number of the AMUX-64T device, as shown in the
following table.

channel list Channel Specified
parameter
AMy ! x Channel x on AMUX-64T device v.
AM4 '8 Channel 8 on AMUX-64T device 4.

You refer to AMUX-64T channels only when a single AMUX-64T
channel comprises the entire list. Otherwise, you refer to them
indirectly through the device channels that you use to scan the
AMUX-64T channels. Refer to Appendix B, Hardware Capabilities,
of the LabVIEW DAQ VI Reference Manual for more information on
addressing AMUX-64T channels.

Refer to the AMUX-64T User Manual for more information on the
external multiplexer device.

Important Terms You Should Know

The following are some definitions of common terms and parameters
that you should remember when acquiring your data.

A scan is one acquisition or reading from each channel in your channel
string.

The number of scans to acquire parameter refers to the number of
data acquisitions or readings to acquire from each channel in the
channel string. The number of samples is the number of data points
you want to sample from each channel.

The scan rate determines how many times per second LabVIEW
acquires data from channels. The scan rate parameter enables interval
scanning (a longer interval between scans than between individual
channels comprising a scan) on devices that support this feature. The
channel clock rate parameter defines the time between the acquisition
of consecutive channels in your channel string. For more information
on scan and channel clock rates, refer to Chapter 9, Letting an Outside
Source Control Your Acquisition Rate.
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For specific information about the Analog Input VIs, refer to
Chapter 2, Introduction to the Analog Input Vs, in the LabVIEW Data
Acquisition VI Reference Manual.
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One-Stop Single-Point

Acquisition

This chapter shows you how to acquire one data point from a single
channel and then one data point from each of several channels using
LabVIEW.

Single-Channel Single-Point Analog Input

A single-channel, single-point analog input is an immediate,
non-buffered operation. In other words, the software reads one voltage
from an input channel and immediately returns the value to you. This
operation does not require any buffering or timing. You should use
single-channel, single-point analog input when you need one data point
from one channel and when the information you seek an analog
voltage. A good example of when you might want to use this would be
if you needed to periodically monitor the fluid level in a tank. You
could connect the transducer that produces a voltage representing the
fluid level to a single channel on your DAQ device and initiate a
single-channel, single-point acquisition whenever you want to know
the fluid level.

For most basic operations, use the Al Sample Channel VI, located in
Functions»DAQ»Analog Input. The Easy Analog Input VI, Al
Sample Channel, measures the signal attached to the channel you
specify on your DAQ device and returns the scaled voltage. Figure 6-1
shows how you can wire this VI.

h dq".'&iﬁﬁ e IIIHEIF‘T

Channg cample
high Tirnit £104) — %4 P
lovw Tirnit (-104)

Figure 6-1. The Al Sample Channel VI Help Window
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Figure 6-2 shows how you program the AI Sample Channel VI in
LabVIEW to acquire data.

Al
OME FT
(o]

Al Samé]e Channel

Figure 6-2. Acquiring Data Using the Al Sample Channel VI

This example continuously calls the Al Sample Channel VI in a While
Loop until you press the Power control button on the front panel. Each
time around the loop, the AI Sample Channel VI initiates an A/D
conversion on the DAQ device and returns the scaled voltage as an
output. The high limit is the highest expected voltage level of the
signals you want to measure. The low limit is the lowest expected
voltage level of the signals you want to measure.

Single-channel acquisition makes acquiring one channel very basic,
but what if you need to take more than one channel sample? For
instance, you might need to monitor the temperature of the fluid as well
as the fluid level of the tank. In this case, two transducers must be
monitored. You can monitor both transducers using a
multiple-channel, single-point acquisition in LabVIEW.

Multiple-Channel Single-Point Analog Input

With a multiple-channel, single-point read (or scan), LabVIEW returns
the voltage on several channels at once. Use this type of operation
when you have multiple transducers to monitor and you want to

LabVIEW Data Acquisition Basics Manual 6-2 © National Instruments Corporation



Chapter 6  One-Stop Single-Point Acquisition

retrieve data from each transducer at the same time. Your DAQ device
executes a scan across each of the specified channels and returns the
voltage values when finished. Refer to Appendix B, Hardware
Capabilities, in the LabVIEW Data Acquisition VI Reference Manual,
for the number of channels your device can scan at one time.

The Easy I/0 VI, Al Sample Channels, acquires single voltage values
from multiple channels. The AI Sample Channels VI performs a single
A/D conversion on the specified channels and returns the scaled
voltages in a 1-dimensional (1D) array. The expected voltage range for
all the signals, specified by high limit and low limit inputs, applies to
all the channels. Figure 6-3 shows how you can acquire a voltage from
multiple channels with this VI.

Note: Remember to use commas to delimit individual channels in the channel
string, or use a colon to indicate an inclusive list of channels.

41 Sample Channels.vi 0., By

]
device |LIL6 OME FT H
ﬁ:;q m] channel O waltage

channels d
high lirnit
Tow Timnit

Indes drray

EﬂJ =] channel 1 woltage

-t

Figure 6-3. Acquiring a Voltage from Multiple Channels with the Al Sample Channels VI

You can benefit from using the Easy Analog Input VIs because you
only need one icon in your diagram to perform the task, there are only
a few basic inputs to the VIs, and the VIs have built-in error checking;
however, the lack of programming flexibility with these VIs can be a
limitation. Because Easy VIs have only a few inputs, you cannot
implement some of the more detailed features of DAQ devices, such as
triggering, interval scanning, or coupling. In addition, these VIs always
reconfigure at start-up. When you need a hi-speed or efficiently-run
program, these configurations can slow down processing time. When
you need speed and more efficiency, use the Intermediate VIs, which
configure an acquisition only once and then continually acquire data
without ever re-configuring. The Intermediate VIs also offer more
error handling control, more hardware functionality, and efficiency in
developing your application than the Easy VIs. You typically use the
Intermediate VIs to perform buffered acquisitions. You can read more
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about buffered acquisitions in Chapter 7, Buffering Your Way through
Waveform Acquisition. The Intermediate Analog Input VI, Al Single
Scan VI, does multiple-channel, single-point acquisitions, as shown in
Figure 6-4.

data remaining
taskiD in taskiD out
opcode (2 :read newest) -SCHN L vyoltage data

I
time Tirnit in sec (compute:-1) —|_| e _I—I:-inarg data
ﬂ acquizition state

output units Cvolts:1)

error in (no error) error out

Figure 6-4. The Al Single Scan VI Help Diagram

The AI Single Scan VI returns one scan of data. You can also use this
VI to read only one point if you specify one channel. Use this VI only
in conjunction with the AI Config VI.

Figure 6-5 shows a simplified block diagram for non-buffered
applications. LabVIEW calls the AI Config VI, which configures the
channels, selects the input limits (the high limit and low limit
parameters in the Easy VIs), and generates a taskID. The program
passes the taskID and the error cluster to the Al Single Scan VI, which
returns the voltage data in an array (one point for each channel

specified).
[=0s]
input limitz (na change) E
L6 conFI S-3LRH [s61]
devrice (1] ! ~ASE gltage array
Al Configawi &l Single Scan.wi

channels (00

[I32]| buffer size =0

Figure 6-5. Using the Intermediate VIs for a Basic Non-Buffered Application

Figure 6-6 shows how you can program the Al Config and Al Single
Scan VIs to perform a series of single scans by using software timing
(a While Loop) and processing each scan. This example shows the
Cont Acquire&Chart (immediate) .vi, which you can findin
examples\dag\anlogin\anlogin.llb.
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The advantage to using the intermediate-level VIs is that you do not
have to configure the channels every time you want to acquire data as
you do when using the Easy VIs. To call the AI Config VI only once,
put it outside of the While Loop in your program. The Al Config VI
configures channels, selects a high/low limit, and generates a taskID.
Then, the Al Config VI passes the taskID and error cluster into the
While Loop, where LabVIEW calls the Al Single Scan VI to retrieve a
scan. The program then passes the returned data to the My Single-Scan
Processing VI. With this VI, you can program whatever processing
needs your application calls for, such as looking for a limit to be
exceeded or performing an average. The VI then passes the data
through the build array function to a waveform chart for display on the
front panel. The Wait Until Next ms multiple VI controls the loop
timing. You enter a scan rate, the application converts the value into
milliseconds and passes the converted value to the Wait Until Next ms
multiple VI. The loop then executes at the rate of scanning. The loop
ends when you press the stop button or an when error occurs. Once the
loop finishes, the Simple Error Handler VI displays any errors that
occurred on the screen.

Read & chart data until an error acours,
or the stop button pressed.

[tranzposed waveform chart]
[ehannets (O[faba] fed cof _' e

PROC
o

interchannel delay (N,

in zecs (-1 hw default)
scan rate
(% zcans/sec)

Figure 6-6. The Cont Acq&Chart (immediate) VI Block Diagram

The previous examples use software-timed acquisition. With this type
of acquisition, the CPU system clock controls the rate at which you
acquire data. Your system clock can be interrupted by user interaction,
so if you do not need a precise acquisition rate, use software-timed
analog input.
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Using Analog Input/Output Control Loops

You should use analog input/output (I/O) control loops when you want
to output analog data after receiving some analog data. With control
loops, this process is repeated over and over again. For instance, you
want to control the fluid flow into several tanks. If the present flow rate
causes the tank to fill up then you open a valve so the fluid can flow to
another tank. You acquire information about the fluid flow rate at a
constant rate.

The single-point analog input and output VIs support several analog
/0 control loops at once because you can acquire analog inputs from
several different channels in one scan, and write all the analog output
values with one update. You perform a single analog input call, process
the analog output values for each channel and then perform a single
analog output call to update all the output channels.

The following sections discuss the two different types of analog I/O
control loop techniques: software-timed and hardware-timed
analog 1/0.

Using Software-Timed Analog 1/0 Control Loops

With software-timed analog control loops the analog acquisition rate
and subsequent control loop rate are controlled by a software timer
such as the Wait Until Next Millisecond multiple timer. The
acquisition is performed during each loop iteration when the Al Single
Scan VI is called and the control loop is executed once for each time
interval. Your loop timing can be interrupted by any user interaction
which means your acquisition rate is not as consistent as that which can
be achieved through hardware-timed control loops. Generally, if you
do not need a precise acquisition rate for your control loop, use
software-timed control loops.

Besides user interaction, a large number or large-sized front panel
indicators, like charts and graphs, affect control loop rates. Refreshing
the monitor screen interrupts the system clock, which controls loop
rates. Therefore, you should keep the number of charts and graphs to a
minimum when you are using software-timed control loops.

An example of software-timed control loops is the Analog 10 Control
Loop (immed) VI located in examples\dag\anlog_io.1l1lb.
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The following diagram shows how to perform software-timed analog
I/0 using the AI Read One Scan and AO Write One Update Vls.

[ransposed waveform chart]

-EAER e R0 Channels 04
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loop rate
[zcan rate)
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Figure 6-7. Software-Timed Analog I/0

The AI Read One Scan VI configures your DAQ device to acquire data
from analog channels 0 and 1. Once your program acquires a data point
from channels 0 and 1, it performs calculations on the data and outputs
the results through the same channels (0 and 1). Because the iteration
count is connected to the AI Read One Scan and AO Write One Update
VIs, the application configures the DAQ device for analog input and
output only on the first iteration of the loop. The loop rate as well as
the acquisition rate is specified by loop rate. The reason why the actual
loop period is important is because user interaction affects the loop and
acquisition rate. When a user presses the mouse button for instance,
that action interrupts the system clock which controls the loop rate. If
your analog acquisition rate for control loops does not need to be
consistent, then use software-timed control loops.

Using Hardware-Timed Analog 1/0 Control Loops

For a more precise timing of your control loops, and more precise
analog input scan rate, use hardware-timed control loops.
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An example of hardware-timed, non-buffered control loops is the
Analog 10 Control Loop (hw timed) VI located in examples\dag\
anlog_io.1llhb.

With hardware-timed control loops, your acquisition is not interrupted
by user interaction. Hardware-timed analog input automatically places
the data in your DAQ device FIFO buffer at an interval determined by
the analog input scan rate. You can synchronize you control loop
diagram to this precise analog input scan rate by repeatedly calling the
Al Single Scan VI to read the oldest data in the FIFO.

The AI Single Scan VI returns as soon as the next scan has been
acquired by the DAQ Device. If more than one scan was stored in the
DAQ device FIFO when the AI Single Scan VI was called, the
LabVIEW diagram was not able to keep up with the acquisition rate.
This is detected by monitoring the data remaining output of the Al
Single Scan VI. In other words, you have missed at least one control
loop interval. This indicates that your software overhead is preventing
you from keeping up with your hardware-timed loop rate. In

Figure 6-8, the loop too slow boolean indicator is set to TRUE whenever
this occurs.
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Figure 6-8. Analog I0 Control Loop (hw timed) VI Block Diagram

In this diagram, the AI Config VI configures the device to acquire data
on channels 0 and 1. The application does not use a buffer created in
CPU memory, but instead uses the DAQ device FIFO. The input limits
parameter (also known as limit settings) affects the expected voltage
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range of the input signals. For more information on input limits (limit
settings), refer to Chapter 3, Basic LabVIEW Data Acquisition Concepts.
The AI Start VI begins the analog acquisition at the loop rate (scan
rate) parameter. On the first iteration of the loop, the Al Single Scan
VI reads the newest data in the FIFO. Some data may have been
acquired between the execution of the AI Start and the AI Single Scan
VIs. On the first iteration of the loop, the application reads the latest
data acquired between the AI Start and the AI Single Scan VIs. On
every subsequent iteration of the loop, the application reads oldest data
in the FIFO, which is the next acquired point in the FIFO.

If more than one value was stored in the DAQ device FIFO when you
read it, your application was not able to keep up with the control loop
acquisition and you have not responded with one control loop interval.
After the application completes analog acquisition and generation, then
the Al Clear VI clears the analog input task.

Figure 6-7 also includes a waveform chart in the control loop. This
reduces your maximum loop rate. You can speed up the maximum rate
of the control loop by removing this graph indicator.

You can easily add other processing to your analog I/0O control loop by
putting the analog input, control loop calculations and analog output in
the first frame of a sequence inside the loop, and additional processing
in subsequent frames of the sequence. Keep in mind that this additional
processing must be less than your control loop interval, otherwise you
will not be able to keep up with your control loop rate.

Improving Control Loop Performance

There are some performance issues you should take into account if you
plan to have other VIs or loops execute in parallel with your
hardware-timed control loop. When you call the Al Single Scan VI in
a hardware-timed control loop, the VI waits until the next scan is
acquired before returning, which means that the CPU is waiting inside
the NI-DAQ driver until the scan is acquired. Consequently, if you try
to run other LabVIEW VIs or while loops in the same diagram in
parallel with your hardware-timed control loop, they may run more
slowly or intermittently. You can reduce this problem by putting a
software delay (with the Wait (ms) VI) at the end of your loop after you
write your analog output values. Your other LabVIEW VlIs and loops
will then be able execute during this time.
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Another good technique is to poll for your analog input without
waiting in the driver. You can set the Al Single Scan VI time limit in
sec to zero. Then, the VI reads the DAQ Device FIFO and
immediately returns—whether the next scan was acquired or not. The
Al Single Scan VI voltage data output array will be empty if the scan
was not yet acquired. Poll for your analog input by using a Wait (ms)
or Wait Until Next Ms Multiple VI together with the Al Single Scan
VIin a while loop within your control loop diagram. Set the wait time
for a smaller time than your control loop interval (at least twice as
smaller). If the voltage data output array is not empty, exit the polling
loop passing out the voltage data array and execute the rest of your
control loop diagram. This method does not return data as soon as the
scan has been acquired, as in the example discussed previously, but
provides ample time for other VIs and loops to execute. This method
is a good technique for balancing the CPU load between several loops
and VIs running in parallel.

In the previously discussed techniques, if you are using software
delays for control loop speeds > 1 Hz turn the Use Default Timer
option off in the Performance dialog box in your LabVIEW
Preferences. Turning this off gives you around 1 ms software timer
resolution, instead of the default 55 ms timer resolution.
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Buffering Your Way through
Waveform Acquisition

If you want to take more than one reading on one or more channels,
there are two techniques that you can use depending on what you want
to do with the data after you acquire it. This chapter reviews these
different methods and explains how LabVIEW stores the acquired data
with each method. You will discover which method you should use by
answering the following questions.

* Do you want to analyze your data as it is being acquired or after it
has been acquired?

* Do you want to acquire a predetermined or indefinite number of
data points?

If you want to analyze your data as it is being measured and the number
of data points does not matter, read the Do You Need to See Your Data
during the Acquisition section in this chapter. If you acquire a
predetermined number of data points and you want to analyze the data
after it has been acquired, refer to the Can You Wait for Your Data
section in this chapter. Also, throughout the chapter there are some
basic examples of some common data acquisition (DAQ) applications
that use these two methods.

Can You Wait for Your Data?

One way to acquire multiple data points for one or more channels is to
use the non-buffered methods described in the previous chapter in a
repetitive manner. For example, you could compare this method to a
trip to the grocery store. You need to get 20 items from the store, but
because you can’t carry all 20 items at once, you decide you must make
30 separate trips to the store. Grocery shopping in this manner would
be very inefficient and time consuming. The same applies for when you
are acquiring a single data point from one or more channels over and
over. Also, with this method of acquisition, you do not have accurate
control over the time between each sample or channel. Going back to
the example of grocery shopping, it would be much more efficient to
use a shopping bag to hold all 20 food items at once, so that you only
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have to make one trip. In the same sense, you can use a data buffer in
computer memory as your shopping bag with which you acquire data.

With buffered I/0, LabVIEW transfers data taken at timed intervals
from a DAQ device to a data buffer in memory. Figure 7-1 illustrates
how the data fills up the buffer only once, however the overall size of
the buffer is specified in your VI. In this illustration, think of N as the
number of scans or updates the buffer can hold, and T as the trigger
occurrence whether the trigger is due to our external signal or the start
of the execution of your VI. Refer to Chapter 8, Controlling Your
Acquisition with Triggers, for more discussion on triggering your
acquisition from another signal.

T
——> writing and reading

Figure 7-1. How Buffers Work

In your VI, you must specify the number of samples to be taken and the
number of channels from which LabVIEW will take the samples. From
this information, LabVIEW allocates a buffer in memory to hold a
number of data points equal to the number of samples per channel
multiplied by the number of channels. As the data acquisition
continues, the buffer fills with the data; however, the data may not
actually be accessible until LabVIEW acquires all the samples (N).
Once the data acquisition is complete, the data that is in the buffer can
be analyzed, stored to disk, or displayed to the screen by your VI.

Acquiring a Single Waveform

You can acquire a waveform from a single channel by using the Al
Acquire Waveform VI, shown in Figure 7-2. You can find this VI in
Functions»DAQ»Analog Input. Because AI Acquire Waveform is an
Easy Analog Input VI, it has the minimal number of inputs needed to
acquire a waveform from a single channel. These minimal inputs are
the device, channel string, number of samples from the channel, and
the sample rate. You can programmatically set the gain by setting the
high limit and the low limit. Using only the minimal set of inputs makes
programming the VI less problematic, but the VI lacks more advanced
capabilities, such as triggering. Built-in error handling is another
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useful feature of the Easy VlIs. If an error occurs, the program stops
running and notifies you with a dialog box explaining the error.

device [l waveform
channel (0] -3 nun{% —— actual sample period (zec)
number of samples f' """ 1=

sample rate (1000 samplesfsec)
high Tirnit (10V)
Toww Tirnit (=104

Figure 7-2. The Al Acquire Waveform VI

Acquiring Multiple Waveforms

You can acquire more than one waveform at a time with another of the
Easy Analog Input VIs, AI Acquire Waveforms, shown in Figure 7-3.
This VI also has minimal set of inputs, but it allows inputs of more than
one channel to read and returns data from all channels read.

device m.u?lrr waveforms
channels (0] —— actual scan period (sec)

. TN
number of samples/ch f 'ﬂv"@
scan rate (1000 scansfsec)

high Timit (104
Tow Tirnit (=104

Figure 7-3. The Al Acquire Waveforms VI

The channel input for this VI is a string where you can enter a list of
channels. Refer to Chapter 3, Basic LabVIEW Data Acquisition
Concepts, for more information on channel specification in LabVIEW.
LabVIEW outputs a two-dimensional (2D) array in the waveforms
output for this VI, where each channel has a different column and the
sample are on each row. Refer to Chapter 3, Basic LabVIEW Data
Acquisition Concepts, for more information on how data is organized
for analog applications. You can set the high limit and low limit inputs
for all the channels to the same value. You cannot have different limit
settings for different channels when you use this VI. For more
information on gain specifications, go to Chapter 3, Basic LabVIEW
Data Acquisition Concepts. Like the other Easy VIs, you cannot use
any advanced programming features with the AI Acquire Waveforms
VI. The built-in error checking of this VI alerts you to any errors that
occur in the program.
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A second method for acquiring multiple waveforms uses the
Intermediate Analog Input VI, Al Waveform Scan, as shown in
Figure 7-4. An example using this VI is the Acquire N Scans VI, found
in labview\examples\dag\analogin\anlogin.llb. This VI
acquires multiple waveforms just like the Al Acquire Waveforms VI,
but you can set different input limits, for different channels. This VI
can also specify inputs for triggering, coupling, and additional
hardware. Coupling affects the value of the DC offset in your analog
signal. AC coupling subtracts the average value of this signal from the
signal before measurement, while DC coupling leaves DC offset
voltages in your signal measurements. If you want to know if your
DAQ device supports coupling, check in the tables in Appendix B,
Hardware Capabilities, in the LabVIEW Data Acquisition VI Reference
Manual.

trigger and
clock Cno trig,
int clk)

coupling &
input config
(nl:l change |:|:| [gu;] ----------------------------

input Tirnits
(no change)|| [ oos] fremms

channels (0] i O
number of zcans :- ﬂf
Tl =]

[561] [[voltage data

to acquire (1000)

=can rate
(1000 scans fsec)

Figure 7-4. Using the Al Waveform Scan VI to Acquire Multiple Waveforms

You can also expand the AI Waveform Scan VI into four separate
Intermediate VIs, which may make your VI diagram look more
complicated, but it provides more control over your data acquisition
processes, like being able to read any part of the buffer. An example
similar to Figure 7-5 is the Getting Started Analog Input VI, located in
labview\examples\dag\run_me.1l1lb. With these Intermediate
Analog Input VIs, you must wire a taskID to identify the DAQ
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operation and the set of channels used in the acquisition and to make
sure the VIs execute in the correct order.

wvoltage data

device (1)
I I16 I 1) [1)

----- ﬂlsmm | RERD |CLEHR @
channels (0) s e ey

s¢an rate
(4000 szans /zec)

BGL

Figure 7-5. Using the Intermediate VIs to Acquire Multiple Waveforms

With these VIs, you not only have the ability to configure triggering,
coupling, acquisition timing, retrieval, and additional hardware, but
you also can control when each step of the data acquisition process
occurs. With the AI Config VI, you can configure the different
parameters of the acquisition such as the channels to be read and the
size of the buffer to use. In the Al Start VI, you specify parameters used
in your program to start the acquisition, such as number of scans to
acquire, the rate at which your VI takes the data, and the trigger
settings. In the Al Read VI, you specify parameters to retrieve the data
from the data acquisition buffer. Then, your application calls the Al
Clear VI, which deallocates all buffers and other resources used for the
acquisition by invalidating the taskID. If an error occurs in any of
these Vs, your program passes the error through the remaining VIs to
the Simple Error Handler VI, which notifies you of the error.

For many DAQ devices, the same ADC samples many channels instead
of only one. The maximum sampling rate per channel is
maximum sampling rate
number of channels
above is the same as the sampling rate per channel. To figure out your
maximum scan rate, you must divide the maximum sampling rate by
the number of channels. In Appendix B, Hardware Capabilities, in the
LabVIEW Data Acquisition VI Reference Manual, maximum sampling
rates are listed for each DAQ device.

. The scan rate input in all the VIs discussed
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Simple-Buffered Analog Input Examples
Simple-Buffered Analog Input with Graphing

Figure 7-6 demonstrates how you can use the Al Acquire Waveforms
VI to acquire two waveforms from channels 0 and 1 and then display
the waveforms on separate graphs. This type of VI is useful in
comparing two or more waveforms, or in analyzing how a signal looks
before and after going through a system. In this illustration, 1000 scans
of channels 0 and 1 are taken at the rate of 5000 scans per second. The
Actual Scan Period output displays in the actual timebase on the x-axis
of the graphs. Remember that each column of the 2D array contains the
information for each channel.

Ao
'I 0 Graph
device (11 —s::; I..
Colurnn
channels (0,13 Al Acquire Waveforms.wi
abe wier [ Actual Scan Period
Ve i
Mo. of Samplesfch (1 I:II:II:I:I|7 E Channel 1 Graph
By
scan rate (50000 n ::
SGL Colurnn

Figure 7-6. Simple Buffered Analog Input Example

If you want to display the data on the same graph, look at the Acquire
N Scans example VI, found in labview\examples\dag\anlogin\

LabVIEW Data Acquisition Basics Manual 7-6 © National Instruments Corporation



Chapter 7 Buffering Your Way through Waveform Acquisition

anlogin.11b. Figure 7-7 shows a simple buffered input application
that uses graphing.

transposed
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=
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device (1)

[channets (0| [ake] }""E .
T jl =
WAVE F—
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to acquire (10000

=can rate

{1000 scans fsec)

Figure 7-7. Simple Buffered Analog Input with Graphing

For a 2D array to be displayed on a waveform graph, each row of data
must represent a single plot. This is because waveform graphs are in
row-major order. Because the channel data is in each column, you must
transpose the 2D array. Transposing the array can easily be done by
popping-up on the front panel of the graph and choosing Transpose
Array.

Simple-Buffered Analog Input with Multiple Starts

In some cases you may not want to acquire contiguous data, like in an
oscilloscope application. In this case, you would only want to take a
specified number of samples as a snapshot of what the input looks like
periodically. For an example using the Al Waveform Scan VI, open the
Acquire N-multi-Start VI found in 1abview\examples\
dag\anlogin\anlogin.llb. The AI Waveform Scan VI, shown in
Figure 7-8, is similar to the Acquire N Scans example, except the
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LabVIEW Data Acquisition Basics Manual 7-8

Note:
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Figure 7-8. Taking a Specified Number of Samples with the Al Waveform Scan VI

This example is similar to the standard simple buffered analog input
VI, but now both the AI Start and AI Read VIs are in a While Loop,
which means the program takes a number of samples every time the
While Loop iterates.

The AI Read VI returns 1000 samples, taken at 5000 samples per second,
every time the While Loop iterates; however, the duration of the iterations
of the While Loop can vary greatly. This means that, with this VI, you can
control the rate at which samples are taken, but you may not be able to
designate exactly when your application starts acquiring each set of data.
If this start-up timing is important to your program, read the Do You Need
To Access Your Data during Acquisition? section in this chapter to see how
to control acquisition start-up times.

To increase control over your DAQ process, use the Intermediate
Analog Input VIs AI Config, Al Start, AI Read, and Al Clear as shown
in Figure 7-9.
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Figure 7-9. Controlling the Sampling Rate in a Simple Buffered Acquisition

Simple-Buffered Analog Input with a Write to Spreadsheet File

If you want to write the acquired data to a file, there are many file
formats in which you can store the data. The spreadsheet file format is
used most often because you can read it using most spreadsheet
applications for later data graphing and analysis. In LabVIEW, you can
use VIs to send data to a file in spreadsheet format or read back data
from such a file. You can locate these VIs in Functions»Utility»File
I/0. The VI used in this example is the Write to Spreadsheet File VI,
shown in Figure 7-10. In this exercise, the Intermediate analog input
VIs acquire an array of data, graph the data using the actual sample
period for the x-axis timebase, and create a spreadsheet file containing
the data.
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Figure 7-10. Writing to a Spreadsheet File after Acquisition

Triggered Analog Input

For information on starting your acquisition with triggers, go to
Chapter 8, Controlling Your Acquisition with Triggers.

Do You Need To Access Your Data during Acquisition?

You can apply the simple buffering techniques in many DAQ
applications, but there are some applications where these techniques
are not appropriate. If you need to acquire more data than your
computer’s memory can hold, or if you want to acquire data over long
periods of time, you should not use these simple-buffered techniques.
For these types of applications, you should set up a circular buffer to
store acquired data in memory. In the previous section, buffered input
was compared to shopping for groceries. You typically use a cart or bag
(your buffer) to hold as many groceries (your acquired data) as
possible, so that you only have to make one trip to the store. In this
case, imagine that you must prepare a meal and you are unable to go
shopping—yet periodically you need things from the store for your
recipe. If you send someone else to the store for you, you can continue
to prepare dinner while someone else retrieves the other items you
need. You can compare this scenario to circular-buffered data
acquisition, shown in Figure 7-11. Using a circular buffer, you can set
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up your device to continuously acquire data in the background while
LabVIEW retrieves the acquired data.

Buffer Being Filled - - >

Number to Read &—>1 1|\
Current Read Mark

<€ Buffer Size >

Figure 7-11. How a Circular Buffer Works

A circular buffer differs from a simple buffer only in how LabVIEW
places the data into it, and retrieves data from it. A circular buffer is
filled with data, just as a simple buffer; however, when it gets to the
end of the buffer, it returns to the beginning and fills up the same buffer
again. This means data can read continuously into computer memory,
but only a defined amount of memory can be used. Your VI must
retrieve data in blocks while the data enters the circular buffer, so that
data is not overwritten by newer data. Because of the buffer
maintenance, you can only use the Intermediate or Advanced VIs with
this type of data acquisition.

While a circular buffer works well in many applications, there are two
possible problems that can occur with this type of acquisition: your VI
could try to retrieve data from the buffer faster than data is placed into
it, or the program might not retrieve data from the buffer fast enough
before LabVIEW overwrites the data into the buffer. When your VI
tries to read data from the buffer that has not yet been collected,
LabVIEW waits for the data your VI requested to be acquired and then
returns the data. If your VI does not read the data from the circular
buffer fast enough, the VI sends back an error, telling you that the data
that you retrieved from the buffer is overwritten data.

Continuously Acquiring Data from Multiple Channels

You can continuously acquire time-sampled data from one or more
channels with the Intermediate Analog Input VI, AI Continuous Scan.
An example using this VI is the Acquire & Process N Scans VI, found
in examples\dag\anlogin\anlogin. 11b. This example is shown
in Figure 7-12. There are inputs for setting the channels, size of the
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circular buffer, scan rate, and the number of samples to retrieve from
the circular buffer each time. This VI defaults to a buffer size of 1000
samples and 500 scans to read, which means the VI reads in half of the
buffer’s data while the VI fills the second half of the buffer with new
data.

Note: The number of scans to read can be any number less than the buffer size.

If you do not retrieve data from the circular buffer fast enough, your
unread data will be overwritten by newer data. You can resolve this
problem in one of three ways: by adjusting the buffer size, scan rate or
the number of scans to read parameters. If your program overwrites
data in the buffer, then data is coming into the buffer faster than your
VI can read all of the previous buffer data, and LabVIEW returns an
error code number -10846. You can increase the size of the buffer so
that it takes longer to fill up, which leaves your VI with more time to
read data from it. If you slow down the scan rate, you reduce the speed
at which the buffer fills up, which also leaves more time for your
program to retrieve data. You can also increase the number of scans
to read, which will retrieve more data out of the buffer each time and
effectively reduce the number of times to access the buffer before it
becomes full. Check the output scan backlog to see how many data
values remain in the circular buffer after the read.

finput tirnits Cne change)]

device (1] -

Read & process data until 411 data acquired,
an error occurs, or the stop button pressed.

ibe

zcan rate
1000 scans S sec)
rurnber of scans
to aoquire [10000

buffer ==

5 ,nl—_l
trarsposed

o aveform
graph

(4000 scans)|[I32

Ble] o

Figure 7-12. Continuously Acquiring Data with the Al Continuous Scan VI

Because this is an Intermediate VI, you can also control parameters
such as triggering, coupling, and additional hardware.
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You can also perform this function using the four Intermediate Analog
Input VIs AI Start, AI Read, and Al Clear, as shown in Figure 7-13.
The only adjustment that you must make to these VIs for circular-
buffered analog input is to set the number of scans to acquire in the Al
Start VI to 0, which indicates continuous data acquisition in the Al
Start VI. The buffer size input of the AI Config VI determines the
circular buffer size, and the number of scans to read input of the Al
Read VI sets the size of the blocks of data to retrieve from the buffer.
The only differences between this method and the
previously-discussed method used with the AI Continuous Scan VI, is
the versatility of having more control over your DAQ processes.

continuous
|§[|
device i I_?H; : al
B e enfigwt |&lStarivd B g ; © Al Gl i
4l Read £ Al Clear Simple

Ertor

EE ED" Handler
=can rate
Figure 7-13. Using Intermediate VIs to Continuously Acquire Time-Sampled Data

There are two ways that you can read data from the circular buffer
using the AI Read VI. If you already know the total number of samples
you want to acquire, you can call the Al Read VI so that after several
loops, you will have acquired all the desired data. If you do not know
exactly how much data you want to acquire, then set your program up
to call the AI Read VI from a continuous loop within your VI and place
a stop button on the front panel so that you can stop your VI.

Circular-Buffered Analog Input Examples

The only differences between the simple buffered applications and
circular-buffered applications in the block diagram is the number of
scans to read input of the Al Start VI is set to 0, and now we must call
the Al Read VI repeatedly to retrieve your data. These changes can be
applied to many of the examples in the previous section on simple
buffered analog input, however we will review the basic
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circular-buffered analog input VI here, and discuss some other
example VIs that are included with LabVIEW.

Basic Circular-Buffered Analog Input

Figure 7-14 shows an example VI that brings data from channel 0 at a
rate of 1000 samples/s into a buffer that can hold 4000 samples. This
type of example might be handy if you wanted to watch the data from
a channel over a long period of time, but you could not store all the data
in memory at once. The Al Config VI sets up the channel specification
and buffer size, then the AI Start VI initiates the background data
acquisition and specifies the rate. Inside the While Loop, the AI Read
VI repeatedly reads blocks of data from the buffer of a size equal to
either 1000 scans or the size of the scan backlog—whichever one is
larger. The VI does this by using the Max & Min function to determine
the larger of the two values. You do not have to use the Max & Min
function in this way for the application to work, but the function helps
control the size of the scan backlog, which is how many samples that
are left over in the buffer. This VI will continuously read and display
the data from channel 0 until an error occurs or until you press the stop

button.
Read & chart data until an error cccurs, or the stop button pressed.
- Transposed
wavetorm
£ I—I-[Eﬂ Chart
Levvice 01| [[T22]] @ Boil
—
I k I
Channels (0| [abellF, " arher  rfio d c1tir
Buffer Size a8l o v i
(4000 scans)
SEL o =HE r
Scan Fate |EEG %
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oo
at a time (10007 stop m

Figure 7-14. Basic Circular-Buffered Analog Input Using the Intermediate VIs

Other Circular-Buffered Analog Input Examples

There are many other circular-buffered analog input VIs that are
included with your LabVIEW application. The following sections
briefly explain some of these VIs. You can find the first two VIs in
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examples\dag\anlogin\anlogin.11b and the rest of the
example VIs in examples\dag\anlogin\strmdisk.1l1lb. For
information on how these examples work and how to modify them,
open Windows»Show VI Information or open the Help window by
choosing Help»Show Help.

Cont Acq&Chart (buffered).vi

The Cont Acg&Chart (buffered).vi demonstrates
circular-buffered analog input similarly to the previous example, but
this VI includes other front panel inputs.

Cont Acq&Graph (buffered).vi

The Cont Acqg & Graph (buffered) .vi issimilar to Cont
Acg&Chart (buffered) .vi, except this VI displays datain a
waveform graph.

Cont Acq to File (binary).vi

In the Cont Acqg to File (binary) .vi, your program acquires
data through circular-buffered analog input and stores it in a specified
file as binary data. This process is more commonly called streaming to
disk.

Cont Acq to File (scaled).vi

The Cont Acg to File (scaled) .vi is similar to the previous
binary VI, with the exception that this VI writes the acquired data to a
file as scaled voltage readings rather than binary values.

Cont Acq to Spreadsheet File.vi

The Cont Acg to Spreadsheet File.vi continuously reads
data that LabVIEW acquires in the circular buffer, and stores this data
to a specified file in spreadsheet format. You can view the data stored
in a spreadsheet file by this VI in any spreadsheet application.
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Triggers

The single-point and waveform acquisitions discussed in the previous
sections start at random times relative to the data. But, there are times
that you may need to be able to set your analog acquisition to start at a
certain time. An example of this would be if you wanted to measure the
temperature of an object after applying heat to it. An electrical
thermometer sends a step voltage to your data acquisition (DAQ)
device after the heating process completes. If you have no way to begin
measuring data immediately after your device receives the step voltage,
then you must acquire more points, some before the step voltage and
some after it in order to capture the data you need. As you can see, this
solution is an inefficient use of computer memory and disk space,
because you must allocate and use more than is necessary. Sometimes
the data you need may be closer to the front of the buffer and other
times it may be closer to the end of the buffer.

However, there is a way to start an acquisition based on the condition
or state of an analog or digital signal. This technique is commonly
called triggering. Generally, a trigger is any event that causes or starts
some form of data capture. There are two basic types of triggering—
hardware and software triggering. In LabVIEW, you can use software
triggering to start acquisitions or use it with an external device to
perform hardware triggering.

Hardware Triggering

Hardware triggering lets you set the start time of an acquisition and
gather data at a known position in time relative to a trigger signal.
External devices produce hardware trigger signals. In LabVIEW, you
specify the triggering conditions that must be reached before
acquisition begins. Once the conditions are met, the acquisition begins
immediately. You can also analyze the data before trigger.

There are two specific types of hardware triggers: digital and analog.
In the following two sections, you will learn about the necessary
conditions to start an acquisition with a digital or an analog signal.
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Digital Triggering
A digital trigger is usually a transistor-transistor logic (TTL) level
signal having two discrete levels—a high and a low level. When
moving from high to low or low to high, a digital edge is created. There
are two types of edges: rising and falling. You can set your analog
acquisition to start as a result of the rising or falling edge of your digital
trigger signal.

In Figure 8-1, the acquisition will begin after the falling edge of the
digital trigger signal. Usually digital trigger signals are connected to
STARTTRIG*, EXTTRIG*, or DTRIG pins on your DAQ device. If
you want to know which pin your device has, look at your hardware
manual, or at the Al Trigger Config VI description in Chapter 10,
Advanced Analog Input Vs, of the LabVIEW Data Acquisition VI
Reference Manual. Digital signals that are connected to STARTTRIG*
and EXTTRIG* pins are inverted, meaning high-level signals become
low and falling edges become rising. Make sure you account for this
situation when specifying your triggering conditions.

TTL Signal

Connect to STARTTRIG*, EXTTRIG*,
or DTRIG Pins

Falling Edge of Signal \

Data Capture Initiated

Figure 8-1. Diagram of a Digital Trigger

Figure 8-2 shows a timeline of how digital triggering works for post-
triggered data acquisition. In this example, an external device sends a
trigger, or TTL signal, to your DAQ device. As soon as your DAQ

LabVIEW Data Acquisition Basics Manual 8-2 © National Instruments Corporation



Chapter 8  Controlling Your Acquisition with Triggers

device receives the signal, and your trigger conditions are met, your
device begins taking data.

External Digital Trigger DAQ
Device Signal = Device

DAQ Device continues checking signal until
digital trigger conditions are met. Then ...

External Analog Data DAQ
Device Device

Figure 8-2. Digital Triggering with Your DAQ Device

Digital Triggering Examples

A common example of digital triggering in LabVIEW is the Acquire N
Scans-DTrig VI, found in examples\dag\anlogin\anlogin.1l1lb.
This VI, as shown Figure 8-3, uses the Al Waveform Scan VI to
perform a buffered acquisition, where LabVIEW stores data in a
memory buffer during acquisition. After the acquisition completes, the
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VI retrieves all the data from the memory buffer and displays it.
Figure 8-3 shows the block diagram of this example VI.

dig tng & & B:T{==mm__
dig trig A:F [F
branzpoged
[ i forrm
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] @a Jrap
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.00 EE i 3

{ [561] [|valtage datal

linput limits [no change]]

number of zcans
bo acguire (1000

zCan rate-‘
(1000 scansdzec)

Figure 8-3. Block Diagram of the Acquire N Scans-DTrig VI

For more information on buffered acquisitions, refer to Chapter 7,
Buffering Your Way through Waveform Acquisition.

You must tell your device the conditions on which it will start
acquiring data. The following figure shows the trigger and clock
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cluster input, where you specify the triggering conditions on the Al
Waveform Scan VI.

trigger and clock
[no trig, int clk)

trigger type (no trig:0)
E no trigger |||E|

pretrigger  edge ar slope
zeans (00 (no change)

E]EI ||E] no change |||E|

analag chan (=) & level [0 Y1)

trigger channel

=can clock source
(no change :0)

El no change | @

For this example, trigger type should be set to Digital Trigger
A. You should only use the Digital Trigger A & B when you
have two triggers: start and stop. This chapter only discusses
applications that use one digital trigger. For more information on
two-triggered applications, look at the description for the Al Trigger
Config VI, found in Chapter 6, Advanced Analog Input Vls, in the
LabVIEW Data Acquisition VI Reference Manual.

In LabVIEW, you can acquire data both before and after a digital
trigger signal. If the pretrigger scans is >0, your device will acquire
data before the triggering conditions are met and subtract the number
of scans parameter value from the pretrigger scans parameter value to
determine the number of scans to collect after the triggering conditions
are met. If pretrigger scans is 0, then you will acquire the number of
scans after the triggering conditions are met.

Before you start acquiring data, you must specify in the edge or slope
input when the acquisition should be triggered on the rising or falling
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Analog Triggering

edge of the digital trigger signal. The analog chan and level and scan
clock source inputs are not used for digital triggering.

Digital Triggering Examples

The Acquire N Scans-DTrig example VI holds the data in a memory
buffer until your device completes the acquisition. The number of data
points you need to acquire must be small enough to fit in memory. This
VI only views and processes the information after the acquisition. If
you need to view and process information during the acquisition, use
the Acquire & Proc N Scans-Trig VI, found in examples\daaq\
anlogin\anlogin.llb. If you expect multiple digital trigger
signals that will start multiple acquisitions, use the example VI,
Acquire N-multi-DTrig, located in examples\daglanlogin\
anlogin.llb.

You connect analog trigger signals to the analog input channels—the
same channels where you connect analog data. Your DAQ device
monitors the analog trigger channel until trigger conditions are met.
You configure the DAQ device to wait for a certain condition of the
analog input signal, like the signal (or voltage) level or slope (either
rising or falling). Once the device identifies the trigger conditions, it
starts an acquisition. In Figure 8-4, the analog trigger is set to start the
data acquisition on the rising slope of the signal, when the signal
reaches 3.2 volts.

Volts

32 +———————

Level and Slope of
Signal Initiates Data Capture

Figure 8-4. Diagram of an Analog Trigger
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Figure 8-5 explains analog triggering for post-triggered data
acquisition using a timeline. You configure your DAQ hardware in
LabVIEW to begin taking data when the incoming signal is on the
rising slope and when the amplitude reaches 3.2 volts. Your DAQ
device receives this message, waits until the pulse reaches the starting
point you designated, and then begins capturing data.

External Analog Trigger DAQ
Device Signal o Device

l

DAQ Device continues checking signal until
analog trigger conditions are met. Then ...

External Analog Data DAQ
Device Device

Figure 8-5. Analog Triggering with Your DAQ Device

Analog Triggering Examples

A common example of analog triggering in LabVIEW is the Acquire N
Scans-ATrig VI, located in examples\dag\anlogin\
anlogin.1llb. This VI, as shown in Figure 8-6, uses the Al
Waveform Scan VI to perform buffered acquisition, where data is
stored in a memory buffer during acquisition. After the acquisition
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completes, the VI retrieves all the data from the memory buffer and

displays it.

Foftware tigger (NILTE]- B>
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Figure 8-6. Block Diagram of the Acquire N Scans-ATrig VI

For more information on buffered acquisition, read Chapter 7,
Buffering Your Way through Waveform Acquisition.
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You must tell your device the conditions on which to start acquiring
data. The following shows the trigger and clock cluster input, where
you specify the triggering conditions on the AI Waveform Scan VI.

trigger and clock
[no trig, int lk)

trigger type Cnao trig:0)
E na trigger |||E|

pretrigger edge ar slope
zcans (0)  (no change)

@D ||H na change "@

analog chan (-1 & lewel (O V)

trigger channel

scan clock source
[no change :0)

E na change ||E|

In this example, trigger type should be set to analog trigger. The
Acquire N Scans-ATrig VI has the option to use condition retrieval to
simulate a hardware trigger in software. Conditional retrieval is
discussed in the next section.

In LabVIEW, you can acquire data both before and after an analog
trigger signal. If the pretrigger scans is >0, your device acquires data
before the triggering conditions and subtracts the number of scans
parameter value from the pretrigger scans parameter value to
determine the number of scans to collect after the triggering conditions
are met. If pretrigger scans is 0, then the number of scans will be
acquired after the triggering conditions are met.

Before you start acquiring data, you must specify in the edge or slope
input if the acquisition is going to be triggered on the rising or falling
edge of the analog trigger signal. Aside from specifying the slope, you
must determine the channel where the analog triggering signal will be
connected as well as the voltage level on the triggering signal needed
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to begin acquisition. In other words, once you specify the channel of
the triggering signal, LabVIEW will wait until the slope and voltage
level conditions are met before starting a buffered acquisition.

The Acquire N Scans-ATrig example VI, located in examples\
dag\anlogin\anlogin.1l1lb, holds the data in a memory buffer
until the device completes data acquisition. The number of data points
you want to acquire must be small enough to fit in memory. This VI
only views and processes the information after the acquisition. If you
need to view and process information during the acquisition, use the
Acquire & Proc N Scans-Trig VI, located in examples\daqg\
anlogin\anlogin.11b. If you expect multiple analog trigger
signals that will start multiple acquisitions, use the example Acquire N-
multi-ATrig, located in examples\dag\anlogin\anlogin.llb.

Software Triggering

Software triggering allows you to simulate an analog trigger using
software. This form of triggering is often used in situations where
hardware triggers are not available. Another name for software
triggering signals, specifically analog signals, is conditional retrieval.
With conditional retrieval, you set up your DAQ device to collect data,
but the device does not return any data to LabVIEW unless the data
meets your retrieval conditions. LabVIEW scans the input data and
performs a comparison with the conditions, but does not store the data
until it meets your specifications. Figure 8-7 shows a timeline of events
that typically occur when you perform conditional retrieval.

The read/search position pointer traverses the buffer until it finds the
scan location where the data has met the retrieval conditions. Offset
indicates the scan location from which the VI begins reading data
relative to the read/search position. A negative offset indicates that you
need pretrigger data (data prior to the retrieval conditions). If offset is
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greater than 0, you should need posttrigger data (data after retrieval
conditions).

Signal Checked for

Device

External Trigger Conditions o DAQ

Device

Rest of Data

When trigger conditions are met ...

l
l

When Offset =0

read/search position

Scan| Scan| Scan | Scan

When Offset < 0

read/search position

AN

Start reading data

.

1 2 3

Scan| Scan| Scan| Scan

\

Y
Offset
Start reading data

When Offset > 0

read/search position

Scan | Scan | Scan | Scan

Offset T

Start reading data

© National Instruments Corporation

Figure 8-7.
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Timeline of Conditional Retrieval
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The conditional retrieval cluster of the Al Read VI specifies the analog
signal conditions of retrieval, as shown in Figure 8-8.

conditional retrieval (off)

mode (off] channel index (0]  slope (rising)  level (0.0)

Aot | ] Blisne ] Hoo0

hysteresis [0.0) skip count [0) offset [0]

Figure 8-8. The Al Read VI Conditional Retrieval Cluster

7= Note: Remember that the actual data acquisition is started by running your VI
and that the conditional retrieval just controls the returning of data
already being acquired.

When acquiring data with conditional retrieval, you typically store the
data in a memory buffer, similar to hardware triggering applications.
After you start running the VI, the data is placed in the buffer. Once the
retrieval conditions have been met, the AI Read VI searches the buffer
for the desired information. As with hardware analog triggering, you
specify the analog channel, called channel index, of the triggering
signal as well as the slope (rising or falling) and the level. The AI Read
VI begins searching for the retrieval conditions in the buffer at the
read/search position, another input of the AI Read VI. Once the slope
and level conditions on channel index have been found, the read/search
position indicates the location where the retrieval conditions were met.
The offset, a value of the conditional retrieval input cluster, indicates
the scan locations from which the VI begins reading data relative to the
read\search position. A negative offset indicates data prior to the
retrieval condition pretrigger data, and a positive offset indicates data
after the retrieval condition posttrigger data. The skip count parameter
shows the number of times the trigger conditions are met. The
hysteresis parameter displays the range of voltage levels you will use
to meet retrieval conditions. For more information on the conditional
retrieval input cluster, look at the AT Read VI description in Chapter 4,
Intermediate Analog Input Vls, in the LabVIEW Data Acquisition VI
Reference Manual.

Conditional Retrieval Examples

You can use the Al Waveform Scan VI to perform conditional retrieval
just as you use it for hardware analog triggering. Actually, the Al
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Waveform Scan VI calls the Al Read VI to perform conditional
retrieval as discussed in the previous section. The Acquire N
Scans-ATrig example, located in examples\dag\anlogin\
anlogin.l1b, uses the AI Waveform Scan VI, as shown in
Figure 8-9.

tirne: lirrit [5 gec

software trigger [T[CTE]]}- g—,:"'

pretrigger
zeans [0

trig slope [1:rising 1] tranzposed
. | warvefarm
trig chan [ 10.00 araph

trigaer lesel [0

B £-+ = [==x ]|
'-.ﬂ:ultaﬁe data

[561]

limput limits [no change]|
[=0s]
device [1 _ s

——

FC:ar rate

1000 zcans/sec

Figure 8-9. Block Diagram of the Acquire N Scans-ATrig VI

The main difference between the trigger condition inputs for
conditional retrieval and hardware triggering is the type of trigger. You
set up trigger channel, slope, and voltage level the same way for both
triggering methods. The pretrigger scans value will be negated and
connected to the offset value in the conditional retrieval cluster of the
Al Read VI. When the trigger conditions are met, the VI will return the
requested number of scans.

If you need to control your acquisition buffer size or if you need to

acquire data continuously, then you should use the Intermediate VIs:
Al Config, Al Start, Al Read, and AI Clear. The Acquire N
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Scans-SWTrig example VI, located in examples\dag\anlogin\
anlogin.1l1b, uses these VIs. Because the Al Read VIis used in this
example, the triggering conditions are specified in the conditional
retrieval input cluster. The acquisition is continuous in this example,
so your device stores the acquired data in a circular buffer. As the data
is being applied, the VI searches the trigger channel data for data that
meets the trigger conditions. When a trigger condition is met or a
timeout occurs, the acquisition is stopped.
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Letting an Outside Source
Control Your Acquisition Rate

Typically, a data acquisition (DAQ) device uses internal counters to
determine the rate to acquire data, but sometimes you might need to
capture your data at the rate of particular signals in your system. For
example, you can also read temperature channels every time a pulse
occurs which represents pressure rising above a certain level. In this
case, internal counters are inefficient for your needs. You must control
your acquisition rate by some other, external source.

You could compare a scan of your channels to taking a snapshot of the
voltages on your analog input channels. If you set your scan rate to 10
scans per second, you are taking 10 snapshots each second of all the
channels in your channel list. In this case, an internal clock within your
device (the scan clock) sets the scan rate, which controls the time

interval between scans.

Also, remember that most DAQ devices (those that do not
simultaneously sample) proceed from one channel to the next
depending on the channel clock rate. Therefore, the channel clock is the
clock controlling the time interval between individual channel samples
within a scan, which means the channel clock proceeds at a faster rate

than the scan clock.

The faster the channel clock rate, the more closely in time your system
samples the channels within each scan, as shown in Figure 9-1.
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Note: For devices with both a scan and channel clock, lowering the scan rate
does not change the channel clock rate.

o1z 3 o122 3 ni1laz T

L] L[] | |11

(] . — -
channel intersal scan inkerval

Figure 9-1. Channel and Scan Intervals Using the Channel Clock

Some DAQ devices do not have scan clocks, but rather use
round-robin scanning. Figure 9-2 shows an example of round-robin
scanning.

I|:I 1 2 2 ] 1 2 3 ] 1 2 3

1 [ [ [ [ [ |
S~

channel intersal

Figure 9-2. Round-Robin Scanning Using the Channel Clock

The devices that always perform round-robin scanning include:
NB-MIO-16, PC-LPM-16, DAQCard-500, DAQCard-700, Lab-NB,
Lab-SE, and Lab-LC. With no scan clock, the channel clock is used to
switch between each channel at an equal interval. The same delay
exists between all channel samples, as well as between the last channel
of a scan and the first channel in the next scan. (For boards with scan
and channel clocks, round-robin scanning occurs when you disable the
scan clock by setting the scan rate to zero and using the interchannel
delay of the AI Config VI to control your acquisition rate.)

Finally, remember that LabVIEW is scan-clock oriented. In other
words, when you select a scan rate, LabVIEW automatically selects the
channel clock rate for you. LabVIEW selects the fastest channel clock
rate that allows adequate settling time for the Analog-to-Digital
Converter (ADC).

LabVIEW adds an extra 10-us to the interchannel delay to compensate
for any unaccounted factors. However, LabVIEW does not consider

this additional delay for purposes of warnings. If you have specified a
scan rate that is adequate for acquisition but too fast for LabVIEW to
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apply the 10-us delay, it configures the acquisition but does not return
a warning.

You can set your channel clock rate with the interchannel delay input
of the AI Config VI, which calls the Advanced AI Clock Config VI to
actually configure the channel clock. The simplest method to select an
interchannel delay is to gradually increase the delay, or clock period,
until the data appears consistent with data from the previous delay
setting.

Refer to your hardware manuals for the required settling time for your
channel clock. You can also find the interchannel delay by running the
low-level Al Clock Config VI for the channel clock with no frequency
specified.

Externally Controlling your Channel Clock

There are times when you might need to control the channel clock
externally. The channel clock rate is the same rate at which analog
conversions occur. For instance, suppose you need to know the strain
value at an input, every time an infrared sensor sends a pulse. Most
DAQ devices have an EXTCONV* pin on the I/O connector for
providing your own channel clock. This external signal must be a TTL
level signal, where the actual conversion occurs on the falling edge of
the signal, as shown in Figure 9-3. With devices that have a RTSI
connector, you can get your channel clock from other National
Instruments DAQ devices.

rising edge falling edge

TTL Signal

Figure 9-3. Example of a TTL Signal

Figure 9-4 shows you the Getting Started Analog Input example VI,
located in examples\dag\run_me. 11b. This example demonstrates
how to set up your acquisition for an externally controlled channel
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clock. The Getting Started Analog Input VI places acquired data in a
buffer. For purposes of this discussion, the VI was slightly altered and
now includes the AI Clock Config VI and the clock source was
connected to the I/O connector.

device (1)

channels (0)

number of scans
to acquire [1000)

scan rate

Which Clock = Channel Clogk  Timeout = 3 seconds

EI transposed voltage graph

|

Al 3]
| 2TART RERD CLEAR
s s Y

[0 =: dizables scan elock)

SGL

Figure 9-4. Getting Started Analog Input Example VI

You can enable external conversions by calling the Advanced-level Al
Clock Config VI. Remember that the AI Clock Config VI, which is
called by the AI Config VI, normally sets internal channel delay
automatically or manually with the Interchannel Delay control.
However, calling the AI Clock Config VI after the AI Config VI resets
the channel clock so that it comes from an external source for external
conversion. Also, notice that the scan clock is still set internally on
those devices that have a scan clock. If you want round-robin scanning
for those devices that support both scan and channel clocks, change the
scan rate to 0.

e Note: Dynamic signal acquisition (DSA) devices, like the AT-A2150, do not
support external conversion pulses.

On most devices, external conversions occur on the falling edge of the
EXTCONYV* line. Consult your hardware reference manual for timing
diagrams. On the MIO-E series devices, you can set the Clock Source
Code input of Al Clock Config VI to the PFI pin with either falling or
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rising edge or use the default PFI2/Convert* pin where the conversions
occur on the falling edge, as shown in Figure 9-5.

clock zource [no change)

clock source code [ clock source string ]

internal

140 connectar
ETS1 connection

FFI pin, lovw ta high

FFI pin, high ta low

ETSI1 pin, Tow to high
ETSI pin, high to Tow
GPCTE output, low to high
GPCTE output, high to Tow
STCOUT, lavw ta high
STCOUT, high ta Tow

Figure 9-5. Setting the Clock Source Code for External Conversion Pulses
for E Series Devices

Note: The AT-MI10-16, AT-MI10-16D, NB-M10-16, and NB-MI0-16X cannot
support both an external channel clock and a digital trigger signal at the
same time. You must choose one or the other.

Because LabVIEW determines the length of time before the AI Read
VItimes out based on the interchannel delay and scan clock rate, you
may need to force a time limit for the AI Read VI, as shown previously
in Figure 9-4.

Note: On the Lab-PC+, SCXI-1200, DAQPad-1200, and DAQCard-1200, the
first clock pulse on the EXTCONV¥* pin configures the acquisition but
does not cause a conversion. However, all subsequent pulses cause
conversions.

Externally Controlling your Scan Clock

External scan clock control may be more useful than external channel
clock control if you are sampling multiple channels, but may not be as
obvious to find because it does not have the input on the I/O connector
labeled “ExtScanClock,” the way the EXTCONV* pin does.
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Note: Some MIO devices have an output on the 1/0 connector labeled
ScanClock. This cannot be used as an input.

The appropriate pin to input your external scan clock can be found in
the Table 9-1.

Table 9-1.  External Scan Clock Input Pins

Device External Scan Clock
Input Pin
AT-MIO-16 Out2
AT-MIO-16F-5
AT-MIO-16X
AT-MIO-16D
AT-MIO-64F-5

Al E Series Devices| Any PFI Pin

Lab-PC+ OutB1
SCXI-1200

DAQPad-1200
DAQCard-1200

%  Note: Some devices do not have internal scan clocks and therefore do not
support external scan clocks. These devices include: NB-M10-16,
PC-LPM-16, DAQCard-700, DAQCard-500, Lab-NB, Lab-SE,
and Lab-LC.

After connecting your external scan clock to the correct pin, set up the
external scan clock in software. For example, in the Getting Started
Analog Input Example VIs, located in examples\dag\run_me . 11b,
you would configure the external scan clock by setting the Scan Clock
Source control to 2 (I/O connector) in the Al Start VI as shown in
Figure 9-6. This disables the internal scan clock from driving the scan
clock circuitry. You do not need to specify a scan rate value because
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your device ignores this value when you set it up to use an external scan

clock.
Timeout = 5 seconds
EI transposed voltage graph
device (1]
I1lG
CIII?“IFIG ] ST'HRT REII:IEI =l CLIEIHR
channels (0] ! + C! mrEl @
number of scans
to acquire (1000] Scan Clock Source = 1/0 Connector
scan rate
[Input ignored with external clack)
aGL

Figure 9-6. Externally Controlling Your Scan Clock with the Getting Started Analog Input Example VI

The NB-MIO-16X cannot support external scan clocks as the other
devices can. The device layout does not allow you to directly provide
an external scan clock. Instead, you can offer a timebase to the internal
counter, counter 5, that generates the scan clock. Do this by sending a
timebase into the source 5 pin and calling the Advanced VIs used by
the AI Clock Config VI. In addition, you need to wire the alternate
clock rate specifications as shown below into the AI Clock Config VI.
Remember that the which clock input of the AI Clock Config VI should

be set to scan clock (1).

[ alternate clock rate specification (no change) ]

clock period timebase signal
B 100 | Hl-1.00 |

timebaze source timebase divisor
E]n-:- change H—1
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Note: You must divide the timebase by some number between 2 and 65535 or you
will get a bad input value error.

Because LabVIEW determines the length of time before Al Read times
out based on the interchannel delay and scan clock rate, you may need
to force a time limit into Al Read. In Figure 9-6, the time limit is

5 seconds.

Externally Controlling the Scan and Channel Clocks

You can control the scan and channel clocks simultaneously by
combining the two previous sections. However, make sure that you
follow the proper timing. Figure 9-7 demonstrates how you can set up
your application to control both clocks.

Which Clack = Channel Clack  Timeout = 5 seconds
E transposed voltage graph

device (1)

[116] CT e 1 Al Al Al

- ETART READ =l CLEAR @
e | phete]

channels (0)
number of scans o Clock 5 —oc +
to acquire (1000) I can Clock Source = onnector

Figure 9-7. Controlling the Scan and Channel Clock Simultaneously
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Making Waves with
Analog Output

This section contains basic information on generating data with
LabVIEW, including generating a single point or multiple points.

Part 3, Making Waves with Analog Output, contains the following
chapters.

e Chapter 10, Things You Should Know about Analog Output, explains
how to use LabVIEW to produce all of the different types of analog
output signals.

e Chapter 11, One-Stop Single-Point Generation, shows you which
VIs to use in LabVIEW to perform single-point updates.

*  Chapter 12, Buffering Your Way through Waveform Generation,
shows you which VIs to use in LabVIEW to perform buffered
analog updates.



Things You Should Know about
Analog Output

Some measuring systems require that analog signals be generated by a
data acquisition (DAQ) device. This analog signal can be a steady or
slowly changing voltage, or a continuously changing waveform. The
next few sections show you how to use LabVIEW to produce all of
these different types of signals. First, you should learn about the
various situations in which you might need to produce an analog signal.

Single-Point Output

When the voltage level at the output is more important than the rate at
which the output voltage changes, you need to generate a steady DC
voltage. You can use the single-point analog output VIs to produce this
type of output. Any time you want to change the voltage on an analog
output channel, you must call one of the VIs that produces a single
update (a single voltage change). Therefore, you can change the output
voltage only as fast as LabVIEW calls the VIs. This technique is called
software timing. You should use software timing if you do not need
high speed generation or very accurate timing. Refer to Chapter 11,
One-Stop Single-Point Generation, for more information on
single-point output.

Buffered Analog Output

Sometimes in performing analog output, the rate that your updates
occur is just as important as the voltage level. This is called waveform
generation, or buffered analog output. For example, you may want
your DAQ device to act as a function generator. You can do this by
storing one cycle of sine wave voltage data in an array, and
programming the DAQ device to continuously generate the voltages in
the array one point at a time at a specified rate. This is known as
single-buffered analog output. But what if you want to generate a
continually changing waveform? For example, you may have a large
file stored on disk that contains data that you want to output. Because
LabVIEW cannot store the entire waveform in a single buffer, you must
continually load new data into the buffer during the generation. This
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process requires the use of circular-buffered analog output in
LabVIEW. To learn more about single or circular buffering, read
Chapter 12, Buffering Your Way through Waveform Generation.
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One-Stop Single-Point
Generation

In the preceding chapter, you learned the appropriate time to use
single-point updates. This chapter shows you which VIs to use in
LabVIEW to perform these updates.

Single-Immediate Updates

The most basic way to program single-point updates in LabVIEW is by
using the Easy Analog Output VI, AO Update Channels. Figure 11-1
shows a diagram of a VI that writes voltages to one or more output
channels on the output data acquisition (DAQ) device.

Cewvice

40 Update Channels . wi
Channels [0:1] T

Moltages

[5GL]

Figure 11-1. Single Immediate Update Using the AO Update Channels VI

Notice that an array of voltages is passed as an input to the VI. The first
element in the array corresponds to the first entry in the channel string,
and the second array element corresponds to the second channel entry.
For more information on channel string syntax, refer to Chapter 3,
Basic LabVIEW Data Acquisition Concepts. Remember that Easy VIs
already have built-in error handling.

If you want more control over the limit settings for each channel, you
can also program a single-point update using the Intermediate Analog
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One-Stop Single-Point Generation

Output VI, AO Write One Update. Figure 11-2 shows an example of
using this VI.

Tirnit settings

Figure 11-2. Single Immediate Update Using Intermediate VI

In this example, your program passes the error information to the
Simple Error Handler VI. The iteration input optimizes the execution
of this VI if you wanted to place it in a loop. For more information,
look at the next section. With Intermediate VIs, you gain more control
over when you can check errors.

Multiple-limmediate Updates

Figure 11-3 shows the block diagram of a VI that performs multiple
updates. The Write N Updates example VI, located in examples\
dag\analogout.11lb, is similar to Figure 11-3. The diagram shown
in Figure 11-3 resembles the one shown in Figure 11-2, except that the
While Loop executes the subVI repeatedly until either the error status
or the stop boolean is TRUE. You could use the Easy Analog Output
VI, AO Write One Update, in a loop, but this is inefficient because the
Easy I/O VIs configure the device every time they execute. The AO
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Write One Update VI configures the device only when the value of the
iteration input is set to 0.

Tirnit zettings
N,

A0 tw'rite One Update i Sirnple Error Handler i

£ T B
1-UP
B
5

voltage data

Figure 11-3. Multiple Immediate Updates Using Intermediate VI

Figure 11-3 shows an immediate, software-timed analog output VI
application. This means that software timing in a loop controls the
update rate. One good reason to use immediate, software-timed output
is that your application calculates or processes output values one at a
time; however, you should remember that software timing is not as
accurate as hardware-timed analog output. For more information on
hardware-timed analog output, refer to Chapter 12, Buffering Your
Way through Waveform Generation.
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Buffering Your Way through
Waveform Generation

In Chapter 10, Things You Should Know about Analog Output, you
learned when to use buffered analog updates. This chapter shows you
which VIs to use in LabVIEW to perform these updates.

Buffered Analog Output

You can program single-buffered analog output in LabVIEW using an
Easy Analog Output VI, AO Generate Waveforms, as shown in
Figures 12-1. This VI writes an array of output voltages to the analog
output channels at a rate specified by the Update Rate parameter. For
example, if Channels is 0, 1 and the Voltages array consists of two
columns containing voltage data for the two channels, LabVIEW writes
voltages from each column to the corresponding channels at every
update interval. After LabVIEW writes all of the voltages in the array
to the channels, the VI stops. The voltage level on the output channel
maintains the value of the final voltage in the array until another
voltage value is generated. Easy VIs contain error handling. If an error
occurs in the AO Generate Waveforms VI, a dialog box appears
displaying the error number and description, and the VI stops running.

device

channels —

HULT FT
=7

update rate =

valtages

Figure 12-1. Waveform Generation Using the AO Generate Waveforms VI
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As with single-point analog output, you can use the Analog Output
Utility VI, AO Waveform Gen, for most of your programming needs.
This VI has several inputs and outputs that the Easy I/O VI does not
have. You have the option of having the voltage array generated once,
several times, or continuously through the generation count input.
Figures 12-2 shows an example diagram of how to program this VI.

Generation count

device

channels Eprme

[abe] WRYE
T}.’.'.

update rate

waltages

Figure 12-2. Waveform Generation Using the AO Waveform Gen VI

In this example, LabVIEW generates the voltages in the array five
times before stopping.

The Generate N Updates example VI, located in examples\dag\
anlogout.11b, uses the AO Waveform Gen VI. Putting this VI in a
loop and wiring the iteration terminal of the loop to the iteration input
on the VI optimizes the execution of this VI. When iteration is O,
LabVIEW configures the analog output channels appropriately. If
iteration is greater than 0, LabVIEW uses the existing configuration,
which improves performance. With the AO Waveform Gen VI, you can
also specify the limit settings input for each analog output channel. For
more information on limit settings, refer to Chapter 3, Basic LabVIEW
Data Acquisition Concepts.
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If you want even more control over your analog output application, use
the set of Intermediate DAQ VIs, as shown in Figures 12-3.

violtages update rate

Figure 12-3. Waveform Generation Using Intermediate VIs

With these VIs, you can set up an alternate update clock source (such
as an external clock or a clock signal coming from another device) or
return the update rate. The AO Config VI sets up the channels you
specify for analog output. The AO Write VI places the data in the
buffer, the AO Start VI begins the actual generation at the update rate,
and the AO Wait VI waits until the waveform generation completes.
Then, the AO Clear VI unconfigures the analog channels.

The Generate Continuous Sinewave VI, located in examples\dag\
anlogout.11b, is similar in structure to Figure 12-3. This example
VI continually outputs a sine waveform through the channel you
specify.

Changing the Waveform during Generation:
Circular-Buffered Output

When your waveform data is too large to fit in a memory buffer or is
constantly changing, you should use a circular buffer to output the
data. You also could use the Easy Analog Output VIs in a loop to create
a circular-buffered output; but this sacrifices efficiency because Easy
VIs configure, allocate, and deallocate a buffer every time they
execute. When you spend time configuring, allocating, and
deallocating a buffer, there are time gaps between the data output.
Figures 12-4 and 12-5 show two different ways to perform
circular-buffered analog output using the Intermediate VIs in
LabVIEW. Figures 12-4 shows the AO Continuous Gen VI, which is
more efficient than the Easy Analog Output VIs in that it configures
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and allocates a buffer when its iteration input is 0 and deallocates the
buffer when the clear generation input is TRUE.

dewice
40 Continuous Gen.owi
channels

=T an I
C-GEH

=]

update rate :
new waltages

[5GL]

Figure 12-4. Circular Buffered Waveform Generation Using the AO Continuous Gen VI

With the AO Continuous Gen VI, you can configure the size of the data
buffer and the limit settings of each channel. For more information on
how to set limit settings, refer to Chapter 3, Basic LabVIEW Data
Acquisition Concepts.

The Continuous Generation example VI, located in examples\daq\
anlogout.1l1b, uses the AO Continuous Gen VI. In this example,
the data completely fills the buffer on the first iteration. On subsequent
iterations, new data is written into one half of the buffer while the other
half continues to output data.

To gain more control over your analog output application, use the
Intermediate VIs shown in Figure 12-5. With these VIs, you can set up
an alternate update clock source and you can monitor the update rate
the VI actually uses. The AO Config VI sets up the channels you
specify for analog output. The AO Write VI places the data in a buffer.
The AO Start VI begins the actual generation at the update rate. The
AO Write VI in the while loop writes new data to the buffer until you
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press the stop button. Then, the AO Clear VI unconfigures the analog
channels.

W vnltaanﬁl

[5GL]

By ,F Bl

update Fate

Figure 12-5. Circular Buffered Waveform Generation Using Intermediate VIs

The Function Generator VI, located in examples\dag\
anlogout.11b, is a more advanced example of Figure 12-5. This VI
changes the output waveform on-the-fly, responding to changing signal
types (i.e., sine, square), amplitude, offset, update rate, and phase
settings on the front panel.

Eliminating Errors from Your Circular-Buffered
Application

If you get an underflow error, error number -10843, while performing
circular-buffered output, it means your program could not write data
fast enough to the buffer to output the data at the update rate. To solve
this problem, decrease the speed of the update rate. If adjusting the
update rate does not get rid of the error in your application, increase the
buffer size.
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Getting Square with Digital 1/0

This section describes basic concepts on how to use digital signals with
data acquisition in LabVIEW, including immediate and handshaked
digital I/O.

Part 4, Getting Square with Digital I/0, contains the following chapters.

»  Chapter 13, Things You Should Know about Digital I/0O, basic
concepts on digital I/0.

e Chapter 14, When You Need It Now—Immediate Digital 1/0,
explains how to use digital lines to acquire and generate data
immediately.

*  Chapter 15, Shaking Hands with a Digital Partner, shows you how
you can synchronize digital data transfers between your DAQ
devices and instruments.



Things You Should Know about

Digital 1/0

Digital I/O interfaces are often used to control processes, generate

patterns for testing, and communicate with peripheral equipment like
heaters, motors, and lights. Digital I/O components on DAQ devices
that generate or produce

and SCXI modules consist of hardware parts

on/off signals. As shown in the diagram below, all digital lines are

grouped into ports on DAQ devices and banks on SCXI modules. The

number of digital lines per port or bank is specific to the particular

device or module used, but most ports or banks consist of four or eight
lines. Except for the TIO-10 and E Series devices, all lines within the
same port or bank must all be of the same direction (either input or

output), as shown in Figure 13-1. By writing to or reading from a port,

you can set or retrieve simultaneously the states of multiple digital

lines. Refer to Appendix B, Hardware Capabilities, of the LabVIEW
Data Acquisition VI Reference Manual or your hardware user manual

for port information on your device.

Output Port
Data latches

and drivers

Output Lines

Device or Module

Input Port A:
Data latches <
and drivers <+—
4—
Input Lines

Figure 13-1. Digital Ports and Lines

There are two types of digital acquisition/generation—nonlatched (or

immediate) and latched (or handshaked). With nonlatched or
immediate digital I/O, your system updates the digital lines
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immediately. Latched or handshaked digital I/O is when a device or
module accepts or transfers data after a digital pulse has been received.
There are two types of latched (handshaked) digital I/O: non-buffered
and buffered. Not all the devices and modules support latched
(handshaked) digital I/O. Again, you should refer to the hardware
tables in Appendix B, Hardware Capabilities, of the LabVIEW Data
Acquisition VI Reference Manual or refer to your hardware manual to
see if your device or module supports it.

For specific information about the Digital I/O VIs, refer to Chapter 12,
Introduction to the Digital 1/0 Vls, in the LabVIEW Data Acquisition VI
Reference Manual.
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Immediate Digital 1/0

The most common way to use digital lines is with nonlatched
(immediate) digital I/O. All DAQ devices and SCXI modules with
digital components support this mode.

When your program calls a function in nonlatched digital I/O mode,
LabVIEW immediately updates the digital line or port output state or
returns the current digital value of an input line, depending on the
digital line direction. LabVIEW inputs or outputs only one value on a
digital line in this mode. You can completely configure port (and
sometimes line) direction in software, and you can switch directions
repeatedly in a program if necessary.

A typical example of when you might use nonlatched (immediate)
digital I/O is in controlling or monitoring relays. You can also use
multiple ports or groups of ports to perform digital I/O functions,
especially if you only have four lines in a port and need to transfer a
byte at a time. In order to group digital ports, you must use Intermediate
or Advanced VIs in LabVIEW. You can read more about grouping
multiple digital ports in the next chapter, Chapter 15, Shaking Hands
with a Digital Partner. This chapter focuses on transferring data across
a single port.

You only use the Easy Digital VIs for nonlatched digital I/O.

Figure 14-1 shows the Easy VIs and their various inputs and outputs.
The four Easy VIs can read data from or write data to a single digital
line or to an entire port immediately. For an example of how to use the
Easy Digital VIs, refer to the Getting Started Digital I/O VI in
examples\dag\run_me.11lb. Use the Easy Digital VIs for most
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digital testing purposes. All of the Easy Digital VIs have error

reporting.
port width :
port width
line state
device |TLE]]
Fre device
[abc |
channels pott number EIE
Tine -
tine |
; : iteration
iteration line state
Read from Digital Line VI Write to Digital Line VI
port width port width
device " device
pattern
channels port nurnber
pattern
iteration teration
Read from Digital Port VI Write to Digital Port VI

Figure 14-1. The Easy Digital VIs

The device input identifies the DAQ device you are using. The port
number input specifies the port of digital lines that you will use during
the digital operation. The line parameter is an individual port bit or line
in the port number. The pattern or line state is the value(s) you want
to read from or write to a device. Pattern values can be displayed in
decimal (default), hexadecimal, octal, or binary form. Refer to
Chapter 10, Numeric Controls and Indicators, in your LabVIEW User
Manual for instructions on how to change the display of a numeric
control or indicator. The iteration input optimizes your digital
operation. When iteration is zero (the default value), LabVIEW calls
the DIO Port Config VI (an Intermediate VI) to configure the port. If
iteration is greater than zero, LabVIEW uses the existing
configuration, which improves performance. You can wire this input to
an iteration terminal of a loop. Every time iteration is zero, you call the
DIO Port Config VI, which resets the digital line values to their default
values. If you want to use the same digital values from one loop
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iteration to another, only set iteration to zero for the first iteration of
the loop, then change it to a value greater than zero.

If you are using an SCXI module for nonlatched digital I/O, refer to the
SCXI Channel Addressing section in Chapter 18, Special
Programming Considerations for SCXI, of this manual for instructions
on how to specify port numbers.
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Shaking Hands with a Digital
Partner

You have just learned that in LabVIEW using non-latched (immediate)
digital I/O, you can use digital lines to acquire and generate data. But
what if you want to pass a digital pattern after receiving a digital pulse?
In this case, you should use latched digital I/0, also called
handshaking. For example, you want to acquire an image from a
scanner. The scanner sends a pulse to your DAQ device after the image
has been scanned and it is ready to transfer the data. Then, your DAQ
device reads a digital pattern, which can be 8, 16, or 32 bits in length.
The scanner sends out another pulse when it is ready to send another
digital pattern. After your DAQ device receives this digital pulse, it
reads the data. This process repeats until all the data is transferred. As
you can see, the ability to handshake gives you the ability to
synchronize digital data transfer between your DAQ device and
instrument.

The following list shows the DAQ devices that support digital
handshaking.

e AT-MIO-16D

e AT-MIO-16DE

«  DAQPad-1200

e  DAQCard-1200

¢ DIO-24 (DAQCard, NB, and PC)
¢ DIO-32F (NB and AT)

¢ DIO-96 (PCI, NB and PC)

¢ SCXI-1200
e Lab Series devices (NB, LC, and PC)
e PCI-1200

Another example of where you could use handshaking might be if you
wanted to test the durability of a product prototype. Each durability test
would be performed with a different piece of machinery for the same
amount of time. For each test, you could turn the machinery on and off
with a specific variation of handshaked digital I/O, known as pattern
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generation. Internal counters would serve to generate the handshaking
signal that initiates a digital transfer. Counters output digital pulses at
a steady frequency. Thus, you could generate and retrieve patterns at a
constant rate because the handshaking signal would be produced at a
constant rate. However, you could use this rate only if the instrument
or external hardware does not work with or require communication
signals for its data transfers. Only the DIO-32F devices support pattern
generation.

If you have an external signal controlling your digital I/O operation,
you should connect the outside signal to the I/O connector or the RTSI
connector. For more information on these connectors, refer to your
hardware manual for your device. The names and functions of
handshaking signals vary. For the DIO-32F devices, there are two
handshaking lines— the REQ (request) line and the ACK
(acknowledge) line. Use the REQ line as the handshaking line to
trigger digital input. You can use the ACK line as the handshaking line
to trigger digital output.

For all other DAQ devices that perform handshaking, there are four
handshaking signals: Strobe Input (STB), Input Buffer Full (IBF),
Output Buffer Full (OBF), and Acknowledge Input (ACK). You use the
STB and IBF signals for digital input operations and the OBF and ACK
signals for digital output operations. When the STB line is low,
LabVIEW loads data into the DAQ device. After the data has been
loaded, IBF is high, which tells the external device that the data has
been read. For digital output, OBF is low while LabVIEW sends the
data to an external device. After the external device receives the data,
it sends a low pulse back on the ACK line. Check your DAQ device
hardware manual for information on which digital port(s) can be
configured for handshaking signals.

For all the DAQ devices that support handshaking, there are separate
handshaking lines for each digital port.

Sending Out Multiple Digital Values

You can group multiple ports together so you can send more digital
values out at a time. The order of grouped ports affects which
handshaking lines you use. If you want to group ports 0 and 1 and you
list the ports in the order of 0:1, then you should use the handshaking
lines associated with port 1. In other words, always use the
handshaking lines associated with the last port in the list. So, if the
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ports are listed 1:0, then you should use the handshaking lines
associated with port 0.

For DAQ devices other than the DIO-32F devices, you must connect
all the STB lines together if you are using more than one port or
grouping ports for digital input, as shown in Figure 15-1. You should
connect only the IBF line of the last port in the port list to the other
device. No connection is needed for the IBF signals for the other ports
in the port list.

STB* [@&———
Port X4
IBF —
STB* |[¢——@
Port x 2
IBF |—
[}
[]
L[]
STB* |« L
Port x External Device
* IBF >
(last port in portList)

Figure 15-1. Connecting Signal Lines for Digital Input

If you are using more than one port or grouping ports for digital output
on DAQ devices other than the DIO-32F devices, you should connect
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only the handshaking signals of the last port in the port list, as shown
in the Figure 15-2.

ACK* —

Portx1
OBF* —
ACK* —

Port x 2
OBF* I—

[ ]

ACK* |

Port x n External Device
OBF* P>

I
(last port in portList)

Figure 15-2. Connecting Digital Signal Lines for Digital Output

There are two types of digital handshaking: non-buffered and buffered.
Non-buffered handshaking is similar to nonlatched digital I/O because
LabVIEW updates the digital lines immediately after every digital or
handshaked pulse. With buffered handshaking, LabVIEW stores
digital values in memory to be transferred after every handshaked
pulse. Both non-buffered and buffered handshaking transfer only one
digital value after each handshaked pulse. For basic digital
applications, use non-buffered handshaking. Use buffered handshaking
when your application requires multiple handshaking pulses to be
created. By using a buffer with multiple handshaking pulses, the
software spends less time reading or writing data, leaving more time
for other operations.

Note: On the DIO-32F devices with non-buffered handshaking, you can group
1, 2, or 4 ports together. For buffered handshaking on the DIO-32F
devices, you can group only 2 or 4 ports together.

You can use only Intermediate or Advanced Digital VIs for digital
handshaking in LabVIEW. The Intermediate VIs work for most all
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non-buffered and buffered digital handshaking applications. However,
for some DAQ devices, you may need to use a combination of
Intermediate and Advanced Vls.

Non-Buffered Handshaking

Non-buffered handshaking takes place when your program transfers
one digital value after receiving a digital pulse on the handshaking
lines. LabVIEW does not store these digital values in computer
memory. You should only use non-buffered handshaking when you
expect only a few digital handshaking pulses. For multiple-pulsed
applications, you should use buffered handshaking, which you can
learn about in the next section of this chapter. Figure 15-3 shows an
example of non-buffered handshaking using the Intermediate VI, DIO
Single Read/Write. In this example, LabVIEW reads the data from the
digital port(s).

data read

ort list
[us]
[a.bc] I?QI/DNI

I
=y
o Bl

Read after handshaked pulse]  [StopILTE]™ E‘D’

Figure 15-3. Non-buffered Handshaking Using the DIO Single Read/Write VI

Typically, you want to put the DIO Single Read/Write VI inside a loop.
You can use the iteration input (the terminal where the loop iteration
is connected) to optimize your digital operation. When iteration is 0
(default), LabVIEW calls the Advanced VI, DIO Group Config, to
configure the port(s). If iteration is greater than zero, LabVIEW uses
the existing configuration, which improves performance. Every time
your program calls the DIO Group Config VI, the digital line values are
reset to their default values. If you want to set the digital line values
once and keep the same values from one loop iteration to the next, set
iteration to O on the first iteration of the loop, then set iteration to 1.
When group direction is equal to 1 (default), all the ports listed in port
list are treated as inputs. The number of elements in the data read
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parameter will be the same as the product of the number of ports in the
group and the number to read parameter.

Figure 15-4 shows how you can use non-buffered handshaking to write
data. The programming flow resembles the read operation above. The
updates to write array must contain as many elements as the number
of ports multiplied by the number of values to write.

EDI[ hist
[a.hc] I

ﬁ—mr'%ﬂ

I-_i shatus

|'W’rite after handshaked pulse]

[updates to wite] [[va 1]

Figure 15-4. Non-buffered Handshaking Using the DIO Single Read/Write VI

Buffered Handshaking

Buffered handshaking allows you to store multiple points in computer
memory. Use this technique if multiple pulses are expected on the
handshaking lines. Buffered handshaking comes in two forms: simple
and circular. You can use simple-buffered handshaking on all DAQ
devices that support handshaking; but you can perform circular-
buffered handshaking only on the AT-DIO-32F. You can think of a
simple buffer as a storage place in computer memory, where buffer
size equals the number of updates multiplied by the number of ports. A
circular buffer differs from a simple buffer only in the way your
program places the data into it and retrieves data from it. A circular
buffer fills with data the same as a simple buffer, but when it gets to
the end of the buffer LabVIEW returns to the beginning of the buffer
and fills up the same buffer again. You should use simple-buffered
handshaking when you have a predetermined number of values to
acquire or generate. Use circular-buffered handshaking when you want
to acquire or generate data continuously.
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Simple Buffered Examples

The example in Figure 15-5 uses the Intermediate VIs to perform
pattern generation using the DIO-32F devices. An example VI that
ships with LabVIEW similar to the diagram below is the Digital
Buffered Handshaking VI, found in examples\dag\digio.1llb.
Notice the port list contains more than one port number, which means
the ports are grouped together.

number of updates (1000

2 H
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mﬂﬁl [l
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“WRITE
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directioh=output El
handshake source (1:intemal] -
clock frequency
1000 updates/sec

Figure 15-5. Pattern Generation Using the DI0-32F Devices
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The For Loop generates the digital data to output. The amount of data
generated equals the number of ports in the port list multiplied by the
number of updates. The direction input specifies whether the ports
are configured for input or output. The DIO Wait VI waits until the
digital buffered input or output operation completes before returning to
the main VI. The DIO Clear VI halts any transfers and clears the group
port configuration. If you want an external source to supply the
handshaking signals, you can specify the handshake source to be an
external signal entering through the I/O connector (handshake
source=2 which is the default value) or the RTSI connector
(handshake source=3). You only need to use the clock frequency if
you are performing pattern generation (having an internal handshake
source).

For DAQ devices other than the DIO-32F devices, you can use a VI
similar to the one above to output digital data. The main difference is
that you use an Advanced Digital VI, like DIO Buffer Control, instead
of the DIO Start VI, as shown in Figure 15-6. The reason for using the
DIO Buffer Control VI is because the DIO Start VI contains Digital
Clock Config and Digital Mode Config, VIs that work only with the
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DIO-32F devices. You do not need to use the Handshake source and
clock frequency inputs, because of the external handshaking signal
source.

rurnber of updates (1000
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Figure 15-6. Pattern Generation Using DAQ Devices (Other Than DIO-32F Devices)

Reading information is similar to writing data when using digital
handshaking. In the example shown in Figure 15-7, the VI is reading
data into the DIO-32F devices while using external handshaking. For
the DIO-32F devices, the DIO Config VI can set or change the
handshaking mode, for instance whether you trigger digital
communication on an edge or at a certain level.
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Figure 15-7. Reading Data with the Digital VIs Using Digital Handshaking (D10-32F Devices)

For the other devices that support digital handshaking, the example
would be the same as above except the handshaking mode input
would be deleted from the DIO Config VI and the DIO Start VI would
be replaced with the DIO Buffer Control VI. Also, you do not need the
handshake source and clock frequency inputs for most devices,
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because of the external handshaking signal source. Figure 15-8 shows
the VI used for all DAQ devices other than the DIO-32F.

direchion=input

device|
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ort st LT B
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10 o
ke limit
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Figure 15-8. Reading Data with the Digital VIs Using Digital Handshaking

Circular-Buffered Examples
Circular-buffered handshaking is similar to simple-buffered
handshaking in that both types of handshaking place data in a buffer;
however, a circular buffer application returns to the beginning of the
buffer when it reaches the end, and fills the same buffer again.

Remember that circular-buffered handshaking works only on the

Note:
AT-DIO-32F.

Figure 15-9 shows an example of a circular-buffered application. In
this example, you are continually reading or writing digital values until
you stop the VI or an error occurs. In order to create a circular buffer,
you must create a buffer that is at least twice as large as the number of
scans/updates you want to read at a time. You can have an internal or
external handshake source. If your handshake source is internal,
remember to specify the rate at which you read values with the clock
frequency. Scan backlog specifies how many values are left in the
buffer after you read. The number read parameter indicates the total
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number of values that have been read from the buffer because the VI

started executing.
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Figure 15-9. Digital Handshaking Using a Circular Buffer

Digital handshaking, whether non-buffered or buffered, inputs or
outputs digital patterns only after your computer receives a digital
pulse. Not all DAQ devices support digital handshaking. The DIO-32F
devices have internal as well as external handshaking signals and
support circular-buffered I/O. Other DAQ devices that support
handshaking accept only external handshaking signals. You should use
digital handshaking when you need to generate or retrieve a digital
pattern after a digital event, or pulse, is detected.
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SCXI—Getting Your Signals in
Great Condition

This section contains basic information on setting up and using SCXI
modules with your data acquisition application, special programming
considerations, common SCXI applications, and calibration
information.

Part 5, SCXI—Getting Your Signals in Great Condition, contains the
following chapters.

Chapter 16, Things You Should Know about SCXI, includes basic
concepts on how to use SCXI modules with LabVIEW for data
acquisition.

Chapter 17, Hardware and Software Setup for Your SCXI System,

explains how to set up your SCXI hardware to work with data
acquisition in LabVIEW.

Chapter 18, Special Programming Considerations for SCXI,
discusses special programming considerations for SCXI in
LabVIEW which include channel addressing, gains (limit

settings), and settling time.

Chapter 19, Common SCXI Applications, cover example VIs for
analog input, analog output, and digital SCXI module.

Chapter 20, SCXI Calibration—Increasing Signal Measurement
Precision, teaches you how to calibrate SCXI modules and shows
you where LabVIEW stores your calibration constants.



Things You Should Know

about SCXI

Signal Conditioning eXtensions for Instrumentation (SCXI) is a
highly-expandable signal conditioning system. In the next few
chapters, you will learn the basic concepts of signal conditioning, the
setup procedure for SCXI hardware, the hardware operating modes, the
procedure for software installation and configuration, the special
programming considerations for SCXI in LabVIEW, and some
common SCXI applications.

What is Signal Conditioning?

Electrical signals can be generated by transducers to measure physical
phenomena, such as temperature, force, sound, or light. Table 16-1 lists
some common transducers.

Table 16-1.  Phenomena and Transducers

Phenomena Transducer

Temperature Thermocouples
Resistance temperature detectors (RTDs)
Thermistors
Integrated circuit sensor

Light Vacuum tube photosensors
Photoconductive cells

Sound Microphone

Force and pressure

Strain gauges
Piezoelectric transducers
Load cells

Position (displacement)

Potentiometers
Linear voltage differential transformer (LVDT)
Optical encoder
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Table 16-1.  Phenomena and Transducers (Continued)
Phenomena Transducer
Fluid flow Head meters
Rotational flowmeters
Ultrasonic flowmeters
pH pH electrodes

In order to measure signals from transducers, you must convert them
into a form that a data acquisition (DAQ) device can accept. For
example, the output voltage of most thermocouples is very small and
susceptible to noise. Therefore, you may need to amplify and/or filter
the thermocouple output before digitizing it. The manipulation of
signals to prepare them for digitizing is called signal conditioning. The
following are some common types of signal conditioning.

Amplification
Isolation

Filtering

Transducer excitation

Linearization

LabVIEW Data Acquisition Basics Manual

16-2

© National Instruments Corporation




Chapter 16  Things You Should Know about SCXI

Figure 16-1 shows some common types of transducers/signals and the
required signal conditioning for each.

Transducers/Signals Signal Conditioning

Amplification, Linearization, and
Cold-Junction Compensation

Thermocouples >

Current Excitation, Four-Wire
RTDs P and Three-Wire Configuration,
Linearization

i » Voltage Excitation, Bridge (2= 880
Strain Gauges | Configuration, and Linearization D%DHDUDDD
DAQ Device
Common-Mode Voltages > Isolation Amplifiers
or High Voltages (Optical Isolation)

Loads Requiring AC Switching | Electromechanical Relays
or Large Current Flow or Solid-State Relays

A4

Signals with High
Frequency Noise

Y

Lowpass Filters

Figure 16-1. Common Types of Transducers/Signals and Signal Conditioning

Amplification

The most common type of signal conditioning is amplification. The
two advantages to amplifying electrical signals are that it improves the
accuracy of the resulting digitized signal and that it reduces noise.

For the highest possible accuracy, the signal should be amplified so
that the maximum voltage swing equals the maximum input range of
the analog-to-digital converter (ADC) (otherwise known as a
digitizer). Your system should amplify low-level signals at the DAQ
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Note:

Isolation

device or at the SCXI module located nearest to the signal source, as
shown in Figure 16-2.

Noise
Instrumentation
Amplifier
( ) Lead Wires ’|_ b ADC
Low-Level Signal ————
External DAQ Board
Amplifier

Figure 16-2. Amplifying Signals Near the Source to Increase Signal-to-Noise Ratio

You can minimize noise that lead wires pick up by using shielded cables
or a twisted pair of cables, and by minimizing wire length. Also, keeping
signal wires away from AC power cables and monitors will help reduce
50 Hz or 60 Hz noise.

If you amplify the signal at the DAQ device, the signal is measured and
digitized with noise that may have entered the lead wires. However if
you amplify the signal close to the signal source with an SCXI module,
noise has a less destructive effect on the signal. In other words, the
digitized representation is a better reflection of the original low-level
signal. For more information, consult Application Note 025, Field
Wiring and Noise Considerations for Analog Signals. You can access this
note on the NI Fax Back system as well as the BBS, World Wide Web,
or FTP site, the numbers for which are located in the front of this
manual.

Another common way to use SCXI is to isolate the transducer signals
from the computer for safety purposes. When the signal being
monitored contains large voltage spikes that could damage the
computer or harm the operator, you should not directly connect the
signal to a DAQ device without some type of isolation. Another reason
for isolation is to make sure that the measurements from the DAQ
device are not affected by differences in ground potentials. When the
DAQ device and the signal are not referenced to the same ground
potential, a ground loop may occur. Ground loops can cause an
inaccurate representation of the measured signal. If the potential
difference between the signal ground and the DAQ device ground is
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large, then damage may even occur to the measuring system. Using
isolated SCXI modules will eliminate the ground loop and ensure that
the signals are accurately measured.

Signal conditioning systems can filter unwanted signals or noise from
the signal you are trying to measure. You can use a noise filter on low-
rate (or slowly-changing) signals, like temperature, to eliminate
higher-frequency signals that can reduce the accuracy of the digitized
signal. A common use of a filter is to eliminate the noise from a 60 Hz
AC power line. A lowpass filter of 4 Hz is best for removing the 60 Hz
AC noise from signals sampled at low rates. Most of the SCXI modules
have lowpass filters with cutoff frequencies at 4Hz and 10 kHz. A
lowpass filter eliminates all signal frequency components above the
cutoff frequency. The SCXI-1141 module has lowpass filters that have
a cutoff frequencies from 10 Hz to 25 kHz.

Transducer Excitation

Linearization

Signal conditioning systems can generate excitation for some
transducers. Strain gauges and RTDs require external voltage and
currents, respectively, to excite their circuitry into measuring physical
phenomena. This type of excitation is similar to a radio which needs
power to receive and decode audio signals. Some plug-in DAQ devices
and SCXI modules, including the SCXI-1121 and SCXI-1122 modules,
provide the necessary excitation for transducers.

Many transducers, such as thermocouples, have a nonlinear response
to changes in the physical phenomena being measured. LabVIEW can
linearize the voltage levels from transducers, so the voltages can be
scaled to the measured phenomena. LabVIEW provides simple scaling
functions to convert voltages from strain gauges, RTDs,
thermocouples, and thermistors.

For specific information about the VIs you can use with your SCXI
module in LabVIEW, refer to Chapter 20, Calibration and
Configuration VIs, in the LabVIEW Data Acquisition VI Reference
Manual.
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SCXI hardware provides signal conditioning close to the signal source
and increases the number of analog and digital signals that can be
analyzed by a data acquisition (DAQ) device. With PC compatible
computers, SCXI can be configured in two ways—a front-end signal
conditioning system for plug-in DAQ devices or an external data
acquisition and control system. For Macintosh computers, SCXI
hardware can only be used as a front-end signal conditioning system for
plug-in DAQ devices. Figure 17-1 demonstrates these configurations.

PC Plug-In
Data Acquisition Board

Conditioned A ;
Signals :

SCXI Signal [IS
Conditioning
Modules

SCXI Signal
Conditioning and
Data Acquisition
Modules

SCXI-1200 12-Bit Data
Acquisition and Control Module

External Data Acquisition and Control System

Figure 17-1. SCXI System
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Figure 17-2 shows the components of an SCXI system. An SCXI
system consists of an SCXI chassis that houses signal conditioning
modules, terminal blocks that plug directly into the front of the
modules, and a cable assembly that connects the SCXI system to a
plug-in DAQ device or the parallel port of a computer. If you are using
SCXI as an external DAQ system where there are no plug-in DAQ
devices, you can use the SCXI-1200 module, which is a multifunction
analog, digital, and timing I/O (counters) module that connects directly
to the parallel port on the PC. The SCXI-1200 can control several SCXI
signal conditioning modules installed in the same chassis. The
functionality of the SCXI-1200 module is similar to the plug-in Lab
devices.

Terminal Signal SCXI Chassis SCXI Plug-In Personal
Blocks  Conditioning Cable Assembly DAQ Board Computer
and/or (or Parallel Port (Optional)
Data Acquisition Cable)
Modules

Figure 17-2. Components of an SCXI System

Refer to the SCXI tables in Appendix B, Hardware Capabilities, of the
LabVIEW Data Acquisition VI Reference Manual, for tables containing
specifications for all the SCXI modules. This appendix also includes a
list of all the SCXI modules and the compatible terminal blocks.

How do you connect the transducers to the SCXI modules? How do
you set the jumpers on the SCXI modules before they are placed in the
chassis? For information on how to set up each module and transducer,
consult your hardware user manuals and the Getting Started with SCXI
manual.

How do you transfer data from the SCXI chassis to the DAQ device or
parallel port? Figure 17-3 shows a diagram of an SCXI chassis. When
you use SCXI as a front-end signal conditioning system, the analog and
digital bus backplane, also known as the SCXIbus, transfers analog

and/or digital data to the DAQ device. Some of the analog and digital
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lines on the DAQ device are reserved for SCXI chassis
communication. To find out which lines are reserved on your device,
refer to the tables in Appendix B, Hardware Capabilities, in the
LabVIEW Data Acquisition VI Reference Manual.

Figure 17-3. SCXI Chassis

When you use SCXI as an external DAQ system, only some of the
digital I/0O lines of the DAQ device are reserved for SCXI chassis
communication, when other modules are present. The DAQ device
digitizes any analog input data and transfers it back to the computer
through the parallel port.

SCXI Operating Modes

The SCXI operating mode determines the way that DAQ devices
access signals. There are two basic operating modes for SCXI
modules—multiplexed and parallel. You designate the mode in the
operating mode parameter in the configuration utility. Also, you may
have to set up jumpers on the module for the correct operating mode.
Check your SCXI module user manual for more information.

Note: National Instruments recommends that you use the multiplexed mode for
most purposes.
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Multiplexed Mode for Analog Input Modules

Note:
Note:

When an analog input module operates in multiplexed mode, all of its
input channels are multiplexed to one module output. When you cable
a DAQ device to a multiplexed analog input module, the DAQ device
has access to that module's multiplexed output, as well as all other 44
modules in the chassis through the SCXIbus. The analog input VIs
route the multiplexed analog signals on the SCXIbus for you
transparently. So, if you operate all modules in the chassis in
multiplexed mode, you only need to cable one of the modules directly
to the DAQ device.

The SCXI-1200 module, MIO devices, and Lab-PC+ devices support
multiple-channel and multiple-scan acquisitions in multiplexed mode.
The Lab-NB and Lab-LC, PC-LPM-16, and DAQCard-700 support only
single-channel or single-scan acquisitions in multiplexed mode.

When you cable a DAQ device to a multiplexed module, the
multiplexed output of the module (and all other multiplexed modules
in the chassis) appears at analog input channel 0 of the DAQ device by
default.

(Windows) Multiplexed Mode for the SCXI-1200

In multiplexed mode, the SCXI-1200 can access the analog signals on
the SCXI bus. The DAQ VIs can multiplex the channels of analog input
modules and send them on the SCXI bus.This means that if you
configure the SCXI-1200 for multiplexed mode, you can read the
multiplexed output from other SCXI analog input modules in the
chassis. In fact, during the same scanning operation, you can have
analog input channels from the SCXI-1200 with input channels from
other analog input modules.

The SCXI-1200 only reads analog input module channels configured in
multiplexed mode, not in parallel mode.

Make sure that you change the jumper in the SCXI-1200 to the ground
position to connect the SCXI-1200 and SCXIbus grounds together.
Refer to the SCXI-1200 User Manual for more details.

Multiplexed Mode for Analog Output Modules

Because LabVIEW communicates with the multiplexed modules over
the SCXIbus backplane, you must only cable one multiplexed module
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in each chassis to a DAQ device to communicate with any multiplexed
modules in the chassis.

Multiplexed Mode for Digital and Relay Modules

Multiplexed mode is referred to as serial mode in the digital and relay
module hardware manuals. When you operate your digital or relay
module in multiplexed mode, LabVIEW communicates the module
channel states serially over the SCXIbus backplane.

Parallel Mode for Analog Input Modules

When an analog input module operates in parallel mode, the module
sends each of its channels directly to a separate analog input channel
of the DAQ device cabled to the module. You cannot multiplex parallel
outputs of a module on the SCXIbus. You must cable a DAQ device
directly to a module in parallel mode to access its input channels. In
this configuration, the number of channels available on the DAQ
device limits the total number of analog input channels. In some cases,
however, you can cable more than one DAQ device to separate
modules in an SCXI chassis. For example, you can use two Lab-NB or
AT-MIO-16E-2 devices operating in parallel mode and cable each one
to a separate SCXI-1120 module in the chassis. You must be sure to
enter the correct device numbers in the Cabled Device field of the
configuration utility for each module you operate in parallel mode. For
more information on the Cabled Device field, read the Installing and
Configuring Your SCXI Chassis in Windows or on the Macintosh
section in Chapter 2, Installing and Configuring Your Data Acquisition
Hardware.

By default, when a module operates in parallel mode, the module sends
its channel O output to differential analog input channel 0 of the DAQ
device, the channel 1 output to analog input channel 1 of the DAQ
device, and so on.

Note: The SCXI-1200 only reads channels from another analog input module in
multiplexed mode, not in parallel mode.

When you use the analog input VIs, specify the correct onboard
channel for each parallel SCXI channel. If you are using a range of
SCXI channels, LabVIEW assumes the onboard channel numbers
match the SCXI channel numbers. Refer to the SCXI Channel
Addressing section in Chapter 18, Special Programming
Considerations for SCXI, for the proper SCXI channel syntax.
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(Windows) Parallel Mode for the SCXI-1200

In parallel mode, the SCXI-1200 reads only its own analog input
channels. The SCXI-1200 does not have access to the analog bus on the
SCXI backplane in parallel mode. You should use parallel mode if you
are not using other SCXI analog input modules in the chassis with the
SCXI-1200.

(Macintosh and Windows) Parallel Mode for Digital Modules

Note:

When you operate a digital module in parallel mode, the digital lines
on your DAQ device directly drive the individual digital channels on
your SCXI module. You must cable a DAQ device directly to every
module operated in parallel mode.

You may want to use parallel mode instead of multiplexed mode for
faster updating or reading of the SCXI digital channels. For the fastest
performance in parallel mode, you can use the appropriate onboard port
numbers instead of the SCXI channel string syntax in the digital VIs.
Refer to the hardware tables in Appendix B, Hardware Capabilities, in
the LabVIEW Data Acquisition VI Reference Manual for the digital ports
used in parallel mode on each DAQ device.

If you are using a DI0O-96, an AT-MI10-16D, or an AT-MIO-16DE-10
device, you can also operate a digital module in parallel mode using the
digital ports on the second half of the NB5 or R1005050 ribbon cable
(lines 51-100). Therefore, the DIO-96 can operate two digital modules in
parallel mode, one module using the first half of the ribbon cable (lines
1-50), and another module using the second half of the ribbon cable (lines
51-100). To set the module to use the second half of the ribbon cable, set
the operating mode in the configuration utility to Parallel (secondary).

SCXI Software Installation and Configuration

After you assemble your SCXI system, you must run the configuration
utility to enter your SCXI configuration. LabVIEW needs the
configuration information to program your SCXI system correctly.
Refer to Chapter 2, Installing and Configuring Your Data Acquisition
Hardware.

LabVIEW Data Acquisition Basics Manual 17-6 © National Instruments Corporation



Special Programming
Considerations for SCXI

When you want LabVIEW to acquire data from SCXI analog input
channels, you use the analog input VIs in the same way that you acquire
data from onboard channels. You also read and write to your SCXI
relays and digital channels using the digital VIs in the same way that
you read and write to onboard digital channels. You can write voltages
to your SCXI analog output channels using the analog output VIs. The
following sections discuss special programming considerations for
SCXI in LabVIEW which include channel addressing, gains (limit
settings), and settling time.

SCXI Channel Addressing

If you operate a module in parallel mode, you can specify an SCXI
channel either by specifying the corresponding onboard channels or by
using the SCXI channel syntax described in this section. If you operate
the modules in multiplexed mode, you must use the SCXI channel
syntax.

An SCXI channel number has four parts: the onboard channel
(optional), the chassis ID, the module slot, and the module channel.

In the following table of examples, x is any chassis ID, y is any module
slot, a is any module channel, and b is any module channel greater

than a.
Channel List Element Channel Specified
OB0!SCx!MDy!a Channel a on the module in slot v of the

chassis with ID x is multiplexed into
onboard channel 0.

OB0O!SCx!MDy!'!a:b Channels a through b inclusive on the
modaule in slot y of the chassis with ID x
are multiplexed into onboard channel 0.

© National Instruments Corporation 18-1 LabVIEW Data Acquisition Basics Manual



Chapter 18  Special Programming Considerations for SCX/

Note:
Note:
= Note:

SCXI Gains

The channel input for DAQ VIs is either a string (with the Easy I/0
VIs) or an array of strings. Each string value can only list the channels
for one module. With the array structure for channel values, you can
list the channels for several modules. In other words for one scanning
operation, you can scan several modules. You can scan an arbitrary
number of channels for each module, but the channels of each module
must be scanned in consecutive, ascending order.

You do not need the SCXI channel string syntax to access channels on the
SCXI-1200 module. Use O for channel 0, 1 for channel 1, and so on. The
SCXI-1200 module is identified by its logical device number.

When you connect any type of SCXI module to a DAQ device, certain
digital lines are reserved. Refer to Appendix B, Hardware Capabilities, in
the LabVIEW Data Acquisition VI Reference Manual for more information.

When operating in parallel mode with analog input SCXI modules, certain
lines on the DAQ device are reserved. Refer to Appendix B, Hardware
Capabilities, in the LabVIEW Data Acquisition VI Reference Manual for more
information

For the fastest performance in parallel mode on digital modules, you
can use the appropriate onboard port numbers instead of the SCXI
channel string syntax in the digital VIs.

Note:

SCXI modules provide higher analog input gains than those available
on most DAQ plug-in devices.

Before reading this section, you should have already read the Limit
Settings section in Chapter 3, Basic LabVIEW Data Acquisition
Concepts.

It is important to follow the basic rules for setting SCXI gains. If your
module has jumper-selectable gains, enter those gains in the
configuration utility. If your module has programmable gains, LabVIEW
selects a gain for you when you use the input limits parameter to the
analog input VIs. If you do not use the input limits parameter, LabVIEW
uses the gain setting in the configuration utility as the default.

Enter the gain jumper settings in the configuration utility for each
channel on each module with jumpered gains. LabVIEW stores these
gain settings and uses them to scale the input data to voltage. When you
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use the input limits parameter of the analog input VIs, LabVIEW
chooses onboard gains that complement the jumpered SCXI gains to
achieve the given input limits as closely as possible.

For analog input modules with programmable gains, LabVIEW uses
the gain setting you enter in the configuration utility for each module
as the default gain for that module. LabVIEW uses the default gain for
the module whenever you leave the input limits terminal to the analog
input VIs unwired, or if you enter O volts for your upper and lower
input limits.

You can experiment with the default gain setting by using the original
Getting Started Analog Input VI found in examples\dag\

run_me. 11b. This VI does not use input limits. After you execute the
VI, you can open the configuration utility while LabVIEW is open and
change the default gain setting there. Be sure to save your change by
choosing File»Save (for the Macintosh, save changes by closing the
utility) before switching back to LabVIEW to run the VI again.
Remember that the larger the gain setting, the more precise your
measurements will be as long as the signal is within the resulting range
of the channel. The Easy I/O VIs for analog input always pass default
input limits of -10 V to 10 V to the analog input VIs. Therefore, if your
module has programmable gains, the Easy I/O VIs do not use the gain
settings from the configuration utility unless you explicitly set the
input limits to 0 volts.

When you use the input limits to specify non-zero voltage limits for a
module with programmable gains, LabVIEW chooses the most
appropriate SCXI gain for the given limits. LabVIEW selects the
highest SCXI gain possible for the given limits, and then selects
additional DAQ device gain if necessary.

If your module has programmable gains and only one gain for all
channels and you are using an MIO DAQ device, you can specify
different input limits for channels on the same module by splitting up
your channel range over multiple elements of the channel array, and
using a different set of input limits for each element. LabVIEW selects
one module gain suitable for all of the input limits for that module, then
chooses different MIO gains to achieve the different input limits. The
last three examples in Table 18-1 illustrates this method. The last
example shows a channel list with two modules.

You can open the advanced VI, AI Hardware Config, to see the gain
selection. After running this VI, the group channel settings cluster
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Table 18-1.  SCXI-1100 Channel Arrays, Input Limits Arrays, and Gains
Array SCXI-1100 input limits LabVIEW | LabVIEW
Index channel list Array Selected Selected
Array SCXI Gain | MIO Gain
0 ob0!scl!mdl!0:7 -0.01 t0 0.01 1000 1
0 ob0!scl!imdl!0:7 -0.001 to 0.001 2000 5%
0 scl!mdl!0:7 -0.001 to 0.001 2000 1
0 ob0!scl!mdl!0:3 -0.1t0 0.1 100 1
1 ob0!scl!mdl!4:15 -0.01 to0 0.01 100 10
0 ob0!scl!imdl!0:15 -0.01 to 0.01 10 100%*
1 ob0!scl!imdl!16:31 | -1.0to 1.0 10 1
0 ob0!scl!mdl!0:3 -1.0t0 1.0 10 1
1 ob0!scl!imdl!4:15 -0.1t0 0.1 10 10
2 ob0!scl!imd2!0:7 -0.01 to 0.01 1000 1
* Applies if the MIO device supports a gain of 5 (some MIO devices do not).
** This case forces a smaller gain at the SCXI module than at the MIO device, because the input limits for
the next channel range on the module require a small SCXI gain. This type of gain distribution is not
recommended because it defeats the purpose of providing amplification for small signals at the SCXI
module. The small input signals are only amplified by a factor of 10 before they are sent over the ribbon
cable, where they are very susceptible to noise. To use the optimum gain distribution for each set of input
signals, do not mix very small input signals with larger input signals on the same SCXI-1100 module,
unless you are sampling them at different times.

array at the right side of the panel shows the settings for each channel.
The gain indicator displays the total gain for the channel, which is the
product of the SCXI gain and the DAQ device gain, and the actual limit
settings. The group channel settings cluster array also shows the input
limits for each channel.

LabVIEW always scales the input data as you specified, unless you
select binary data only. Therefore, the gains are transparent to the
application. You can specify the input signal limits and let LabVIEW

do the rest.
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SCXI Settling Time

The filter and gain settings of your SCXI modules affect the settling
time of the SCXI amplifiers and multiplexers. You should always enter
your jumpered filter settings and your jumpered gain settings (if
applicable) in the configuration utility. LabVIEW uses the gain and
filter settings to determine a safe interchannel delay that allows the
SCXIT amplifiers and multiplexers to settle between channel switching
before sampling the next channel.

With previous releases of LabVIEW, you had to determine the safe
interchannel delay (or channel clock rate). Beginning with LabVIEW
3.0, LabVIEW calculates the delay for you. If you set a scan rate that
is too fast to allow for the default interchannel delay, LabVIEW shrinks
the interchannel delay and returns a warning from the Al Start or Al
Control VIs. You can refer to your hardware manuals for SCXI settling
times.

You can open the advanced-level Al Clock Config VI to retrieve the
channel clock selection. Set the which clock control to channel clock
1, and set the clock frequency to -1.00 (no change). Now run the VI.
The actual clock rate specification cluster is on the right side of the
panel.
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Now that you have your SCXI system set up and you are aware of the
special SCXI programming considerations, you should learn about
some common SCXI applications. This section will cover example VIs
for analog input, analog output, and digital modules. For analog input,
you will learn how to measure temperature (with thermocouples and
RTDs) and strain (with strain gauges) using the SCXI-1100,
SCXI-1102, SCXI-112x, and SCXI-1141 modules. If you are not
measuring temperature or pressure, you can still gain basic conceptual
information on how to measure voltages with an analog input module.
Read these sections and then apply the information to measuring your
transducer.

Another analog input module, the SCXI-1140, is a simultaneous
sampling module. All the channels acquire voltages at the same time,
which means you can preserve interchannel phase relationships. After
all channel voltages are sampled by going into hold mode, the software
will read one channel at a time. When a scan of channels is done, the
SCXI-1140 module returns to track mode until the next scan period.
Both of these operations are performed by the analog input VIs. You
can use any of the data acquisition (DAQ) VIs, located in the
examples\daglanlogin\anlogin.llb, or the Getting Started
Analog Input VI, found in examples\dag\run_me.11b, to acquire
data from the SCXI-1140 module.

For analog output, you will learn how to output voltage or current
values using the SCXI-1124 module. For digital I/O, you will learn
how to input values on the SCXI-1162/1162HV modules and output
values on the SCXI-1160, SCXI-1161, and SCXI-1163/1163R
modules.

Besides looking at the following sections, other sources of information
are the following application notes and support documents.

e SCXI Hardware Specific Common Questions
e Common Questions about Transducers

e Common Questions about Signal Issues

© National Instruments Corporation 19-1 LabVIEW Data Acquisition Basics Manual



Chapter 19  Common SCXI Applications

All of these notes can be accessed on the NI FaxBack system or by
accessing the BBS, World Wide Web, or FTP site, the numbers for
which are located in the front of this manual.

Analog Input Applications for Measuring Temperature

Two common transducers for measuring temperature are
thermocouples and RTDs. Read the following sections on special
measuring considerations needed for each transducer.

Measuring Temperature with Thermocouples

In this section, you will learn how to use analog input SCXI modules
with thermocouples to measure temperature. If you want to measure
the temperature of the environment, you can use the temperature
sensors in the terminal blocks. But if you want to measure the
temperature of an object away from the SCXI chassis, you must use a
transducer, like a thermocouple. A thermocouple is a junction of two
dissimilar metals that gives varying voltages based on the temperature.
However, when using thermocouples, you need to compensate for the
thermocouple voltages produced at the screw terminal because the
junction with the screw terminals itself forms another thermocouple.
You can use the resulting voltage from the temperature sensor on the
terminal block for cold-junction compensation. The cold-junction
compensation voltage is used when linearizing voltage readings from
thermocouples into temperature values.

The SCXI modules that will be used to measure temperature in this
section are SCXI-1100, SCXI-1102, SCXI-1120, SCXI-1121,
SCXI-1122, and SCXI-1141. All of the terminal blocks used with these
modules have temperature sensors which can be used as cold-junction
compensation. In addition, the SCXI-1100, SCXI-1141, and
SCXI-1122 offer a way for you to ground the module amplifier inputs
so you can read the amplifier offset. You can subtract the amplifier
offset value to determine the actual voltages.

For more information on temperature sensors and amplifier offsets
look at the following two sections. You can also refer to Application
Note 005, Thermocouples and Temperature Measurements, for more
information on measuring temperature with thermocouples. You can
access this note on the NI Fax Back system as well as the BBS, World
Wide Web, or ftp site, the numbers for which are located in the front of
this manual.
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Temperature Sensors for Cold-Junction
Compensation

The temperature sensors in the terminal blocks for the analog input
modules can be used for cold-junction compensation. If you are
operating your SCXI modules in multiplexed mode as recommended,
you should leave the cold-junction sensor jumper on the terminal block
in the mt emp (factory default) position. If you are using parallel mode,
you can use the dtemp jumper setting.

The SCXI-1102 only uses the cjtemp string in multiplexed mode.

To read the temperature sensor, use the standard SCXI string syntax in
the channels array with mt emp substituted for the channel number like
the one shown in the following table.

Channel List Element Channel Specified

ob0!scx ! mdy !mtemp The temperature sensor configured in
mtemp mode on the multiplexed module
in slot y of the chassis with ID x.

ob0!scx!mdy!cjtemp | The temperature sensor configured in

cj temp mode on the multiplexed module
of the SCXI-1102 in slot v of the chassis
with ID x.

If you want to read the cold-junction temperature sensor in dtemp
mode, you can read the following DAQ device’s onboard channels for
these modules.

SCXI-1100: 1
SCXI-1120: 15 (use referenced single-ended mode)
SCXI-1121: 4
SCXI-1122: 1

For example, you can run the Getting Started Analog Input VI, found
in examples\dag\run_me.11b, with the channel string
ob0!scl!mdl !mtemp to read the temperature sensor on the terminal
block that is connected to the module in slot 1 of SCXI chassis 1.
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SCXI terminal blocks have two different kinds of sensors: either an
Integrated Circuit (IC) sensor or a thermistor. For terminal blocks that
have IC sensors, such as the SCXI-1300 and the SCXI-1320, multiply
by 100 to get the ambient temperature in degrees Centigrade at the
terminal block. For terminal blocks that have thermistors, such as the
SCXI-1303, SCXI 1322, SCXI-1327, and SCXI-1328, use the
Thermistor Conversion VI from Functions»Data Acquisition»Signal
Conditioning to convert the raw voltage data into units of temperature.

You cannot sample other SCXI channels from the same module while
you are sampling the mtemp sensor. However, if you are in parallel
mode, you can sample the dtemp sensor along with other channels on
the same module at the same time because you are not performing any
multiplexing on the SCXI module. You can also sample the cjtemp
sensor along with other channels on the SCXI-1102, but ¢j temp must
be the first channel in the channel list.

For greater accuracy, you should take several readings from the
temperature sensor and average those readings to yield one value. If
you do not want to average several readings, you can take a single
reading using the Easy Analog Input VI, AI Sample Channel.

You should look at the SCXI Thermocouple example VIs, found in
examples\dag\anlogin\scxi.1l1lb. The VIsuse the mtemp string
to read the temperature sensor and use the reading for thermocouple
cold junction compensation.

Amplifier Offset

The SCXI-1100, SCXI-1122, and SCXI-1141 have a special
calibration feature that enables LabVIEW to ground the module
amplifier inputs so that you can read the amplifier offset. For the other
SCXIT analog input modules, you must physically wire your terminals

to ground. The measured amplifier offset is for the entire signal path
including the SCXI module and the DAQ device.

To read the grounded amplifier on the SCXI-1100 or SCXI-1122, use
the standard SCXI string syntax in the channels array with calgnd
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substituted for the channel number. Refer to the following table for an
example of this.

Channel List Element Channel Specified

ob0!scx!mdy!calgnd (SCXI-1100 and SCXI-1122 only)
The grounded amplifier of the module
in slot y of the chassis with ID x.

For example, you can run the Getting Started Analog Input VI, found
in the examples\dag\run_me. 11b, with the channel string
ob0!scl!mdl!calgnd toread the grounded amplifier of the
module in slot 1 of SCXI chassis 1. The voltage reading should be very
close to very close to 0 V. The AI Start VI grounds the amplifier before
starting the acquisition, and the AI Clear VI removes the grounds from
the amplifier after the acquisition completes.

The SCXI-1141 has a separate amplifier for each channel, so you must
specify the channel number when you ground the amplifier. To specify
the channel number, attach the channel number to the end of the string
calgnd. For example, calgnd2 grounds the amplifier inputs for
channel 2 and reads the offset. You can also specify a range of
channels. The string calgnd0 : 7 grounds the amplifier inputs for
channels 0 through 7 and reads the offset for each amplifier.

Use the Scaling Constant Tuner VI from Functions»Data
Acquisition»Signal Conditioning to modify the scaling constants so
that LabVIEW automatically compensates for the amplifier offset
when scaling binary data to voltage. The SCXI-1100 Voltage example,
found in examples\dag\anlogin\scxi.1llb, shows you a way
to use the Scaling Constant Tuner VI.

This section discusses how to measure temperature with the
SCXI-1100 and SCXI-112x modules using thermocouples. The
temperature examples below use both cold-junction measurements and
amplifier offsets. In SCXI analog input examples, you cannot set the
scaling constants with the Easy VIs (determined by the amplifier
offset). With the Intermediate VIs, you can change the scaling
constants before acquisition begins, while the Advanced VIs include
functions that are not necessary to accurately measure temperature
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with SCXI modules. The examples discussed in this section use
Intermediate VIs along with transducer-specific VIs.

First, you should learn how to measure temperature using the
SCXI-1100 with thermocouples. You can use the example SCXI-1100
Thermocouple VI located in examples\dag\anlogin\scxi.1llb.
Open the VI and continue reading this section.

In order to reduce the noise on the slowly varying signals produced by
thermocouples, you can average the data and then linearize it. For
greater accuracy, you can measure the amplifier offset, which helps
scale the data and lets you eliminate the offset error from your
measurement. The diagram below shows how you can program the
Acquire and Average VI to measure the amplifier offset. You can find
this VI in vi.lib\dag\zdaqutil.1l1lb. This VI acquires 100
measurements from the amplifier offset, designated in the offset
channel input by calgnd, and then averages the measurements. When
you determine the amplifier offset, you must always use the same input
limits and clock rates that you will be using in the acquisition. The
Acquire and Average VI can measure the amplifier offset of many
modules at once, but in Figure 19-1, it only measures one module.

I input limits [ho change
Hevice [autput units [blnary]lEl-‘ Tom]

Ii6

R — e Binaty amplifier offset
ob0 ! se1 ! mdl | calgnd) I [s61]

B Fan
error_ out

132 i

number of samples
to average for each data point [100)]  |LSGL

Figure 19-1. Measuring a Single Module with the Acquire and Average VI

After measuring the amplifier offset, measure the temperature sensor
for cold-junction compensation. Both the amplifier offset and cold-
junction measurements should be taken before any thermocouple
measurements are taken. To measure temperature sensors, you use the
Acquire and Average VI. The main differences between the amplifier
offset measurement and temperature sensor measurement are the
channel string and the input limits. If have set the temperature sensor
in mtemp mode (the most common mode), you access the temperature

LabVIEW Data Acquisition Basics Manual 19-6 © National Instruments Corporation



Chapter 19 Common SCXI Applications

by using mtemp. If you have set the temperature season in dtemp
mode, then you would read the corresponding DAQ device onboard
channel. Make sure you use the temperature sensor input limits which
are different from your acquisition input limits. To read from a
temperature sensor based on an IC sensor or a thermistor, set the input
limit range from +2 to -2 V.

The temperature sensor voltage

will range from 2% ba 2,

Sl L T
20} o=

device|  Joutput units [valts
116

Id junch h 1 Lqu - cald junction voltage
Cold junclion channe
ob0 ! 321 | mdl | mtem and B o| |56

anetage =t
abc I S
T3z 1} error out
number of zamples
to average for each data point (100] T
zcan rate

Figure 19-2. Measuring Temperature Sensors Using the Acquire and Average VI

After determining the average amplifier offset and cold-junction
compensation, you can acquire data using the Intermediate VIs as
shown in Figure 19-3. This example continually acquires data until an
error occurs or the user stops the execution of the VI. In order to
perform continuous, hardware-timed acquisition, you need to set up a
buffer. In this case, the buffer is 10 times the number of points acquired
for each channel. Before you initiate the acquisition with the AI Start
VI, you need to set up the binary-to-voltage scaling constants by using
the Scaling Constant Tuner VI. This VI, which you can find in
Functions»Data Acquisition»Signal Conditioning, passes the
amplifier offset to the DAQ driver so that LabVIEW accounts for the
amplifier offset as the AI Read VI retrieves the data. After the
compensated voltage data from the Al Read VIis averaged, the voltage
values are converted to temperature and linearized by using the
Convert Thermocouple Reading VI in Functions»Data
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Acquisition»Signal Conditioning. After completing the acquisition,
remember to always clear the acquisition by using the Al Clear VI.

[F==] [l Jbinary amplifier cffse]

channels|

T e - W
conFIE— Ghs continuou STRRT
. i g L H— o o
lb. =hffer $|ze>J—,, '\’ acq IEl nu'\’

FECan rater

input limnits|

—
p
T =
A, =

— <humber of chang —

[=nz] <ernor clusters
< taskiD »
zcan rate]
e :
Falze
=T
Strip Chart [Celziu
132 ]
i CLEAR
nurmber o latest temperature data ]
zamples to T56L] H
average for *
each data =)
paint [100]

seror clusters

Figure 19-3. Continuously Acquiring Data Using Intermediate VIs

Another temperature acquisition example using the SCXI-1100
module is SCXI Temperature Monitor VI located in examples\dag\
anlogin\scxi.1l1lb. This VI continually acquires thermocouple
readings and sets an alarm if the temperature readings go above a user-
defined limit.

You can use the SCXI-1100 examples with the SCXI-1122 module.
Both modules have the capability to programmatically measure the
amplifier offsets and both modules need the cold-junction
compensation to linearize thermocouple measurements. The main
difference between the two modules is the type of temperature sensors
available on their terminal blocks. The main difference between the
two modules is in the way module channels are multiplexed. The
SCXI-1100 uses a CMOS multiplexer, which is capable of fast-channel
multiplexing, whereas the SCXI-1122 uses a electromechanical relay
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to switch one of its 16 channels. Because the SCXI-1122 uses a relay,
this module imposes a minimum interchannel delay of 10 ms.
However, scanning multiple SCXI-1122 channels many different
times, can quickly wear out the relay. To avoid this, acquire data from
the SCXI-1122 module a single channel at a time. For further
information, refer to the SCXI-1122 User Manual, or the SCXI-1122
Voltage example VI in examples\dag\analogin\

scxi-1122 voltage.vi.

If you are measuring temperature with the SCXI-1120 and the
SCXI-1121 modules, then you can refer to the example VI, SCXI-112x
Thermocouple, located in examples\dag\anlogin\scxi.1llb.
This VI is similar to the VI used to measure temperature on the
SCXI-1100. Both VIs average and linearize temperature data using the
Intermediate analog input VIs. The two main differences between the
VIs are that the SCXI-112x VI does not measure the amplifier offset,
and the input limits for the module and the temperature sensor are
different from the input limits for the SCXI-1100. The SCXI-1120 and
SCXI-1121 modules do not have the internal switch used to
programmatically ground the amplifiers as in the SCXI-1100 for the
amplifier offset measurement. If you want to determine the amplifier
offset, you have to manually wire the amplifier terminals to ground and
use a separate VI to read the offset voltage. You can also manually
calibrate the SCXI-1120 and SCXI-1121 to remove any amplifier
offset on a channel-by-channel basis. Refer to the SCXI-1120 or
SCXI-1121 user manuals for specific instructions.

Measuring Temperature with RTDs

Resistance-Temperature Detectors (RTDs) are temperature-sensing
devices whose resistance increase with temperature. They are known
for their accuracy over a wide temperature range. RTDs require current
excitation to produce a measurable voltage. RTDs are available in
2-wire, 3-wire, or 4-wire configuration. The lead wires in the 4-wire
configuration are resistance-matched. If you use a 2-wire or 3-wire
RTD, they are unmatched. Resistance in the lead wires that connect
your RTD to the measuring system will add error to your readings. If
you are using lead lengths greater than 10-feet, you will need to
compensate for this lead resistance. RTDs are also classified by the
type of metal they use. The most common metal is platinum.
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Note:

You should only use the RTD conversion function in LabVIEW for
platinum RTDs. If you do not have a platinum RTD, the
voltage-temperature relation will be different, so the LabVIEW
conversion function cannot be used.

For more information on how the lead wires affect RTD measurements
as well as general RTD information, look at the Measuring Temperature
with RTDs application note. You can find this note on the NI FaxBack
system or by accessing the BBS, World Wide Web, or FTP site, the
numbers for which are in the front of this manual.

Signal conditioning is needed to interface an RTD to a DAQ device or
an SCXI-1200 module. Signal conditioning required for RTDs include
current excitation for the RTD, amplification of the measured signal,
filtering of the signal to remove unwanted noise, and isolation of the
RTD and monitored system from the host computer. Typically, you
would use the SCXI-1121 module with RTDs because it easily
performs all the signal conditioning listed previously. You must set up
the excitation level, gain, and filter settings on the SCXI-1121 module
with jumpers as well as in your system’s configuration utility. For
information on how to connect and configure the RTD with the
SCXI-1121 module, look at the Getting Started with SCXI manual or the
RTD application note mentioned previously.

The SC-2042 RTD device is a signal conditioning device designed
specifically for RTD measurement. This device can be used as an
alternative to SCXI modules. For more information, look at the
National Instruments catalog.

You do not have to worry about cold-junction compensation with
RTDs as you do when measuring thermocouples. To build an
application in LabVIEW, you can use the Easy I/O analog input VIs. If
you are measuring multiple transducers on several different channels,
you will need to scan the necessary channels with little overhead.
Because the Easy I/O VIs reconfigure your SCXI module every time
your application performs an acquisition, it is recommended that you
use the Intermediate analog input VIs as well as the RTD conversion
VI, as shown in the following example. The Convert RTD Reading VI,
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in Functions»Data Acquisition»Signal Conditioning, converts the
voltage read from the RTD to a temperature representation.

channels |[abc]

devicell] _|

buffer zize

input Timits (ne change)

o]

0 rieans
continuous acq

lll Al
10 b bed CONFIG E— STHRT
neg [1neg

|
SGan
rate

E3

number of samples to
average Tor each data
point (100)

snurnber of chans:

[561]

latest
temperature data

Temperature
Strip Chart

This example continually acquires data until an error occurs or the user
stops the VI from executing. In order to perform continuous
hardware-timed acquisition, you need to set up a buffer. In this case,
the buffer is 10 times the number of points acquired for each channel.
After your device averages the voltage data from the AI Read VI, it
converts the voltage values to temperature. After completing the
acquisition, remember to always clear the acquisition by using the Al
Clear VL.

Measuring Pressure with Strain Gauges

Strain gauges give varying voltages in response to stress or vibrations
in materials. Strain gauges are thin conductors attached to the material
to be stressed. Resistance changes in parts of the strain gauge to
indicate deformation of the material. Strain gauges require excitation
(generally voltage excitation) and linearization of their voltage
measurements. Depending on the strain gauge configuration, another
requirement for using strain gauges with SCXI is a configuration of
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resistors. As shown in Figure 19-4, the resistance from the strain
gauges combined with the SCXI hardware form a diamond-shaped
configuration of resistors, know as a Wheatstone bridge.

When you apply a voltage to the bridge, the differential voltage (Vm)
varies as the resistor values in the bridge change. The strain gauge
usually supplies the resistors that change value with strain.

DC Voltage ——

Excitation -

Supplied by signal Rg is value at rest
conditioning hardware

Physical strain gauge

Figure 19-4. Half-Bridge Strain Gauge

Strain gauges come in full-bridge, half-bridge, and quarter-bridge
configurations. For a full-bridge strain gauge, the four resistors of the
Wheatstone bridge are physically located on the strain gauge itself. For
a half-bridge strain gauge, the strain gauge supplies two resistors for
the Wheatstone bridge while the SCXI module supplies the other two
resistors, as shown above. For a quarter-bridge strain gauge, the strain
gauge only supplies one of the four resistors for a Wheatstone bridge.
For more information on how to connect your strain gauge to SCXI,
refer to the Getting Started with SCXI manual.

The SCXI-1121 and the SCXI-1122 modules are commonly used with
strain gauges because they include voltage or current excitation and
internal Wheatstone bridge completion circuits. You can also use the
signal conditioning device SC-2043SG as an alternative to SCXI
modules. The device is designed specifically for strain gauge
measurements. For more information on this device, look in your
National Instruments catalog.
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You can set up your SCXI module to amplify strain gauge signals or
filter noise from signals. In order to set up the excitation level, gain,
and filter settings, you must consult your Getting Started with SCXI
manual for the necessary hardware configuration and Chapter 2,
Installing and Configuring Your Data Acquisition Hardware, for
software configuration.

To build a strain gauge application in LabVIEW, you can use the Easy
I/O analog input VIs. If you are measuring multiple transducers on
several different channels, you will need to scan the necessary channels
as quickly as possible. Because the Easy I/O VIs reconfigure your
SCXI module every time the VI is called, you should use the
Intermediate analog input VIs as well as the strain gauge conversion
VI, as shown in the following example. The Convert Strain Gauge
Reading VI, located in Functions»DAQ»DAQ Ultilities, converts the
voltage read by the strain gauge to units of strain.

input Tamits (no change)|

dewicell)

buffer size

channels [[abc]] o

[ =nz]

Qirneane
continuous acg

Al H Al
—] ETHRT " RERD [ CLEAR
Bl & g ]

=]

mumber of samples to
arerage For cach data
point (1000

zean rate |[SCL

"":’-"""-"'"_'""-""'_"""""E
HE stor ][
TlFatse bf"

snumber of chans

[5o]
latest =G
temperature data
Temper ature
Ctrip Chart

© National Instruments Corporati

This example continually acquires data until an error occurs or the user
stops the VI from executing. In order to perform continuous
acquisition, you need to set up a buffer. In this case, the buffer is 10
times the number of points acquired for each channel. After your
device averages the voltage data from the Al Read VI, it converts the
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voltage values to strain values. After completing the acquisition,
remember to always clear the acquisition by using the AI Clear VI.

When measuring strain gauge data, there are some parameters on the
Convert Strain Gauge Reading VI you should know.

Rg(120) ——
GF (2.0)
v (0.0) ———— |
¥sq (0.0) {f‘“ﬁ’.,p

Bridge Configuration (3:Hal... —— .5,
Yex (T _IF) — L coH

Yinit (0.0)
R100.0)

Strain

Vsg, the strain gauge value, is the only parameter wired in the previous
VI diagram. The other parameters for this VI have default values but
those values may not be correct for your strain gauge. You should
check the following parameters: Vinit, the voltage across the strain
gauge before strain is applied (always measure at the beginning of the
VI); Bridge Configuration; Vex, the excitation voltage; Rl, the lead
resistance; and Rg, the resistance of the strain gauge before strain is
applied. Usually you can ignore the lead resistance, Rl, for strain
gauges unless the leads are several feet. For more information on any
of the parameters for this VI, look in Chapter 14, Data Acquisition
Utility VIs, in the LabVIEW Data Acquisition VI Reference Manual.

Analog Output Application Example

With the SCXT analog output module, SCXI-1124, you can output
voltages or currents. Refer to the example analog output VI,
SCXI-1124 Update Channels VI, located in
examples\dag\anlogin\scxi.1llb. This VI uses the analog
output Advanced VIs because the output mode (whether you have
voltage or current data) must be accessible in order to change the value,
as shown below. The program calls the AO Group Config VI to specify
the device and output channels. The AO Hardware Config VI specifies
the output mode and the output voltage range, or limit settings, for all
the channels specified in the channels string. This advanced-level VI is
the only place where you can specify a voltage or current output mode.
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If you are going to output voltages only, you may want to use the AO
Config VI (an Intermediate VI), instead of the AO Group Config and
AO Hardware Config VIs. You can program individual output
channels of the SCXI-1124 for different output ranges by using the
arrays for channels, output mode, and limit settings. The AO Single
Update VI initiates the update of the SCXI-1124 output channels. To
help debug your VlIs, it is always helpful to display any errors, in this
case using the Simple Error Handler VI.

Note: LabVIEW for Windows NT does not support the SCXI-1124 module.

- A Group Config.wi - AD Hardware Config.vi AD Single Update.vi Simple Error Handler
device [1]| 132 | o P J Hr dwr - Tingle o= e :
ot 0 9 R

[charmeks [zc1 T md] | ohi: 5]
[oBL]
=
output mode [¥] = voltage current anay [0.0]]

Digital Input Application Example

To input digital signals through an SCXI chassis, you can use the
SCXI-1162 and SCXI-1162HV modules and the Easy Digital VI, Read
from Digital Port, as shown below.

pattern displaved in hes, octal, decimall
pattern displaved as boolean cluster]

Murnber ta array to
cluster converzion

The port number is a string expressed in the SCX ! MDY ! 0 format,
where you are trying to input from the digital input module on slot y of
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Note:

Note:

chassis x. The last identifier is always port 0, because the whole
module is considered one port. The port width should be the number
of lines in a port on your SCXI module if you are operating in
multiplexed mode. For the SCXI-1162 and SCXI-1162HV, the port
width is 32 lines. If you are operating in parallel mode, the port width
should be the number of lines on your DAQ device. The DIO-32F
device can access all 32 lines of the SCXI modules at once by using the
SCXI-1348 cable assembly. The DIO-24 and the DIO-96 devices can
only access the first 24 lines of these modules when configured in
parallel mode. For the fastest performance in parallel mode, you can
use the appropriate onboard port numbers instead of the SCXI channel
string syntax. Use the iteration input to optimize your digital operation.
When iteration is 0 (default), LabVIEW calls the DIO Port Config VI
(an Advanced VI) to configure the port. If iteration is greater than zero,
LabVIEW bypasses reconfiguration and remembers the last
configuration, which improves performance. You can wire this input to
an iteration terminal of a loop. With the DIO-24 and DIO-96 devices,
every time you call the DIO Port Config VI, the digital line values are
reset to default values. If you want to maintain the integrity of the
digital values from one loop iteration to another, do not set iteration to
0 except for the first iteration of the loop.

For an example on SCXI digital input, refer to SCXI-1162/1162HV
Digital Input VI located in examples\dag\digitall\digio.1llb.
Even though this VI uses Advanced Vls, it is functionally equivalent
to the Easy I/0 Digital VI, Read from Digital Port.

The DIO Port Config VI resets output lines on adjacent ports on the same
8255 chip for DIO-24, DIO-96, MIO-16D, MI10-16DE, and Lab Series
devices.

If you are also using SCXI analog input modules, make sure your cabling
DAQ device is cabled to one of them.
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Digital Output Application Example

To output digital signals through an SCXI chassis, you can use the
SCXI-1160, SCXI-1161, SCXI-1163, and SCXI-1163R modules and
the digital Easy Digital VI, Write to Digital Port, as shown below.

teration

niurmenic pattern

Cluzster to array to
number coreersion

The port number is a string expressed in the SCX!MOY ! 0 format,
where you are trying to output from the digital output module on slot
v of chassis x. The last identifier is always port 0, because the whole
module is considered one port. The port width should be the number
of lines on your SCXI module if you are operating in multiplexed
mode. The SCXI-1160 has 16 relays, the SCXI-1161 has 8 relays, and
the SCXI-1163/1163R have 32 relays. You can do not use the
SCXI-1160 or SCXI-1161 in parallel mode. For the SCXI-1163/1163R
the port width in parallel mode should be the number of lines on your
DAQ device or SCXI-1200 module. The DIO-32F device can access all
32 lines of the SCXI-1163/1163R modules at once by using the
SCXI-1348 cable assembly. The DIO-24 and the DIO-96 devices can
only access the first 24 lines of the SCXI-1163/1163R when configured
in parallel mode. For the fastest performance in parallel mode, you can
use the appropriate onboard port numbers instead of the SCXI channel
string syntax. Use the iteration input to optimize your digital
operation. When iteration is 0 (default), LabVIEW calls the DIO Port
Config VI (an Advanced VI) to configure the port. If iteration is
greater than zero, LabVIEW bypasses reconfiguration and remembers
the last configuration, which improves performance. You can wire this
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input to an iteration terminal of a loop. Every time you call the DIO
Port Config VI the digital line values are reset to default values. If you
want to maintain the integrity of the digital values from one loop
iteration to another, do not set iteration to 0 except for the first iteration
of the loop.

For an example on SCXI digital output, refer to SCXI-116x Digital
Output VI located in examples\dag\digitalldigio.llb. Even
though this VI uses Advanced Vs, it is functionally equivalent to the
Easy Digital VI, Write to Digital Port.

Note: If you are also using SCXI analog input modules, make sure your cabling
DAQ device is cabled to one of them.

Multi-Chassis Applications

Multiple SCXI-1001 chasses can be daisy-chained together using the
SCXI-1350 or SCXI-1346 multichassis cable adapters and an MIO
Series DAQ device other than the DAQPad-MIO-16XE-50. Every
module in each of the chassis must be in multiplexed mode. Only one
of the chassis will be connected directly to the DAQ device.

When you daisy-chain multiple chasses to a single DAQ device, each
chassis multiplexes all of its analog input channels into a separate
onboard analog input channel. The first chassis in the chain uses
onboard channel 0, the second chassis in the chain uses onboard
channel 1, and so on. Therefore, to access channels in the second
chassis, you must select the correct onboard channel as well as the
correct chassis ID. The string obl!sc2!mdl! 0 means channel 0 on
the module in slot 1 of SCXI chassis 2, multiplexed into onboard
channel 1. Remember to use the correct chassis ID number from the
configuration utility and to put the jumpers from the power supply
module in the correct position for each chassis.

When an MIO Series device is cabled to multiple chasses, the number
of reserved analog input channels depends on the number of chasses.

Refer to Table B-14, Reserved DAQ Device Analog Input Channels, in

Appendix B, Hardware Capabilities, of the LabVIEW Data Acquisition
VI Reference Manual for more channel information.

When you access digital SCXI modules, you do not use onboard
channels. Therefore, if you have multiple chassis, you only have to
choose the correct SCXI chassis ID and module slot.
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You can perform DAQ operations on channels in multiple SCXI
chassis at the same time. For example, the first element of your
channels array could be ob0!scl!mdl!0:31, and the second
element of the channels array could be obl!sc2!md1!0:31. Then,
LabVIEW would scan 32 channels on module 1 of SCXI chassis 1,
using onboard channel 0, then the 32 channels on module 1 in SCXI
chassis 2, using onboard channel 1. Remember that the scan rate you
specify is how many scans per second LabVIEW performs. For each
scan, LabVIEW reads every channel in the channels array. One
restriction is that the channel list for each module must be consecutive.

You can practice reading channels from different chassis by using the
channel strings explained above in the Getting Started Analog Input VI
found in examples\dag\run_me.1llb.

Note: Only the SCXI-1001 chassis can be used in multi-chassis applications with
MIO Series devices other than the DAQPad-MI0-16XE-50. Lab Series,
LPM, DAQCard-500, DAQCard-700, DAQCard-1200, and DIO-24
devices do not support multi-chassis applications.
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SCXI Calibration—Increasing
Signal Measurement Precision

Your SCXI module ships to you pre-calibrated for the specified
accuracy at the factory. You only need to recalibrate the module if the
precision of your signal measurement is not acceptable because of
shifts in environmental conditions.

Before learning about how to calibrate, you should understand where
LabVIEW stores your calibration constants.

This chapter does not apply to the SCXI-1200. For calibration on the

7

SCXI-1200, you should use the 1200 Calibrate VI, which you can find in
Functions»Data Acquisition»Calibration and Configuration.

EEPROM—Your System’s Holding Tank for
Calibration Constants

When you calibrate your SCXI module in LabVIEW, the calibration
constants can be stored in Electronically Erasable Programmable
Read-Only Memory (EEPROM). EEPROM could be compared to a
holding tank for calibration constant information in your module’s
memory. There are 3 parts to this holding tank: the factory area, the
default load area, and the user area.
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7= Note: Only the SCXI-1122, SCXI-1124, SCXI-1102, and SCXI-1141 have
EEPROMs. All other SCXI modules do not store calibration constants.

Electronically Erasable Programmable Read-Only Memory

(EEPROM)
Factory Default Load User
Area Area Area

e The factory area has a set of factory calibration constants already
stored in it when you receive your SCXI module. You cannot write
into the factory area, but you can read from it, so you can always
access and use these factory constants if they are appropriate for
your application.

e The default load area is where LabVIEW automatically looks to
load calibration constants the first time you access the module.
When the module is shipped, the default load area contains a copy
of the factory calibration constants.

= Note: You may overwrite the constants stored in the default load area of
EEPROM with a new set of constants using the SCXI Cal Constants VI.
To learn more about this VI, refer to Chapter 20, Calibration and
Configuration Vs, in the LabVIEW Data Acquisition VI Reference Manual.

e The user area is an area for you to store your own calibration
constants that you calculate using the SCXI Cal Constants VI. You
can also put a copy of your own constants in the default load area
if you want LabVIEW to automatically load your constants for
subsequent operations. You can read and write to the user area.

LabVIEW Data Acquisition Basics Manual 20-2 © National Instruments Corporation



Note:

Chapter 20  SCXI Calibration—Increasing Signal Measurement Precision

You should use the user area in EEPROM to store any calibration
constants that you may need to use later. This safeguards you from
accidentally overwriting your constants in the default load area, because
you will have two copies of your new constants and you can revert to the
factory constants by copying the factory area to the default load area
without wiping out your new constants entirely.

The following sections explain how to calibrate your SCXI modules to
achieve the levels of accuracy that you desire.

Calibrating SCXI Modules

S0l

cal
cobEt

Note:

The SCXI Cal Constants VI in LabVIEW automatically calculates the
calibration constants for your module with the precision you need for
your particular application. You can find this VI in
Functions»DAQ»Calibration and Config. Refer to Chapter 20,
Calibration and Configuration VIs, in the LabVIEW Data Acquisition
VI Reference Manual for more specifics on the SCXI Cal Constants VI
and each of its parameters.

By default, calibration constants for the SCXI-1102, SCXI-1122, and
SCXI-1141 are loaded from the module EEPROM. The SCXI-1141 has
only gain adjust constants in the EEPROM; it does not have the binary
zero offset. All other analog input modules (excluding the SCXI-1102,
SCXI-1122, and SCXI-1141) do not have calibration constants by
default and do not assume any binary offset and ideal gain settings.
This means you must use one of the procedures described in the SCXI
Calibration Methods for Signal Acquisition section below to store
calibration constants for your module if it is not an SCXI-1102,
SCXI-1122, or SCXI-1141.

You can determine calibration constants based specifically on your
application setup, which includes your type of DAQ device, your DAQ
device settings, and your cable assembly—all combined with your
SCXI module and its configuration settings.

If your SCXI module has independent gains on each channel, the
calibration constants for each channel are stored at each gain setting.
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SCXI Calibration Methods for Signal Acquisition
There are two ways you can calibrate your SCXI module—through
one-point calibration or two-point calibration. The following
illustration explains why you may need to calibrate your SCXI module.

Binary Reading

Ideal Reading

" Actual Reading

Gain Error

Actual Voltage
in Binary Representation

Binary Reading

In this picture, you can see the difference between the ideal reading and
the actual reading. This difference is called V , or the binary offset,
before the two readings intersect. The difference between the actual
and ideal readings after they intersect is called the gain error.

One-point calibration removes the V¢ (binary offset) by measuring a
0 volt signal and comparing the actual reading to it. Two-point
calibration removes the V¢ (binary offset) and corrects gain error by
first performing a one-point calibration. Then you measure a voltage at
x volts and compare it to the actual reading. The x must be as close as
possible to the full-scale range. The following sections explain how to
perform a one-point and two-point calibration.
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One-Point Calibration

These steps show you how to perform a one-point calibration
calculation in LabVIEW. You should use one-point calibration when
you only need to adjust the binary offset in your module. If you need
to adjust both the binary offset and the gain error of your module, read
the Two-Point Calibration section later in this chapter. Open
SCXI-1100 One-Point Calibration example in examples\daqg\
analogin\SCXI.11b for an example application that demonstrates
one-point calibration.

Note: If you are using an AT-MI10-16F-5, AT-MI10-64F-5, AT-MI10-16X device
or an MIO-E series device, you should calibrate your DAQ device first
using either the MIO Calibrate VI or E-Series Calibrate VI.

1.
Al
CONFIG
m—r 2
3.
Al 4.
S-SCAN
e ]

© National Instruments Corporation

Make sure you set the SCXI gain to the gain you want to use in
your application. If your modules have gain jumpers or DIP
switches, they must be set appropriately. Refer to your SCXI
module user manual for jumper or switch setting information. If
your modules have software-programmable gain, use the input
limits parameter in the AI Config VI to set gain.

Program the module for a single-channel operation by using the Al
Config VI with the channel that you are calibrating as the channels
parameter in the VI.

Ground your SCXI input channel to determine the binary zero
offset. You should ground inputs because offset can vary at
different voltage levels due to gain error. If you are using an
SCXI-1100 or SCXI-1122, you can ground your input channels
without external hookups by substituting the channel string with
calgnd as the channel number. For other modules, you need to
wire the positive and negative channel inputs together at the
terminal block and wire them to the chassis ground.

Use the AI Single Scan VI to take several readings and average
them for greater accuracy. Set the DAQ device gain settings to
match the settings you plan to use in your application. If you are
using an AT-MIO-16F-5, AT-MIO-64F-5, or AT-MIO-16X, you
can use the MIO Configure VI to enable dithering, which makes
your averaged data more accurate. The dither mode is always
enabled on MIO-E series devices. By using the Al Start and Al
Read VIs, instead of the Al Single Scan VI, you can average over
an integral number of 60Hz or 50Hz power line cycles (sine
waves) to eliminate line noise. You now have your first volt/binary
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measurement: volt = 0.0 or the applied voltage at your input
channel, and binary is your binary reading or binary average.

5. Use the SCXI Cal Constants VI with your volt/binary
measurement from step 4 as the Volt/Amp 1 and Binary 1 inputs
in your VI, respectively. (These input names may vary depending
on your application setup.) For example, if your volt/binary
measurement from step 4 was 0.00 volts and 2, then you would
enter the values into your front panel controls as shown in the
following illustration.

Valt s amp 1 Einary 1

Two-Point Calibration

These steps show you how to perform a two-point calibration
calculation in LabVIEW. You should use two-point calibration when
you need to correct both the binary offset and the gain error in your
SCXI module. Open SCXI-1100 two-point calibration
example in examples\dag\anlogin\SCXI.1l1b for an example
application that demonstrates a two-point calibration.

Note: If you are using an AT-MI10-16F-5, AT-MIO-64F-5, or AT-MI0-16X
device or an MIO-E series device, you should calibrate your DAQ device
first using either the MIO Calibrate VI or E-Series Calibrate VI.

Follow steps 1 through 5 in the previous section, One-Point
Calibration.

6. Now apply aknown, stable, non-zero voltage to your input channel
at the terminal block. This input voltage should be close to the
upper limit of your input voltage range for the given gain setting.
For example, if your input voltage range is -5 to 5V, you would
want to apply an input voltage that is as close to 5 volts as possible,
but not exceeding 5 volts.

7. Take another binary reading or average of readings. If your binary
reading is the maximum binary reading for your DAQ device, you
should try a smaller input voltage. This is your second volt/binary
measurement.
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8. Use the SCXI Cal Constants VI with the first volt/binary
measurement from step 4 as Volt/Amp 1 and Binary 1 inputs, and
the second measurement from step 7 as Volt/Amp 2 and Binary 2
inputs of the VI. The following illustration shows how you should
enter the values into these inputs in LabVIEW if your volt/binary
measurements are 0V/0 and 5V/2045. Keep in mind that your
input names may vary depending on your application setup.

Volt A amp 1 Einary 1 Volt/ dmp 2 Einary 2

Hiooo ] Hzoo 1| Hso0 Hlzoas |

9. Ifyouareusing SCXI-1102 or SCXI-1122 inputs, you can save the
constants in the module user area in EEPROM. Store constants in
the user area as you are calibrating, and then use SCXI Cal
Constants VI again at the end of your calibration sequence to copy
the calibration table in the user area to the default load area in
EEPROM. Remember that constants that are stored in the default
load area can be overwritten. If you want to use a set of constants
later, you should keep a copy of the constants stored in the user
area in EEPROM.

Note: If you are storing calibration constants in the SCXI-1102 or SCXI-1122
EEPROM, your binary offset and gain adjust factors must not exceed the
ranges given in the respective module user manuals.

For other analog input modules, you must store the constants in the
memory. Unfortunately, calibration constants stored in the memory are
lost at the end of a program session. You can solve this problem by
creating a file and saving the calibration constants to this file. You can
load them again in subsequent application runs by passing them into
the SCXI Cal Constants or the Scale Constant Tuner VlIs.

Repeat the above procedure for any additional channel or gain settings
you want to calibrate.

Calibrating SCXI Modules for Signal Generation
When you output a voltage or current value to your SCXI analog output
module, LabVIEW uses the calibration constants loaded for the given
module, channel, and output range to scale the voltage or current value
to the appropriate binary value to write to the output channel. By
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default, calibration constants for the SCXI-1124 will be loaded into the
memory from the EEPROM default load area.

You can recalibrate your SCXI analog output module by following
these steps.

1. Use the AO Single Update VI to output a binary value. If you are

ingle
u'f!-?..tﬁ calibrating a voltage output range, enter O in the binary array
_T input of the VI. If you are calibrating current range, enter 255 into

the binary array input of the VI.

2. Measure the output voltage or current at the output channel with a
voltmeter or ammeter. This is your first volt/binary measurement:
Binary 1= 0, and Volt/Amp 1 is the voltage or current you
measured at the output.

Use the AO Single Update VI to output a binary value of 4,095.

4. Measure the output voltage or current at the output channel. This
is your second volt/ binary measurement: Binary 2 should be
4,095 and Volt/Amp 2 is the voltage or current you measured at
the output.

5. Use SCXI Cal Constants VI with the first voltage/binary
measurement from step 2 as the Volt/Amp 1 and Binary 1 inputs
and the second measurement from step 4 as the Volt/Amp 2 and
Binary 2 inputs of the VI.

You can save the constants on the module in the user area in EEPROM.
Use the user area as you are calibrating, and then use SCXI Cal
Constants VI again at the end of your calibration sequence to copy the
calibration table in the user area to the default load area in EEPROM.
Remember that constants that are stored in the default load area can be
overwritten. If you want to use the constants later, you should store a
backup copy of the constants in the user area in EEPROM.

Repeat the procedure above for each channel and range you want to
calibrate. Subsequent analog outputs will use your new constants to
scale voltage or current to the correct binary value.

For more information on the SCXI Cal Constants VI, refer to
Chapter 20, Calibration and Configuration VIs, in the LabVIEW Data
Acquisition VI Reference Manual.
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Want Precision Timing—Use

Counters

This section describes the different ways you can use counters with
your data acquisition application, including generating a pulse or
pulses, measuring pulse width, frequency, and period, counting events,
and dividing frequencies for precision timing.

Part 6, Want Precision Timing—Use Counters, contains the following
chapters.

Chapter 21, Things You Should Know about Counters, shows you
how to add high-precision timing to your data acquisition (DAQ)
system by using counters and explains basic counter concepts.

Chapter 22, Generating a Square Pulse or Pulse Trains, describes
the ways you can generate a square pulse or multiple pulses (called
pulse trains) using the counters available on your data acquisition
(DAQ) device with the Easy and Intermediate Counter VIs in
LabVIEW.

Chapter 23, Measuring Pulse Width, describes how you can use a
counter to measure pulse width.

Chapter 24, Measuring Frequency and Period, describes the various
ways you can measure frequencies and periods using the counters
on your data acquisition (DAQ) device.

Chapter 25, Counting Signal Highs and Lows, teaches you how to
use counters to count external events or elapsed time.

Chapter 26, Dividing Frequencies, shows you how to divide the
available device frequencies to get the frequency you need for your
data acquisition application.



Things You Should Know about
Counters

Counters add counting or high-precision timing to your data
acquisition (DAQ) system. Counters respond to and output Transistor-
Transistor Logic (TTL) signals—square-pulse signals that are OV (low)
or 5V (high) in value. The following diagram shows a TTL signal.

Signal Transitions
or Edges ————p»|

ov ......

Even though counters just count the signal transitions (edges) of a TTL
source signal, you can use this counting capability in many ways.

*  You can generate square TTL pulses for clock signals and triggers
for other DAQ applications.

*  You can measure the pulse width of TTL signals.

*  You can measure the pulse frequency and period of TTL signals.
*  You can count TTL signal transitions (edges) or elapsed time.

*  You can divide the frequency of TTL signals.

The counter chapters that follow this chapter discuss each one of these
counter functions.
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Things You Should Know about Counters

Knowing the Parts of Your Counter

The following illustration shows a basic model of a counter.

—»|GATE ouT|—»

Counter Register

—»|SOURCE

A counter consists of a SOURCE input pin, a GATE input pin, an OUT
output pin, and a count register. In plug-in device diagrams and in the
LabVIEW Data Acquisition VI Reference Manual, these counter parts
are called SOURCE n, GATE n, and OUT n, where n is the number of
the counter.

Typically, a counter counts the signal transitions at the SOURCE input.
You can configure the counter to count either the low-to-high or the
high-to-low transition of the SOURCE input. These signal transitions
are sometimes referred to as edges. For each counted edge, the counter
increments or decrements the internal count register. The count register
value always reflects the current count of the signal edges. Reading the
count register does not change its value.

The GATE input can control when counting in your application occurs.
You can enable and disable counting according to GATE signal
transitions or levels. There are four different gating modes:
rising-edge, falling-edge, high-level, and low-level. The following
diagram illustrates the four gating modes. The numbers represent how
many low-to-high transitions (rising edges) occur at the SOURCE
input after the counter has been gated. You also can count the
high-to-low transitions (falling edges) on the SOURCE input, but it is
not shown in the diagram below.
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7% Note: The gating levels shown below are not available with devices that use the
DAQ-STC chip.

Rising Edge Gating
SOURCE J LT LILI1/L Il rlririrriri
|

Counter Value 1—=>2—+=3—>4—>5—=6—>7—>8—>9—"10 count rising SOURCE edge
|

aate — 11

Falling Edge Gating
SOURCE JLILIririimrrnriririririri.

Counter Value I jep—>3—>4—=5>6—27>8 count rising SOURCE edge
|

aate — T 1

High-Level Gating
SOURCE T LIMLI LI LIl Il i rlririririri
|

Counter Value 1—==2—+»3———>4—>5—6 count rising SOURCE edge
|

Low-Level Gating
SOURCE I LI LIl il rrmrire
|

Counter Value 1—2—+3—>=4——=5—>6 count rising SOURCE edge
|

GATE | L

By default, counters count up in value, but you can change your
counter to count down in value. You can use the count direction input
on the Advanced VI, CTR Mode Config, to configure a counter to
count up or down in value. For more information, refer to the
description of the CTR Mode Config VI in Chapter 19, Advanced
Counter Vls, in the LabVIEW Data Acquisition VI Reference Manual.

Note: If a GATE edge or level change occurs after the specified transition or
edge on the SOURCE input, then the counter does not begin counting
until the next SOURCE transition or edge.

You can also use a counter with no gating, allowing the software to
initiate the counting operation.
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Knowing Your

Use the OUT signal of a counter to generate various TTL pulse
waveforms. If you are incrementing the count register value, you can
configure the OUT signal to either toggle signal states or pulse when
the counter register reaches a certain value. The highest value of a
counter is called the terminal count (TC). (If you are decrementing, the
counter register value will be 0). If you chose to have pulsed output,
then the counter outputs a high pulse that is equal in time to one cycle
of the counter’s SOURCE signal, which can be either an internal or
external signal. If you chose to have a toggled output, you just change
the state of the output signal from high to low or low to high. If you
want more control over the length of high and low outputs, then you
should use a toggled output. Refer to Chapter 22, Generating A Square
Pulse or Pulse Trains, for more information.

Multiple counters can be concatenated for a greater counting range on
most devices. For more information on how to concatenate counters,
refer to Chapter 25, Counting Signal Highs and Lows.

Counter Chip

Most National Instruments DAQ devices contain one of three different
counter chips: the Am9513, the DAQ-STC, and the 8253/8254 chip. To
find out which counter chip your device uses, refer to your hardware
manual or Chapter 19, Advanced Counter Vls, in the LabVIEW Data
Acquisition VI Reference Manual. All counter information discussed in
this manual refers to the Am9513 chip (a 16-bit counter with a counting
range of 0 to 65,535) and the DAQ-STC chip (a 24-bit counter with a
counting range of 0 to 224.1). For information on the 8253/8254 chip,
refer to the ICTRControl VI in Chapter 19, Advanced Counter VIs, of
the LabVIEW Data Acquisition VI Reference Manual.

If you have the DAQ-STC chip, LabVIEW provides a buffer to
perform counter operations. Typically, you should use
buffered-counter operations when you have a GATE signal that may
trigger the counter to count several times, or if you want to save data
from different counters count several times. If you have the DAQ-STC
chip and want to perform buffered-counter operations, you can alter
any of the counter examples that ship with LabVIEW. For information
on buffered-counter operations or how to alter the examples, refer to
the CTR Mode Config VI in Chapter 19, Advanced Counter VIs, of the
LabVIEW Data Acquisition VI Reference Manual.
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Counting Operations When All Your Counters Are Used

MIO series devices feature an FOUT output and E Series devices
feature a FREQ_OUT output, where your device can generate a square
wave without using any of the available counters. The CTR Control VI,
found in Functions»Data Acquisition» Counters»Advanced Counters,
enables and disables the FOUT signal and sets the square wave
frequency. The square wave frequency is defined by FOUT timebase
signal/FOUT divisor. The front panel and block diagram below show
an FOUT output configured to generate a 25,000 Hz square wave.

Front Panel

; enable FOUT

FOUT port |FIIIL|T timebase 51'gna]|

HFour port 1| [1o0000.00
[FOUT timebaze source| FOUT divisor

E]inter’na] frrequency in Hz E]4

Block Diagram

CTE Eu:-ntr'-:-l.vil
[—F=

--------- '

Figure 21-1. CTR Control VI Front Panel and Block Diagram

Now that you have read about the basic operations of a counter, go to
the chapter that discusses your particular counter application.

For specific information about the Counter VIs in LabVIEW, refer to
Chapter 16, Introduction to the Counter VIs, in the LabVIEW Data
Acquisition VI Reference Manual.
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Generating A Square Pulse or
Pulse Trains

This chapter describes the ways you can generate a square pulse or
multiple pulses (called pulse trains) using the counters available on
your data acquisition (DAQ) device with the Easy and Intermediate
Counter VIs in LabVIEW.

Generating a Square Pulse

There are many times that you may need to generate TTL pulses. TTL
pulses can be used as clock signals, gates, and triggers. You can also
use a generated pulse with a known timebase to determine an unknown
TTL signal frequency, or use a square pulse to trigger an analog
acquisition.

There are two basic types of counter signal generation—toggled and
pulsed. When a counter reaches a certain value, a counter configured
for a toggled output changes the state of the output signal from high to
low or from low to high, while a counter configured for a pulsed output
outputs a pulse. The width of the pulse is equal to one cycle of the
counter’s SOURCE signal. When generating a pulse or pulse train, you
must define the polarity of the signal as positive or negative. In the
following illustration, you can see that for a signal with a positive
polarity the initial state is low, while for a signal with a negative
polarity the initial state is high.

Positive Polarity Negative Polarity

Each counter-generated pulse consists of two parts—phase 1 and
phase 2. If the counter is configured to output a signal with positive
polarity and toggled output, as shown in the following diagram, the
period of time from when the counter starts counting to the first rising
edge is called phase 1. The time between the rising and the following
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falling edge is called phase 2. If you configure the counter to generate
a continuous pulse train, the counter repeats this process many times as
shown on the bottom line of Figure 22-1.

counter starts

¢ phase 1 | phase 2 |

Single Pulse

¢ phase 1 phase 2 phase 1 phase 2

Pulse Train

Figure 22-1. Pulse Created with Positive Polarity and Toggled Output

The following is a list of terms you should know before outputting a
pulse or pulse train using LabVIEW.

Phase 1 refers to the first phase or delay to the pulse.
Phase 2 refers to the second phase or the pulse itself.
Period is the sum of Phase 1 and Phase 2.

Frequency is the reciprocal of the Period (1/Period).

In LabVIEW, you can adjust and control the times of phase 1 and
phase 2 in your counting operation. You do this by specifying a
duty cycle. The duty cycle equals:

Phase?

- , where  Period = Phasel + Phase 2
Period

Examples of various duty cycles are shown in Figure 22-2. The first
line shows a duty cycle of 0.5. In this case, phase 1 and phase 2 are the
same duration. A signal with a 0.5 duty cycle acts as a SOURCE for
counter operations. The second line shows a duty cycle of 0.1. In this
case, phase 1 has been increased and phase 2 has been decreased. The

LabVIEW Data Acquisition Basics Manual 22-2 © National Instruments Corporation



Chapter 22 Generating A Square Pulse or Pulse Trains

final line shows a large duty cycle of 0.9. In this example, phase 1 is
very short and the phase 2 duration is longer.

counter starts

¢ phase 1 | phase 2 |
Duty Cycle = 0.5

Duty Cycle = 0.1

Duty Cycle = 0.9

Figure 22-2. Pulse Duty Cycles

Note: A high duty cycle denotes a long pulse phase relative to the delay phase.

Now that you know the terms involving generating a single square
pulse or a pulse train, you can learn about the LabVIEW VIs, and the
physical connections needed to implement your application.

Generating a Single Square Pulse

When do you need to generate a single square pulse? A single pulse
could be used to trigger analog acquisition or to gate a counter
operation, especially if you are triggering off an edge of the pulse.
Refer to the How to Generate Pulses and Pulse Trains VI, located in
examples\dag\counter.11b as you read this section.

Figure 22-3 illustrates how to connect your counter and device to
generate a square pulse. The edges of the internal SOURCE signal are
counted to generate the output signal. You get the pulse signal for your
external device from the counter’s OUT pin, and you can optionally
gate the operation with the signal connected to the GATE. Instead of

© National Instruments Corporation 22-3 LabVIEW Data Acquisition Basics Manual



Chapter 22 Generating A Square Pulse or Pulse Trains

using an internal timebase as your SOURCE, you could connect an
external signal.

Basic Connection Optional Connection
ouT—>» — SOURCE OUT —
oaaDovce || || S0l | | [Comteregiser] | | g
— GATE

Figure 22-3. Physical Connections for Generating a Square Pulse

The Generate Delayed Pulse VI, found in Functions»Data
Acquisition» Counter, tells your device to generate a single delayed
pulse. This VI is self-contained and checks for errors automatically.
With the Generate Delayed Pulse VI, you must connect the pulse delay
(phase 1) and pulse width (phase 2) controls to define the output pulse,
as shown in Figure 22-4. Sometimes the actual pulse delay and pulse
width are not the same as you specified.

device

ST actual pulse delay [s or cycles]]
[ DBL |

=]

4 W
Laclual pulse width [s or cycles)|
ulse delay (s or cycles [@BL]|

DBL

ulse width (s or cycles
DBL

Figure 22-4. Using the Generate Delayed Pulse VI

If you need more control over when the counter actually begins
generating a single square pulse, use Intermediate VIs instead of the
Easy VIs. Figure 22-5 shows how to generate a single pulse using the
intermediate-level VIs. The Delayed Pulse Generator Config VI
configures the counter and the counter, using the Counter Start VI,
generates the TTL signal. An example of this is if you wanted to
generate a pulse as a result of meeting certain conditions. If you used
the Easy Counter VI, the VI would configure and then immediately
start the pulse generation. With the Intermediate VIs, you can

LabVIEW Data Acquisition Basics Manual 22-4 © National Instruments Corporation




Chapter 22 Generating A Square Pulse or Pulse Trains

configure the counter long before the actual pulse generation begins.
As soon as you want a pulse to be generated, the counter can
immediately begin without having to configure the counter. In this
situation, using Intermediate VIs would improve performance.

devvice task D
PULEE +

counter COHFIGE Ei!".«t"
Fall S

— —F

Figure 22-5. Generating a Single Delayed Pulse Using Intermediate Vis

You must stop the counter if you want to use it for other purposes. For
more information on stopping counters, refer to the Stopping Counter
Generations section at the end of this chapter.

Generating a Pulse Train

There are two types of pulse trains: continuous and finite. You may use
a continuous pulse train as the SOURCE of another counter or as the
clock for analog acquisition (or generation). You may use a finite pulse
train as the high-level gate signal for another counter.

For a LabVIEW example on generating continuous and finite pulse
trains, look at the How to Generate Pulses and Pulse Trains VI, located
in examples\dag\counter.1llb.

Generating a Continuous Pulse Train

Figure 22-6 describes how to connect your counter and device to
generate a continuous pulse train. The edges of the internal source
signal are counted to generate the output signal. You obtain the
continuous pulse train for your external device from the counter’s OUT
pin. You can optionally gate the operation with a signal connected to
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the GATE input pin. Instead of having an internal timebase as your
SOURCE, you can connect an external signal.

counter

your sourc: your
device| | gatgu device|

Figure 22-6. Physical Connections for Generating a Square Pulse

Besides generating continuous pulse trains, the How to Generate
Pulses and Pulse Trains example VI configures counters to generate
retriggerable pulse trains, which behave like one-shots.

Figure 22-7 shows how to generate a continuous pulse train using the
Easy Counter VI, Generate Pulse Train. This VI requires you to specify
the frequency and the duty cycle inputs. The number of pulses

parameter defaults to O for the generation of a continuous pulse train.

device
counter
number of pulses [cont:0) ;’lﬁjlﬂ?ﬁ
132 it
frequency [Hz)
[oec]
duty cycle [.5)
Goor]

Figure 22-7. Generating a Continuous Pulse Train with the Generate Pulse Train VI

If you are generating a pulse train and you want more control over
when the counter actually begins the operation, use the Intermediate
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VIs instead of the Easy VIs. Figure 22-8 demonstrates how to generate
a simple pulse train using Intermediate-level VIs.

device Py p—
GURTEF

counter I:EIHF1IG Start
Hribd o L2

————1

Figure 22-8. Generating a Continuous Pulse Train Using Intermediate VIs

The Continuous Pulse Generator Config VI configures the counter for
the operation and the Counter Start VI controls the initiation of the
pulse train. An example of this if you want to generate a continuous
pulse train as a result of meeting certain conditions. If you used the
Easy VI, the VI would configure and then immediately start the pulse
train generation. With the Intermediate VIs, you can configure the
counter long before the conditions are met. Then, as soon as the
conditions are met, you can begin pulse train generation. In this
situation, using Intermediate VIs would improve performance.

If the duty cycleis 0.0 or 1.0, the closest achievable duty cycle is
used to generate a train of positive or negative pulses.

You must stop the counter if you want to use it for other purposes. For
more information on stopping counters, refer to the Stopping Counter
Generations section at the end of this chapter.

Generating a Finite Pulse Train

You can set the Easy I/O VI, Generate Pulse Train, or a stream of
Intermediate VIs to generate a finite pulse train. With either technique,
you must use two counters as shown in the connection diagram in
Figure 22-9. Refer to Chapter 25, Counting Signal Highs and Lows, for
more information on how to determine counter-1 and how to use the
adjacent counter VI. The maximum number of pulses in the pulse train
is 216-1, for Am9513 devices and 2%*-1 for DAQ-STC devices.

Figure 22-9 shows how you can produce a finite pulse train on the OUT
pin of a counter. counter generates the finite pulse train with high-level
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gating. counter-1 provides counter with a long enough gate pulse to
output the number of desired pulses.

counter-1 counter
your source  [sourcd your

; out O e :
dewce‘Lgate -Lgate device

Figure 22-9. Physical Connections for Generating a Finite Pulse Train

A gated pulse train using the Easy Counter VI, Generate Pulse Train,
as shown in Figure 22-7, requires the frequency, duty cycle, and
number of pulses controls to be set. Instead of setting the number of
pulses to 0, as you would for a continuous pulse train, set the number
of pulses to a value greater than 0.

Figure 22-10 describes how to create a finite pulse train using the
Intermediate VIs.

gate mode (edge gating
gate mode @
(level gating — |
oee (6] T T e I e
ar ar

counter a1 12 ¥R
pulse polarity

frequency I-1 .O: counter -1

duty cycle |0.5=

Figure 22-10. Creating a Finite Pulse Train Using the Intermediate VIs

In this operation, you use counter to generate a continuous pulse train
with level gating while using counter-1 to generate a minimum delayed
pulse to gate the counter long enough to generate the desired number
of pulses. The Continuous Pulse Generator Config VI configures
counter to generate a continuous pulse train. Then, the Delayed Pulse
Generator Config VI configures counter-1 to generate a single delayed
pulse. The first Counter Start VI in the flow begins the continuous
pulse generation and the next Counter Start VI generates a pulse after
a specified time. The gate mode must be specified as level-gating on
the Continuous Pulse Generator Config VI in order for the counter to
wait for the gate signal from counter -1. The gate mode for the Delayed
Pulse Generator Config VI can be set to a single or multiple edges. In
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other words, you could produce one finite pulse train or multiple pulse
trains. The GATE signal for counter -1 can be from an external device
or from another counter on your DAQ device.

Knowing the Accuracy of Your Counters

When you generate a waveform, there can be an uncertainty of up to
one timebase period between the start signal and the first counted edge
of the timebase. This is due to the uncertainty in the exact relation of
the start signal, which the software call or the gate signal supplies to
the first edge of the timebase as shown in Figure 22-11.

1 dimebas perind

. ! uncerainty of
1 1+ 1 dmehaze period

Figure 22-11. Uncertainty of One Timebase Period

Stopping Counter Generations

You can stop the counting operation in several ways, such as starting
the counter again after it has generated a pulse, reconfiguring the

counter to do something else, or calling the Wait (ms) VI and Counter
Stop function as shown in Figure 22-12. (You can find the Wait (ms)
VI in Functions»Time & Dialog.) The previous methods can be used
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so that the counter can be used for another operation without resetting
the entire board.

PULSE ¥ g:unter ,
| o] ) [
S Q. B

Generate Delayed Pulse.vi Wait+ (ms). vi

Figure 22-12. Using the Generate Delayed Pulse and Stopping the Counting Operation

To stop a generated pulse train, another Generate Pulse Train VI can
be concatenated to the diagram and have the Number of Pulses input
set to -1, as shown in Figure 22-13.

MNumber of Pulses

PULSE ULSE
TRAIN
-l 1+ 4 d—l:l

Generate Pulse Train.vi Generate Delayed Pulse.vi

Figure 22-13. Stopping a Generated Pulse Train
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Measuring Pulse Width

This chapter describes how you can use a counter to measure pulse
width. There are several times you may need to determine pulse width.
For example, if you wanted to determine the duration of an event, you
would want your application to measure the width of a pulse that occurs
during that event. Another example would be if you wanted to
determine the interval between two events. In this case, you would
measure the pulse width between the two events. An example of when
you might use this type of application is if you wanted to determine the
time interval between two boxes on a conveyor belt or the time it takes
one box to be processed through an operation. The event would be an
edge every time a box goes by a point, which prompts a digital signal
to change in value.

Measuring a Pulse Width

You can measure pulse width by determining the number of pulses of
known frequency that are generated during the period to be measured.
As illustrated in Figure 23-1, connect the pulse you want to measure to
the GATE input pin and a signal of a known frequency to the SOURCE
input pin. Your counter must be configured for high-level mode gating,
which means the counter starts counting when the gated signal goes

high and stops counting at the end of the pulse. Figure 23-1 describes
how a pulse of an unknown width (Tpw) gates a counter configured to
count a timebase clock of a known period (7). The pulse width equals

the timebase period times the count, or: T,

. = TS X count .

| —|GATE N e

count register

frequency — »l=ouRcE
SOuFce

Ts

Figure 23-1. Counting Input Signals to Determine Pulse Width
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The SOURCE input can be an external or internal signal. An internal

signal or clock is based upon the type of counter chip on your device.

With Am9513 devices, you can choose frequencies or timebases of

1 MHz, 100 kHz, 10 kHz, 1 kHz, and 100 Hz. DAQ/STC devices have
internal timebases of 20 MHz and 100 kHz. Figure 23-2 shows how to
physically connect the counter on your device to measure pulse width.

counter
your Sourced

device 'L gatht

Figure 23-2. Physical Connections for Determining Pulse Width

Determining Pulse Width

You can measure the pulse width using the Measure Pulse Width or
Period VI, located in Functions»Data Acquisition»Counter. This VI
automatically notifies you with a dialog box if an error occurs.
Figure 23-3 shows how to program your counters to determine the
pulse width using this Easy Counter VI.

device pulse width/period (s)
Ti6
" ’J,=. valid?
counter FPULSE
= [pe—
abc ==

type of measurement | | Measure Pulse Width or Period.vi

|

timebase (100 Hz)

Figure 23-3. Determining Pulse Width Using the Pulse Width or Period VI

The Measure Pulse Width or Period VI counts the number of cycles of
the specified internal timebase between the starting and ending events
that you designate in the type of measurement input. You can measure
the pulse width from rising to falling edge or from falling to rising

edge. The valid? parameter indicates whether the frequency measured
the data without overflow. Overflow occurs when the counter reaches
its highest value, or terminal count (TC). You only need to check the
valid? parameter if you are using an Am9513 chip. The DAQ-STC
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does not use the valid? parameter to set the overflow, so you do not
need to check this parameter with this chip. Refer to the Measure Pulse
Width or Period VI description in Chapter 17, Easy Counter Vls, of the
LabVIEW Data Acquisition VI Reference Manual for further information
regarding the input parameters.

Controlling Your Pulse Width Measurement

Figure 23-4 describes how to measure pulse width using the following
Intermediate Counter VIs: Pulse Width or Period Meas Config,
Counter Start, Counter Read, and Counter Stop. Use this set of VIs to
control when the measurement of the pulse width begins and ends. The
Pulse Width or Period Meas Config VI configures a counter to count
the number of cycles of a known internal frequency or timebase. The
Counter Start VI begins the measurement. The Counter Read VI
determines if the measurement is complete and displays the count
value. With Am9513 devices, the Counter Read VI also alerts you if an
overflow occurs (when the counter reaches terminal count (TC)).
Overflows do not occur in continuous counter operations. Once you
press the stop button, the Counter Stop VI stops the counter operation.
And finally, the Simple Error Handler VI notifies you of any errors.

dewice

timebase (Hz)

count

Ll

caunter

FLULFE

FER oF i

Counter
Stop @
1 ,

type of measurement

Figure 23-4. Measuring Pulse Width Using Intermediate VIs

When measuring pulse width, make sure you start the counter before
your device measures the first pulse. Otherwise, LabVIEW returns an
error or an incorrect measurement.
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Increasing Your Measurable Width Range

The maximum value for counters determines the internal timebases
you can use to measure the pulse width of a signal. Remember the
internal timebase acts as the SOURCE. When measuring the pulse
width of a signal, you count the number of SOURCE edges that occur
during the measured pulse. The counted number of SOURCE edges
cannot exceed the counting range of the counter. Slower internal
timebases allow for a greater range in possible pulse widths, because it
takes a longer period of time to reach the maximum counter value.
Because the Am9513 counters are 16-bit count registers, the maximum
count value is 65,535 (2!6-1). For example, if you use a 1 Us internal
timebase, the counter has a pulse width range of 65 ms or 655 s at
100 Hz. The DAQ/STC counter has a pulse width range of about

840 ms at 20MHz and 167ms at 100 kHz. Therefore, if you produce an
overflow error, decrease the timebase frequency to increase your range
of measurable width.

Instead of using an internal timebase, you can set up an additional
counter for pulse train generation and use the output of that counter as
the source of the counter measuring pulse-width. You can also use
FOUT or FREQ_OUT for this purpose.
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Measuring
and Period

Frequency

This chapter describes the various ways you can measure frequencies
and periods using the counters on your data acquisition (DAQ) device.
The period of a signal is equal to one cycle of the signal. Frequency is
the inverse of period. An example of when you would want to know the
frequency of a signal is when you have a signal that controls how often
a meter takes measurements—like a flow meter measuring flow rates

or a thermometer measuring temperature.

Knowing How and When to Measure Frequency and

Period

A common way to measure the frequency of a signal is to measure the
number of pulses that occur during a known time period. For example,
Figure 24-1 illustrates the measurement of a waveform of an unknown
frequency (f,) by a pulse of a known pulse width (7 ). The frequency
of the waveform equals the count divided by the period of known pulse
width (frequency=count/T;). The period is always the reciprocal of the
measured frequency (period=1/f,).

— | —{ GATE ouT ——g

+——F
Tg

pulze of known width c-:n.ln register

| | | ——{SOURCE

input of unknown

frequency , £

Figure 24-1. Measuring Square Wave Frequency

For period measurement, you count the number of pulses of a known
frequency (f;) during one period of the signal to be measured. As shown
in Figure 24-2, the signal of a known frequency is connected to the
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SOURCE and the signal to be measured is connected to the GATE. The
period is the count-divided by the known frequency (count/f).

| | —_— GHTE LT [

+—
Tg

count register

| | | | | —i SOURCE

input of known
frequency , o

Figure 24-2. Measuring a Square Wave Period

You typically would use frequency measurement for high frequency
signals because the signal to be measured is faster than most available
internal timebases. Period measurement is commonly used with low
frequency signals because the signal to be measured is slower than
most internal timebases. For the Am9513 chip, the possible internal
timebases are 1 MHz, 100 kHz, 10 kHz, 1 kHz, and 100 Hz. For the
DAQ-STC chip, the possible internal timebases are 20 MHz and
100 kHz. Remember that whether you use the frequency or period
measurement, you can always obtain the other measurement by taking
the inverse of the current one as shown in the following equations.

1
frequency measurement

period measurement =

1
period measurement

frequency measurement =

Connecting Counters to Measure Frequency and Period

For low frequency signals, your counting range should not exceed the
range of one counter (65,535 for the AM9513 chip and more than

4 billion for the DAQ-STC chip). If the counting range does exceed
one counter, pick a faster timebase.

Connect your device and counter as indicated in Figure 24-3 to
measure low frequency signals. To measure pulse period and
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frequency, you should wire the signal to be measured to the GATE
input pin and a timebase of known frequency to the SOURCE input pin.

counter
your sourced

device -L gate?Ut

Figure 24-3. Physical Connections for Period Measurement of Low Frequency Signals

For high frequency signals, you have a greater potential for a larger
counting range. Counters are cascaded together to increase the
counting range, as shown in Figure 24-4. Here counter-1 creates a
gating pulse for an even counter (counter) and for increased resolution
you can concatenate an additional counter (counter+1).

counter
SOUrc source {sourc
d'igl;"ge out out} out
gate qate gate
counter-1 counter+1
(32-bit)

Figure 24-4. Physical Connections for Period Measurement of High Frequency Signals

Note: You cannot cascade counters together with devices that use the DAQ-STC
chip.

Refer to Chapter 25, Counting Signal Highs and Lows, for further
information regarding adjacent counters.

A LabVIEW example that measures the frequency and period of high
and low frequency signals is the How to Measure Frequency and Period
VI, located in examples\dag\counter.11lb. Refer to this example
as you read the following sections.
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Measuring the Frequency and Period of Low Frequency
Signals

For low-frequency signals, you can use the Measure Pulse Width or
Period VI, located in Functions»Data Acquisition» Counter, as shown
below in Figure 24-5. Set the type of measurement parameter to a
period or pulse measurement. The frequency is the reciprocal of the
period value returned. The valid? parameter indicates if the frequency
was measured without overflow. Overflow occurs when the counter
reaches its highest value, or terminal count (TC). You only need to
check the valid? parameter if you are using an Am9513 chip. The
DAQ-STC does not use the valid? parameter to set the overflow, so you
do not need to check this parameter with this chip.

device
pulze width /period (=)
counter
- Measure Pulse Wwidth or Period. wi
type of measurement
FULZE
@ Feriab walid?
timebase (100KH) | il
I DEL I

Figure 24-5. Measuring Low-Frequency Signals with Measure Pulse Width or Period VI

If you need more control over when frequency/period measurement
begins and ends, use the Intermediate VIs instead of the Easy VIs.

Figure 24-6 shows you how to measure the period and frequency for
low-frequency signals.

The Intermediate VIs described in Figure 24-6 include the Pulse Width
or Period Meas Config, Counter Start, Counter Read, and the Counter
Stop VIs. The Pulse Width or Period Meas Config VI configures the
counter for period measurement. The Counter Start VI begins the
counting operation. Counter Read returns the count value from the
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counter, which is used to determine the frequency and period
measurement. Counter Stop stops the counter operation.

FULZE
ILEF! GF&

Figure 24-6. Measuring Low-Frequency Signals Using Intermediate VIs

A third method to determine frequency involves timing how long it
takes a number of cycles of the TTL signal connected to the SOURCE
input to occur. Refer to the How to Measure Frequency and Period VI
(Case 4) for a detailed description of the block diagram.

Itis a good idea to know what type of signal you are measuring, so you
can use the best approach for measuring the frequency signal.

Measuring the Frequency and Period of High Frequency
Signals

For high-frequency signals, you can use the Easy VI, Measure
Frequency, to determine the frequency, as shown in Figure 24-7. You
can find the Measure Frequency VI in Functions»Data
Acquisition»Counter. This VI initiates the counter to count the number
of rising edges of a TTL signal at the counter’s SOURCE input during
a gate period of a specific duration (7 seconds). Set the gate width (T)
to the pulse width of the gated signal. The measured frequency equals
count/ gate width. The valid? parameter indicates if the frequency was
measured without overflow. Overflow occurs when the counter reaches
its highest value, or terminal count (TC). You only need to check the
valid? parameter if you are using an Am9513 chip. The DAQ-STC
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does not use the valid? parameter to set the overflow, so you do not
need to check this parameter with this chip.

device frequency (Hz)
counter
abe FRE
e i valid?
gate width [s)

Figure 24-7. Measure Frequency VI

If you need more control over when frequency/period measurement
begins and ends, use the Intermediate VIs instead of the Easy VIs.
Figure 24-8 shows you how to measure the period and frequency for
high-frequency signals.

The Intermediate VIs described in Figure 24-8 include the Delayed
Pulse Generator Config, Event or Time Counter Config, Counter Start,
CTR Control, Counter Read, and the Counter Stop VIs. The Delayed
Pulse Generator Config VI configures counter -1 to generate the gate
signal. The Event or Time Counter Config VI configures the counter to
count the number of pulses while it is gated. The Counter Start VI
begins the counting operation for counter first, then counter -1. The
Counter Read VI returns the count value from counter, which is used
to determine the frequency and period measurement. The Counter Stop
VI stops the counter operation.

PULSE —
0 . Counter Counter

NFIG ~ LS Start
L =T

|
Control Counter
" R Stop @
=] ) R el B[
r o

Figure 24-8. Measuring High-Frequency Signals Using Intermediate VIs
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A third method to determine frequency involves timing how long it
takes a number of cycles of the TTL signal connected to the SOURCE
input to occur. Refer to the How to Measure Frequency and Period VI
(Case 4) for a detailed description of the block diagram.

Itis a good idea to know what type of signal you are measuring, so you
can use the best approach for measuring the frequency signal.
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Counters can count external events (like the rising and falling edges on
the SOURCE input pin), or elapsed time (like the rising and falling
edges of an internal timebase). When might you need to count external
events or elapsed time? One case is if you are in charge of figuring out
the throughput of a production line. You have a bar code reader which
reads the serial number of every product. The bar code reader outputs
a digital pulse every time it reads a serial number. You could use a
counter, counter A, to count the number of digital pulses, or events,
from the barcode reader. If you only needed to count the digital pulses
for a certain amount of time, you can gate the operation of the counter.
In order to produce the gate signal for the counter, you can use another
counter, counter B, to count the pulses of an internal clock for the
amount of time needed to count the number of products. So, counter B
would measure elapsed time and the output pulse(s) of counter B would
turn counter A on and off. As you can see, time- or event-based
counting can be very useful with data acquisition.

Figure 25-1 shows how to connect the counter on your device to
measure events (left diagram) and elapsed time (right diagram). The
GATE signal can be produced by your device or another counter (like
in the example mentioned above).

counter

device

gate

Tk

count events

counter ]
s[soure your source fsourc ﬁw
; out device ot out optional
gate gate gate iternal
counter+1 counter+1 cnnnectmni
(Z2-hit) count time [Z2-hit)

Figure 25-1. Connecting Counters to Your Device to Count Events or Time

Note: (Am9513 chips only) Make sure to use counters that are not being used in
any other data acquisition (DAQ) applications. If you try to use a counter
that is already being used by another DAQ application, LabVIEW returns
error number -10009. Refer to Appendix B, Hardware Capabilities, in the
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Note:

LabVIEW Data Acquisition VI Reference Manual for information on which
counters are already used for analog and digital applications.

As shown in Figure 25-1, you can extend the counting range of a
counter chip by connecting to the next higher counter (called
counter+1). This is called cascading counters. By cascading counters,
you can increase your counting range from 65,535 (the maximum
number for a 16-bit counter) to almost 4.3 billion (the maximum
number for a 32-bit counter) on the Am9513 chip. The Am9513 chip
has a set of five counters (numbered 1-5) that can be connected in a
circular fashion. For example, the next higher counter to counter 1 is
counter 2 (called counter+1) and the next lower counter is counter 5
(called counter-1). The TIO-10 device contains two Am9513 chips, so
the device has 10 counters, two sets of five counters which can be
accessed in a circular fashion. Table 25-1 identifies the adjacent
counters for the Am9513 (one and two chips).

You cannot cascade counters with devices that have the DAQ-STC chip.

Table 25-1.  Adjacent Counters for Counter Chips

Device Next Lower Counter | Next Higher
Type Counter Counter

5 1 2
1 2 3
2 3 4
3 4 5

= 4 5 1

1

£

- 10 6 7
6 7 8
7 8 9
8 9 10
9 10 6
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For more information on adjacent counters, refer to the Adjacent
Counters VI description in Chapter 18, Intermediate Counter Vls, of the
LabVIEW Data Acquisition VI Reference Manual.

Counting Events or Elapsed Time

In order to count events or elapsed time, you can use Easy I/O and
Intermediate VIs. You should only use the Advanced VlIs if the Easy
I/0 and Intermediate VIs do not satisfy your needs. One example in
LabVIEW that uses the Advanced VIs is the How To Count VI, found
in examples\dag\counter. 11b. Inthe discussion below, the use of
the Easy and Intermediate VIs will be discussed. You can refer to the
Getting Started Counters VI as well as the How To Count VI for
examples on how to use Easy I/0 and Intermediate VIs to count events
or elapsed time. You can find the Getting Started Counters VI in
examples\dag\run_me.1llb.

The Easy VI that counts events or time, the Count Events or Time VI,
is located in Functions»Data Acquisition» Counter. Figure 25-2 shows
how you would use the VI to count external events. This VI displays a
dialog box if an error occurs.

uze counter's SOURCE|
0.0

oLk

Figure 25-2. Using the Count Events or Time VI to Count External Events
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In Figure 25-2, the counter begins counting the rising edges at the
SOURCE input on the first iteration of the while loop. Pressing the stop
button will stop the counter and output the present count to the front
panel of the VI. The counter size input is a menu ring where you have
the choice to use a single 16-bit Am9513 counter or a 24-bit DAQ-STC
counter, or cascade two Am9513 counters as a 32-bit counter. By
default, this VI counts the rising edges of the SOURCE signal. You can
change the value of the source edge input, so it will count the falling
edges of the SOURCE signal. In order to figure out where the inputs
and outputs are located on this VI, remember to use the Help window.

Figure 25-3 shows how to use the Easy Counter VI, Count Events or
Time VI, to measure elapsed time.

elapzed time

counter size

start]--

Figure 25-3. Using the Count Events or Time VI to Measure Elapsed Time

The only difference between measuring events or time is the type of
source signal. When measuring events, you have an external signal
connected to the SOURCE input. When measuring time, you use an
internal timebase signal produced by the counter chip. With the
Am9513 chip, you can choose from the timebases of 1 MHz, 100 kHz,
10 kHz, 1 kHz, and 100 Hz. With the DAQ-STC chip, you can choose
from the timebases of 20 MHz and 100 kHz. How do you know which
timebase frequency to use? Suppose you want to count the rising edges
of the internal signal for 1 minute. The maximum counted value for a
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16-bit counter is 65,535. If you use the 100 Hz signal, your counter
would count 100 edges in a minute. If you use the 100 kHz signal, then
the counter counts 100,000 edges in a minute. This means you would
need to cascade two counters in order to count the necessary edges
using the 100 kHz signal. You should use a higher frequency for
smaller time measurements and use a slower frequency for longer time
measurements. If you do not choose one of the above frequencies, then
the counter will give you error -10403, which informs you that the
specified device does not support your requested action. If you need to
use a frequency that is not listed above, then refer to Chapter 26,
Dividing Frequencies, for more information.

Gaining More Control over Your Counting Operations

If you want more control over counting events or time, use the
Intermediate VIs. These Vs allow you to trigger or gate the counting
operation. Figure 25-4 shows how to count external events using
Intermediate Counter VIs: Event or Time Counter Config, Counter
Start, Counter Read, and Counter Stop.

[count continuousy|

EviCE

. Counter Counter
F = Ttart Read
counter] | [ LELE iz

B [etats]

i

Figure 25-4. Using the Intermediate VIs to Count External Events

This VI tells the counter to count the number of rising edges on the
SOURCE input until the stop button is pressed.

The Event or Time Counter Config VI configures one or two counters
to count the edges of the signal at the SOURCE input. The counter size
input is a menu ring similar to the Easy I/O examples. You have the
choice to use a single, 16-bit Am9513 counter or a 24-bit DAQ-STC
counter, or cascade two Am9513 counters as a 32-bit counter. The
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event source/timebase input is set to count the edges of the SOURCE
signal by default (a 0. 0 default value). The source edge input is set to
count on a rising edge by default. In order to figure out the location of
the event source/timebase input as well as any other parameters on any
VI, use the Help window. The Counter Start VI initiates the counter to
begin counting the edges of the SOURCE input. The Counter Read VI
reads the latest edge count from the counter register and displays the
value on the front panel. Once the stop button has been pressed, the
Counter Stop VI stops the counter operation.

It is a good idea to always check for errors at the end of an operation
to see if the operation was successful.

If you want to trigger TTL event counting, then set up your gate mode
input on the Event or Time Counter Config VI. With this VI, you can
perform level or edge triggering. Refer to the Event or Time Counter
Config VI description in Chapter 18, Intermediate Counter Vls, of the
LabVIEW Data Acquisition VI Reference Manual for more information.

When you use Easy I/O VIs to measure external events or elapsed time,
the only difference between the two block diagrams is the counting
source. The same is true when you use Intermediate VIs. For the Event
or Time Counter Config VI, the default event source/timebase input is
the signal connected to the SOURCE input (a value of 0). If you want
to use an internal timebase as your source, then you need to enter an
internal frequency available on your DAQ device. Figure 25-5 shows
how to measure elapsed time using Intermediate VlIs.

[count continuously|

elapsed time
—Counter

133 ¢

[£>—{men
Read
2 (2]

Ccounter size

limebase

g

Figure 25-5. Using the Intermediate VIs to Measure Elapsed Time
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Counters enable you to count the edges of TTL signals whether the
signals are external or internal to the DAQ device. Counting external
signals is called counting events; whereas, counting internal signals is
called elapsed time. Since counters count events or time, you can
combine these two capabilities in order to count events for a certain
period of time. The basic capability of counting TTL signals allows
you to perform many complex functions.
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Dividing Frequencies

When would you need to divide the frequency of a TTL signal?
Sometimes you may need to use an internal signal at a certain
frequency, but this frequency is not available on your data acquisition
(DAQ) device. In order to get the frequency you need, you can divide
the available device frequencies. You can also divide the frequency of
an external signal. Frequency division is outputting a pulse or pulse
train from a counter every N cycles of an internal or external source.
Counters can only decrease (or divide-down) the frequency of the
source signal. The resulting divided-down frequency is equal to the
input frequency/N (timebase divisor). N ( timebase divisor) can only be
an integer number, not a real number, and must also be greater than 1.
Performing frequency division on a internal signal is called a down
counter; whereas, frequency division on an external signal is called a
signal divider. Figure 26-1 shows how to wire counters to perform
frequency division.

counter
Yoy J_E':'u;ﬁt Y our
dewvice gate device
Frequency Division for a Signal Divider
counter
I our 50”;3:_ I oM
dewvice gate device

Frequency Division for a Down Counter

Figure 26-1. Wiring Your Counters for Frequency Division

In order to divide down frequencies, you must use Intermediate VIs
instead of Easy VIs. For a LabVIEW example on frequency division,
refer to How to Generate Pulses and Pulse Trains VI, (pulse generation
method 5) in examples\dag\counter.11lb. The diagram in
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Figure 26-2 shows how you can program a signal divider using the
Down Counter or Divide Config, Counter Start, and Counter Stop VIs.

DIWIDER,
[ : Stop

e [
]
:

device [Dawn Counter ar Divider Config. v
el m OH GTR Counter
abc

output [high pulzed

) Lize counter's SEILIFH:E|

himebaze divisor

Figure 26-2. Programming a Single Divider for Frequency Division

The Down Counter or Divide Config VI configures the specified
counter to divide the SOURCE signal by the timebase divisor value
and output a signal when the counter reaches its terminal count (TC).
Using Down Counter or Divide Config VI, you can configure the type
of output to be pulse or toggled. The diagram above outputs a high
pulse lasting one cycle of the source signal once the counter reaches its
TC. For more information on the different types of signal outputs, refer
to the Down Counter or Divide Config VI description in Chapter 18,
Intermediate Counter Vls, of the LabVIEW Data Acquisition VI Reference
Manual. The diagram above counts the rising edges of the SOURCE
signal, the default value of the source edge input. In order to figure out
where the inputs and outputs are located on this VI, remember to use
the Help window. Open this window by choosing Help»Show Help.

The Counter Start VI tells the counter to start counting the SOURCE
signal edges. The counter only stops the frequency division when the
stop button is pressed. The Counter Stop VI stops the counter
immediately and clears the count register. It is a good idea to always
check your errors at the end of an operation to see if the operation was
successful.

You can alter the Down Counter or Divide Config VI to create a down
counter. To do this, change the timebase value from 0.0 (external
SOURCE) to a frequency available on your counter. With the Am9513
chip, you can choose timebases of 1 MHz, 100 kHz, 10 kHz, 1 kHz, and
100 Hz. With the DAQ-STC chip, you can choose timebases of

20 MHz and 100 kHz.
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Instead of triggering frequency division for signal dividers and down
counters by software, as was previously discussed, you can trigger
using the GATE signal. You can trigger while the GATE signal is high,
low or on the rising or falling edge. For more information, look at the
Down Counter or Divide Config VI description in Chapter 18,
Intermediate Counter Vs, of the LabVIEW Data Acquisition VI Reference
Manual.
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Debugging Your Data
Acquisition Application

This section contains an explanation of ways you can debug your data
acquisition application to make sure your application is accurate and
runs smoothly.

Part 7, Debugging Your Data Acquisition Application, contains the
following chapters.

*  Chapter 27, Debugging Techniques, shows you some tips to help
figure out why your VI is not working.



Debugging Techniques

Is your VI not working as you expected it would? Well, this chapter
shows you some tips to help figure out why your VI is not working.
First, find your LabVIEW User Manual and LabVIEW Tutorial Manual,
because these manuals are references in this section. With LabVIEW
data acquisition (DAQ) applications, you may find errors in hardware
connections, software configuration, or VI construction. The goal of
this chapter is to help you narrow down where the problem is in your
program flow.

Hardware Connection Errors

When no error occurs, but the data is not what you expected, then you
may want to check your hardware connections and jumper settings. For
instance, if you have an analog input application, make sure your
signals are properly grounded. For more information on analog input
configuration issues, refer to Chapter 5, Things You Should Know about
Analog Input.

For SCXI modules, you must verify that gain jumpers are set up
properly. To verify how a DAQ device gets set to a certain gain (or
limit setting as noted in the software), refer to Chapter 3, Basic Data
Acquisition Concepts. Another common SCXI hardware error is using
digital lines on your DAQ device that are reserved for communication
with the SCXI modules.

In order to test that your hardware has not been damaged, connect a

known voltage to the channels you are using. To check the location of
any hardware connections, refer to your hardware user manual.

Software Configuration Errors

As you check hardware connections, it is a good idea to verify that the
NI-DAQ software configuration reflects your hardware setup. For
possible difficulties with software configuration, read the Installation
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and Configuration section of this manual, the chapter of this manual
that discusses your specific application, or the NI-DAQ User Manual.

(Windows) In the NI-DAQ configuration, you can use the utilities
under the test menu to take single point measurements for analog I/0
and digital I/O applications. These utilities are helpful in testing for
damaged hardware.

VI Construction Errors

Error Handling

The various sections below describe methods to find problems with VI
construction. All the techniques discussed can be used by themselves
or in conjunction with one another.

The best way to determine if your application executed without an
error is to use one of the error handler VIs in your application. The
Error Handler VIs are located in Functions»Time & Dialog. You can
only use these VIs with Intermediate and Advanced VIs. Easy I/O VIs
already include error handling capabilities within each VI. Each
Intermediate and Advanced VI has an error input and output clusters
(named error in and error out, respectively). The error clusters contain
a Boolean that indicates whether an error occurred, the error code for
the error, and the name of the VI that returned the error. If error in
indicates an error, the VI returns the same error information in error
out, and does not perform any DAQ operations.

error in (no error) error out

code

no error IE

source source

| | | —

When you use any of the Intermediate or Advanced VIs in a While
Loop, you should stop the loop if the status in the error out cluster
reads TRUE. If you wire the error cluster to the General Error Handler
VI or the Simple Error Handler VI, the VI deciphers the error
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information and describes the error to you. The following diagrams
show how to wire a typical DAQ VI to an error handler.

Al
CLEARR
s

Al
cLbaR
g

Figure 27-2. Error Checking Using the Simple Error Handler VI

The following shows an example of the dialog box the Error Handler
VIs display if an error occurs.

Error -10005 occurred at Al Group Config.

Possible reasons:
DAQ or DSP badDeviceErmn: The device is invalid.

Continue | Stop |

Please refer to the LabVIEW Function Reference Manual for more
information on the error handler VIs.

Single-Stepping through a VI
Single stepping through a VI allows you to execute one node at a time
in the block diagram. A node can be subVlIs, functions, structures,
formula nodes, and attribute nodes. Refer to Chapter 5, Executing and
Debugging, in the LabVIEW User Manual and the LabVIEW Tutorial
Manual for more information on single-stepping.

Execution Highlighting
Execution highlighting shows you how the data passes from one node
to another in your program. When you turn execution highlighting on,
data movement is marked by bubbles moving along the wires. Refer to
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Chapter 5, Executing and Debugging, in the LabVIEW User Manual and
the LabVIEW Tutorial Manual for more information on execution
highlighting.

Using the Probe Tool

If your VI is producing questionable results, you may want to use the
Probe tool to check intermediate values in a VI. The Probe tool will
help you narrow down where the incorrect results are occurring. Refer
to Chapter 5, Executing and Debugging, in the LabVIEW User Manual
and the LabVIEW Tutorial Manual for more information on using the
probe.

Setting Breakpoints and Showing Advanced DAQ Vls

Once you have narrowed down the location of an error to a subVI, you
can set a breakpoint on that subVI to cause VI execution and pause
before executing the subVI. You can now see what values get passed
in or are generated by the Advanced Vls, single-step through the
subVI’s execution, probe wires to see data, or change values of front
panel controls. Refer to Chapter 5, Executing and Debugging, in the
LabVIEW User Manual and the LabVIEW Tutorial Manual for more
information on how to set a breakpoint.
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LabVIEW Data Acquisition
Common Questions

Where is the best place to get up to speed quickly with data
acquisition and LabVIEW?

Read the LabVIEW Data Acquisition Basics Manual and look at the
run_me.1l1lb examples (in examples->daq) included with the
package.

What is the easiest way to address my AMUX-64T board with
my MIO board?

Set the number of AMUX boards used in the configuration utility
(wdagconf . exe on Windows or NI-DAQ control panel on
Macintosh). Then in the channel string inputs specify the onboard
channel. For example, with one AMUX-64T board, the channel
string “0 : 1” will acquire data from AMUX channels 0 through 7, and
SO on.

What are the advantages/disadvantages of reading Al Read's
backlog rather than a fixed amount of data?

Reading the backlog is guaranteed not to cause a synchronous wait for
the data to arrive. However, it adds more delay until the data is
processed (because the data was really available on the last call) and it
can require constant reallocation or size adjustments of the data
acquisition read buffer in LabVIEW.

How can | tell when a continuous data acquisition operation
does not have enough buffer capacity?

The scan backlog rises with time, either steadily or in jumps, or takes
a long time to drop to normal after an interrupting activity like mouse

movement. If you can open another VI during the operation without
receiving an overrun error you should have adequate buffer capacity.
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| want to group two or more ports using my DIO32F, DI024,
or DIO-96 bhoard, but I do not want to use handshaking. | just
want to read one group of ports just once. How can | set it up
in software?

Use Easy I/O VIs (Write to Digital Port or Read from Digital Port) or
Advanced Digital VIs (DIO Port Config, DIO Port Write or DIO Port
Read), and set multiple ports in the port list. For Easy I/O VIs, you can
specify up to four ports in the port list. Whatever data you try to output
to each port of your “group” will correspond to each element of the
data array. This also applies for input.

| want to use the OUT1, OUT 2, OUT3 and IN1, IN2, IN3 pins
on my DI0-32F hoard. How do | address those pins using the
Easy I/0 Digital Vls in LabVIEW?

These output and inputs pins are addressed together as port 4. OUT1
and IN1 are referred to as bit 0, OUT?2 and IN2 are referred to as bit 1,
and OUT3 and IN3 are referred to as bit 2. Only the NB-DIO-32F has
3 pins for each direction. If you use the Write To Digital Port VI, you
will output on the OUT pins, and if you use the Read From Digital Port
VI, you will input from the IN pins.

| want to use a TTL digital trigger pulse to start data
acquisition on my DAQ device. | noticed there are two types
of triggers: Digital Trigger A, and Digital Trigger A&B. Which
digital trigger setting should | use and where should |
connect the signal?

You should use Digital Trigger A, which stands for “first trigger," to
start a data acquisition. Digital Trigger B, which stands for “second
trigger," should only be used if you are doing both a start AND a stop
trigger for your data acquisition. Connect your trigger signal to either
STARTTRIG* (pin 38) if you are using an AT-MIO-16,
AT-MIO-16D, NB-MIO-16X, or EXTTRIG* or DTRIG for any other
board that has that pin. The only analog input boards on which you
cannot do a digital trigger are the PC-LPM-16, DAQCard-700, and the
DAQCard-500. Refer to the Al Trigger Config description in
Chapter 6, Advanced Analog Input VIs, in the LabVIEW Data
Acquisition VI Reference Manual for more information on the use of
digital triggers on your DAQ device.
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Note: The NB-MI0O-16 has an EXTTRIG* pin, but cannot support start and stop
triggering.

When are the data acquisition boards initialized?

All data acquisition boards are initialized automatically when the first
DAQ Vlis loaded in on a diagram when you start LabVIEW. You can
also initialize a particular board by calling the Device Reset VI.

(Windows) | open a VI that calls a DAQ VI, or drop a DAQ
subVl on a block diagram, and crash.

The first time a DAQ VI is loaded into memory in LabVIEW,
LabVIEW opens the library (d11) that controls data acquisition. A
crash at this time indicates a problem in communicating with the
driver. This may indicate that there is a conflict with another device in
the machine.

To determine the source of the problem, quit LabVIEW and Windows,
re-launch Windows, and run wdagconf . exe. Run a simple
configuration test with the NI boards in the machine. If this results in
a crash, there is probably a conflict with another device in the machine
or the driver’s file versions do not correspond for some reason. If not,
you need to obtain the latest version of the DAQ driver from NI BBS,
World Wide Web, or FTP site.

We have also seen cases where the video driver conflicts with both
WDAQCONF and LabVIEW. You can obtain the Error Messages and
Crashes Common Questions document from the NI FaxBack system.

(Windows) | am having problems accessing ports 2 or
higher on the AT-MI0-16D or PC-DI0-96.

A problem was found in version 3.0 with addressing the higher-
numbered ports on these boards. To fix the problem, get the updated
version of atwdaqg.d11, and use the updated DIO Port Read.vi.
These updated files are included with LabVIEW for Windows version
3.0.1. LabVIEW for Windows version 3.0 users can obtain these files
by downloading the file win30up2 . zip from the NI BBS or FTP
sites. The file is in the directory support/labview/windows/
LVWin3.0/updates.
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(Windows) While performing analog input, | get memory
allocation errors (-10444) even though | have a large amount
of memory on my machine.

Buffers for data acquisition arrays, unlike arrays for LabVIEW buffers,
must be available in physical RAM, not in virtual memory. For
example, assume the machine has 32 MB of RAM, and LabVIEW is
allocated 8 MB of RAM. The memory allocated to LabVIEW wires
will come out of the 8§ MB; however, data acquisition buffers will be
allocated out of the remaining 24 MB of RAM.

On an AT style machine (ISA) using DMA, the DMA controller can
only address the first 16 MB of RAM. If you get "out of memory"
errors on your machine, try setting the board to use programmed I/O
(interrupts only) with the Set Device Information.vi (in
DAQ->Calibration and Config). An alternative is to switch to
an EISA bus machine. The DMA controller can address up to 4 GB of
RAM on EISA machines.

(Windows 3.1) | am having problems running Windows for
Workgroups with my data acquisition program.
Remark out nivisrd.386 inthe [386 Enhanced] section of

your system. ini file. To mark out the line, place a number sign (#)
at the beginning of the line which reads:

device = c:\windows\system\nivisrd.386

nivisrd. 386 normally improves performance by reducing interrupt
latencies in Windows enhanced mode.

(Windows 3.1)| hought LabVIEW for Windows and also have
a slightly older DAQ device from National Instruments. |
installed the entire LabVIEW package, but should | go ahead
and install my NI-DAQ for Windows drivers that | originally
got with the board?

In most cases, the answer is no. The LabVIEW installer installs a set
of DAQ driver files that are guaranteed to work with LabVIEW,
whereas if you happen to install an older version of the drivers, you
may run into many problems. You may even end up crashing your

computer every time you do any data acquisition. If you buy a new
DAQ device and if you already have LabVIEW installed, it is safe to
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install the NI-DAQ for Windows drivers from those disks. In any case,
make sure you install and use the latest version of the NI-DAQ drivers.

(Macintosh) My analog input Vis returns error -10845 (buffer
overflow). What is the problem?

If you do not have an NB-DMA-2800 or NB-DMASG board in your
Macintosh and are trying to acquire at sampling rates (not scan rates)
greater than 8 kHz, you may get this error. Even at sampling rates
under 8 kHz, depending on the type of machine, you may run into
overflow error problems if there is a lot of other interrupts that need to
be serviced. This is all due to the long interrupt latencies. If you do
have either DMA board in your Macintosh, make sure that you have a
RTSI cable connecting your DAQ device and the DMA board. Even
after you connect a RTSI cable, restarting LabVIEW may help.

Also, if you have a Quadra, your errors may be caused by prolonged
network interrupt latencies, which prevents the NI-DAQ driver from
copying the data in the DAQ device resident memory to the memory
on your computer. In this case, you can either disable AppleTalk in the
Chooser and disconnect your AppleTalk cable or contact National
Instruments and ask for the newest revision of the NB-MIO-16X
(which has a larger device resident memory) if you are using either of
those DAQ devices.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary
to help us solve your technical problems and a form you can use to comment on the product
documentation. When you contact us, we need the information on the Technical Support Form
and the configuration form, if your manual contains one, about your system configuration to
answer your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
quickly provide the information you need. Our electronic services include a bulletin board
service, an FTP site, a FaxBack system, and e-mail support. If you have a hardware or software
problem, first try the electronic support systems. If the information available on these systems
does not answer your questions, we offer fax and telephone support through our technical support
centers, which are staffed by applications engineers.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded
instructions on how to use the bulletin board and FTP services and for BBS automated
information, call (512) 795-6990. You can access these services at:

United States: (512) 794-5422 or (800) 327-3077
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: (44) 635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: (1) 48 651559
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere. com, as your password. The support
files and documents are located in the / support directories.
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FaxBack Support

FaxBack is a 24-hour information retrieval system containing a library of documents on a wide
range of technical information. You can access FaxBack from a touch-tone telephone at the

following numbers:

(512) 418-1111 or (800) 329-7177

E-Mail Support (currently U.S. only)

You can submit technical support questions to the appropriate applications engineering team
through e-mail at the Internet addresses listed below. Remember to include your name, address,
and phone number so we can contact you with solutions and suggestions.

GPIB: gpib.support@natinst.com
DAQ: dag.support@natinst.com
VXI: vxi.support@natinst.com

LabWindows: lw.support@natinst.com

Telephone and Fax Support

National Instruments has branch offices all over the world. Use the list below to find the
technical support number for your country. If there is no National Instruments office in your
country, contact the source from which you purchased your software to obtain support.

Australia
Austria
Belgium
Canada (Ontario)
Canada (Quebec)
Denmark
Finland
France
Germany
Hong Kong
Italy

Japan
Korea
Mexico
Netherlands
Norway
Singapore
Spain
Sweden
Switzerland
Taiwan
U.K.

Telephone
03 9 879 9422

0662 4579900
02757 00 20
519 622 9310
514 694 8521
4576 26 00
90 527 2321
148 142424
089 741 31 30
2645 3186

02 48301892
03 5472 2970
02 596 7456
5202 2544
03480 33466
32 84 84 00
2265886

91 640 0085
08 730 49 70
056 20 51 51
02 377 1200
01635 523545

LabVIEW: 1v.support@natinst.com
HiQ: hig.support@natinst.com
VISA: visa.support@natinst.com

Fax

0398799179
0662 45 79 90 19
027570311
519 622 9311
514 694 4399
457671 11
90 502 2930
148 1424 14
089 714 60 35
2686 8505

02 48301915
03 5472 2977
02 596 7455
5520 3282
03480 30673
32 84 86 00
2265887

91 640 0533
08 7304370
056 20 51 55
02 737 4644
01635 523154



Technical Support Form

Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing
this form accurately before contacting National Instruments for technical support helps our
applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name

Company

Address

Fax (__) Phone (__)

Computer brand Model Processor

Operating system (include version number)

Clock speed MHz RAM MB Display adapter
Mouse ___yes ___no Other adapters installed
Hard disk capacity MB Brand

Instruments used

National Instruments hardware product model Revision

Configuration

National Instruments software product Version

Configuration

The problem is:

List any error messages:

The following steps reproduce the problem:




Documentation Comment Form

National Instruments encourages you to comment on the documentation supplied with our
products. This information helps us provide quality products to meet your needs.

Title:  LabVIEW® Data Acquisition Basics Manual
Edition Date:  January 1996
Part Number: 320997A-01

Please comment on the completeness, clarity, and organization of the manual.

If you find errors in the manual, please record the page numbers and describe the errors.

Thank you for your help.

Name

Title

Company

Address

Phone ()

Mail to: Technical Publications Faxto: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678

Austin, TX 78730-5039



Prefix Meaning Value
n- nano- 109
u- micro- 106
m- milli- 103
k- kilo- 103
M- mega- 100

Numbers/Symbols

1D

2D

A

A
AC
A/D

ADC

ADC resolution

Al

AIGND

© National Instruments Corporation

One-dimensional.

Two-dimensional.

amperes.
Alternating current.
Analog-to-digital.

Analog-to-digital converter. An electronic device, often an
integrated circuit, that converts an analog voltage to a digital
number.

The resolution of the ADC, which is measured in bits. An ADC
with 16 bits has a higher resolution, and thus a higher degree of
accuracy than a 12-bit ADC.

Analog input.

The analog input ground pin on a DAQ device.
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Glossary

amplification

AMUX devices

analogin

analog_io.1l1lb

analog input group

analog multiplexer

analogout.llb

analog output group

analog trigger

LabVIEW Data Acquisition Basics Manual

A type of signal conditioning that improves accuracy in the
resulting digitized signal and to reduce noise.

See analog multiplexers.

A LabVIEW DAQ library containing VIs that perform analog
input with DAQ devices and SCXI modules and can write or
stream the acquired data to disk.

A LabVIEW DAQ library containing VIs for analog I/O control
loops.

A collection of analog input channels. You can associate each
group with its own clock rates, trigger and buffer configurations,
and so on. A channel cannot belong to more than one group.

Because each board has one ADC, only one group can be active
at any given time. That is, once a control VI starts a timed
acquisition with group n, subsequent control and read calls must
also refer to group n. You use the task ID to refer to the group.

Devices that increase the number of measurement channels while
still using an single instrumentation amplifier. Also called AMUX
devices.

A LabVIEW DAQ library containing VIs that generate single
values or multiple values (waveforms) to output through analog
channels.

A collection of analog output channels. You can associate each
group with its own clock rates, buffer configurations, and so on.
A channel cannot belong to more than one group.

A trigger that occurs at a user-selected point on an incoming
analog signal. Triggering can be set to occur at a specified level
on either an increasing or a decreasing signal (positive or
negative slope).
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AO

array

BCD

bipolar

buffer

C

cascading

channel

channel clock

circular-buffered I/0

clock

cluster

code width

column-major order

© National Instruments Corporation

Glossary

Analog output.

Ordered, indexed set of data elements of the same type.

Binary-coded decimal.

A signal range that includes both positive and negative values
(for example, -5 to 5 V).

Temporary storage for acquired or generated data.

Process of extending the counting range of a counter chip by
connecting to the next higher counter.

Pin or wire lead to which you apply or from which you read the
analog or digital signal. Analog signals can be single-ended or
differential. For digital signals, you group channels to form ports.
Ports usually consist of either four or eight digital channels.

The clock controlling the time interval between individual
channel sampling within a scan. Boards with simultaneous
sampling do not have this clock.

Input/output operation that reads or writes more data points than
can fit in the buffer. When LabVIEW reaches the end of the
buffer, LabVIEW returns to the beginning of the buffer and
continues to transfer data.

Hardware component that controls timing for reading from or
writing to groups.

A set of ordered, unindexed data elements of any data type
including numeric, Boolean, string, array, or cluster. The
elements must be all controls or all indicators.

The smallest detectable change in an input voltage of a DAQ
device.

A way to organize the data in a 2D array by columns.
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common-mode voltage

conditional retrieval

conversion device

counter.1llb

counter/timer group

coupling

D/A

DAC

dagconf

data acquisition

data flow

default input

LabVIEW Data Acquisition Basics Manual

Any voltage present at the instrumentation amplifier inputs with
respect to amplifier ground.

A method of triggering in which you to simulate an analog trigger
using software. Also called software triggering.

Device that transforms a signal from one form to another. For
example, analog-to-digital converters (ADCs) for analog input,
digital-to-analog converters (DACs) for analog output, digital
input or output ports, and counter/timers are conversion devices.

A LabVIEW DAQ library containing VIs that count the rising
and falling edges of TTL signals, generate TTL pulses, and
measure the frequency and period of TTL signals.

A collection of counter/timer channels. You can use this type of
group for simultaneous operation of multiple counter/timers.

The manner in which a signal is connected from one location to
another.

Digital-to-analog.

Digital-to-analog converter. An electronic device, often an
integrated circuit, that converts a digital number into a
corresponding analog voltage or current.

The NI-DAQ configuration utility on the Sun.

Process of acquiring data, typically from A/D or digital input
plug-in boards.

Programming system consisting of executable nodes in which
nodes execute only when they have received all required input
data and produce output automatically when they have executed.
LabVIEW is a dataflow system.

The default value of a front panel control.
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default setting

device

device number

DIFF

differential measurement

system

digital

digital input group

digital output group

digital trigger

DIP
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A default parameter value recorded in the driver. In many cases,
the default input of a control is a certain value (often 0) that
means use the current default setting. For example, the default
input for a parameter may be do not change current setting, and
the default setting may be no AMUX-64T boards. If you do
change the value of such a parameter, the new value becomes the
new setting. You can set default settings for some parameters in
the configuration utility.

A DAQ device inside your computer or attached directly to your
computer through a parallel port. Plug-in boards, PCMCIA cards,
and devices such as the DAQPad-1200, which connects to your
computer's parallel port, are all examples of DAQ devices. SCXI
modules are distinct from devices, with the exception of the
SCXI-1200, which is a hybrid.

The slot number or board ID number assigned to the board when
you configured it. \

Differential. A differential input is an analog input consisting of
two terminals, both of which are isolated from computer ground
and whose difference you measure.

A way you can configure your device to read signals, in which
you do not need to connect either input to a fixed reference,
such as the earth or a building ground.

A LabVIEW DAQ library containing VIs that perform immediate
digital I/O and digital handshaking with DAQ devices and SCXI
modules .

A collection of digital input ports. You can associate each group
with its own clock rates, handshaking modes, buffer
configurations, and so on. A port cannot belong to more than one

group.

A collection of digital output ports. You can associate each group
with its own clock rates, handshaking modes, buffer
configurations, and so forth. A port cannot belong to more than
one group.

A TTL level signal having two discrete levels—a high and a low
level.

Dual inline package.
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dithering
DLL

DMA

down counter

driver

DSP

E

EEPROM

EISA
event

external trigger

F

FIFO

filtering

floating signal sources
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The addition of Gaussian noise to an analog input signal.
Dynamic link library.

Direct memory access. A method by which data you can transfer
data to computer memory from a device or memory on the bus (or
from computer memory to a device) while the processor does
something else. DMA is the fastest method of transferring data to
or from computer memory.

Performing frequency division on an internal signal.

Software that controls a specific hardware device, such as a data
acquisition board.

Digital signal processing.

Electrically erased programmable read-only memory. Read-only
memory that you can erase with an electrical signal and
reprogram.

Extended Industry Standard Architecture.
The condition or state of an analog or digital signal.

A voltage pulse from an external source that triggers an event
such as A/D conversion.

A first-in-first-out memory buffer. In a FIFO, the first data stored
is the first data sent to the acceptor.

A type of signal conditioning that allows you to filter unwanted
signals from the signal you are trying to measure.

Signal sources with voltage signals that are not connected to an
absolute reference or system ground. Also called nonreferenced
signal sources. Some common example of floating signal sources
are batteries, transformers, or thermocouples.
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G
gain

GATE input pin

grounded measurement system

grounded signal sources

group

handle

handshaked digital I/O

hardware triggering

hex

Hz
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The amplification or attenuation of a signal.

A counter input pin that controls when counting in your
application occurs.

See referenced single-ended measurement system.

Signal sources with voltage signals that are referenced to a
system ground, such as the earth or a building ground. Also called
referenced signal sources

A collection of input or output channels or ports that you define.
Groups can contain analog input, analog output, digital input,
digital output, or counter/timer channels. A group can contain
only one type of channel, however. You use a task ID number to
refer to a group after you create it. You can define up to 16 groups
at one time.

To erase a group, you pass an empty channel array and the group
number to the group configuration VI. You do not need to erase
a group to change its membership. If you reconfigure a group
whose task is active, LabVIEW clears the task and returns a
warning. LabVIEW does not restart the task after you reconfigure
the group.

Pointer to a pointer to a block of memory; handles reference
arrays and strings. An array of strings is a handle to a block of
memory containing handles to strings.

A type of digital acquisition/generation where a device or module
accepts or transfers data after a digital pulse has been received.
Also called latched digital I/0.

A form of triggering where you set the start time of an acquisition
and gather data at a known position in time relative to a trigger
signal.

Hexadecimal.

Hertz. The number of scans read or updates written per second.
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IEEE

immediate digital I/O

input limits

input range

interrupt

interval scanning

I/0
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Institute of Electrical and Electronic Engineers.

A type of digital acquisition/generation where LabVIEW updates
the digital lines or port states immediately or returns the digital
value of an input line. Also called nonlatched digital I/0.

The upper and lower voltage inputs for a channel. You must use
a pair of numbers to express the input limits. The VIs can infer
the input limits from the input range, input polarity, and input
gain(s). Similarly, if you wire the input limits, range, and
polarity, the VIs can infer the onboard gains when you do not use
SCXI.

The difference between the maximum and minimum voltages an
analog input channel can measure at a gain of 1. The input range
is a scalar value, not a pair of numbers. By itself the input range
does not uniquely determine the upper and lower voltage limits.
An input range of 10 V could mean an upper limit of +10 V and
alower of 0 V or an upper limit of +5 V and a lower limit of -5 V.

The combination of input range, polarity, and gain determines the
input limits of an analog input channel. For some boards, jumpers
set the input range and polarity, while you can program them for
other boards. Most boards have programmable gains. When you
use SCXI modules, you also need their gains to determine the
input limits.

A signal indicating that the central processing unit should
suspend its current task to service a designated activity.

Scanning method where there is a longer interval between scans
than there is between individual channels comprising a scan.

Input/output. The transfer of data to or from a computer system
involving communications channels, operator interface devices,
and/or data acquisition and control interfaces.
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ISA

isolation

K

Kwords

L

LabVIEW

latched digital I/0O

limit settings

linearization

LSB

MB
memory buffer

multibuffered I/0
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Glossary

Industry Standard Architecture.

A type of signal conditioning in which you isolate the transducer
signals from the computer for safety purposes. This protects you
and your computer from large voltage spikes and makes sure the
measurements from the DAQ device are not affected by
differences in ground potentials.

1,024 words of memory.

Laboratory Virtual Instrument Engineering Workbench.

A type of digital acquisition/generation where a device or module
accepts or transfers data after a digital pulse has been received.
Also called handshaked digital 1/0.

The maximum and minimum voltages of the analog signals you
are measuring or generating.

A type of signal conditioning in which LabVIEW linearizes the
voltage levels from transducers, so the voltages can be scaled to
measure physical phenomena.

Least significant bit.

megabytes of memory.
See buffer.

Input operation for which you allocate more than one memory
buffer so you can read and process data from one buffer while the
acquisition fills another.
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multiplexed mode

multiplexer

NB
NI-DAQ

NI-PNP.EXE

NI-PNP.INI

nodes

nonlatched digital I/O

non-referenced signal sources

NRSE

Non-referenced single-ended
(NRSE) measurement system

LabVIEW Data Acquisition Basics Manual

An SCXI operating mode in which analog input channels are
multiplexed into one module output so that your cabled DAQ
device has access to the module’s multiplexed output as well as
the outputs on all other multiplexed modules in the chassis
through the SCXI bus. Also called serial mode.

A set of semiconductor or electromechanical switches with a
common output that can select one of a number of input signals
and that you commonly use to increase the number of signals
measured by one ADC.

NuBus.
The NI-DAQ configuration utility on the Macintosh.

A stand-alone executable that NI-DAQ installs in your NI-DAQ
root drive that detects and configures any Plug and Play devices
you have in your computer.

A file, generated by the NI-PNP . EXE, that contains information
about all the National Instruments devices in your computer,
including Plug and Play devices.

Execution elements of a block diagram consisting of functions,
structures, and subVIs.

A type of digital acquisition/generation where LabVIEW updates
the digital lines or port states immediately or returns the digital
value of an input line. Also called immediate digital I/0.

Signal sources with voltage signals that are not connected to an
absolute reference or system ground. Also called floating signal
sources. Some common example of non-referenced signal
sources are batteries, transformers, or thermocouples.

Nonreferenced single-ended.

All measurements are made with respect to a common
reference, but the voltage at this reference can vary with respect
to the measurement system ground.
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0

onboard channels

OUT output pin

output limits

P

parallel mode

pattern generation

PGIA

Plug and Play devices

postriggering

pretriggering

pulse trains

pulsed output
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Glossary

Channels provided by the plug-in data acquisition board.

A counter output pin where the counter can generate various TTL
pulse waveforms.

The upper and lower voltage or current outputs for an analog
output channel. The output limits determine the polarity and
voltage reference settings for a board.

A type of SCXI operating mode in which the module sends each
of its input channels directly to a separate analog input channel of
the device to the module.

A type of handshaked (latched) digital I/O in which internal
counters generate the handshaked signal, which in turn initiates a
digital transfer. Because counters output digital pulses at a
constant rate, this means you can generate and retrieve patterns at
a constant rate because the handshaked signal is produced at a
constant rate.

Programmable gain instrumentation amplifier.

Devices that do not require dip switches or jumpers to configure
resources on the devices—also called switchless devices.

The technique you use on a data acquisition board to acquire a
programmed number of samples after trigger conditions are met.

The technique you use on a data acquisition board to keep a
continuous buffer filled with data, so that when the trigger
conditions are met, the sample includes the data leading up to the
trigger condition.

Multiple pulses.

A form of counter signal generation by which a pulse is outputted
when a counter reaches a certain value.
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R

read mark

read mode

referenced signal sources

Points to the scan at which a read operation begins. Analogous to
a file I/O pointer, the read mark moves every time you read data
from an input buffer. After the read is finished, the read mark
points to the next unread scan. Because multiple buffers are
possible, you need both the buffer number and the scan number
to express the position of the read mark.

Indicates one of the four reference marks within an input buffer
that provides the reference point for the read. This reference can
be the read mark, the beginning of the buffer, the most recently
acquired data, or the trigger position.

Signal sources with voltage signals that are referenced to a
system ground, such as the earth or a building ground. Also called
grounded signal sources.

referenced single-ended (RSE) All measurements are made with respect to a common reference

measurement system
RMS

row-major order
RSE

RTD

RTSI

run_me.llb

LabVIEW Data Acquisition Basics Manual

or a ground. Also called a grounded measurement system.
Root mean square.

A way to organize the data in a 2D array by rows.
Referenced single-ended.

Resistance temperature detector. A temperature-sensing device
whose resistance increases with increases in temperature.

Real-Time System Integration bus. The National Instruments
timing bus that interconnects data acquisition boards directly, by
means of connectors on top of the boards, for precise
synchronization of functions.

A LabVIEW DAQ VI library containing VIs that perform basic
operations concerning analog I/O, digital I/O, and counters.
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S

sample

sample counter

scan

scan clock

scan rate

scan width

SCXI

S€C

settling time

signal conditioning

signal divider
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Glossary

A single (one and only one) analog or digital input or output data
point.

The clock that counts the output of the channel clock, in other
words, the number of samples taken. On boards with
simultaneous sampling, this counter counts the output of the scan
clock and hence the number of scans.

One or more analog or digital input samples. Typically, the
number of input samples in a scan is equal to the number of
channels n the input group. For example, one pulse from the scan
clock produces one scan which acquires one new sample from
every analog input channel in the group.

The clock controlling the time interval between scans. On boards
with interval scanning support (for example, the AT-MIO-16F-
5), this clock gates the channel clock on and off. On boards with
simultaneous sampling (for example, the EISA-A2000), this
clock clocks the track-and-hold circuitry.

The number of times (or scans) per second that LabVIEW
acquires data from channels. For example, at a scan rate of 10Hz,
LabVIEW samples each channel in a group 10 times per second.

The number of channels in the channel list or number of ports in
the port list you use to configure an analog or digital input group.

Signal Conditioning eXtensions for Instrumentation. The
National Instruments product line for conditional low-level
signals within an external chassis near sensors, so only high-level
signals in a noisy environment are sent to data acquisition boards.

Seconds.

The amount of time required for a voltage to reach its final value
within specified limits.

The manipulation of signals to prepare them for digitizing.

Performing frequency division on an external signal.
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simple-buffered I/O

single-ended inputs

software trigger

software triggering

SOURCE input pin

STC

strain gauge

subVI

switchless device

syntax
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Input/output operation that uses a single memory buffer big
enough for all of your data. LabVIEW transfers data into or out
of this buffer at the specified rate, beginning at the start of the
buffer and stopping at the end of the buffer. You use simple
buffered I/O when you acquire small amounts of data relative to
memory constraints.

Analog inputs that you measure with respect to a common
ground.

A programmed event that triggers an event such as data
acquisition.

A method of triggering in which you to simulate an analog trigger
using software. Also called conditional retrieval.

An counter input pin where the counter counts the signal
transitions.

System timing controller.

A thin conductor, which is attached to a material, that detects
stress or vibrations in that material.

VI used in the block diagram of another VI; comparable to a
subroutine.

Devices that do not require dip switches or jumpers to configure
resources on the devices—also called Plug and Play devices.

The set of rules to which statements must conform in a particular
programming language.
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T

task

task ID

TC

toggled output

© National Instruments Corporation

Glossary

A timed I/O operation using a particular group. See task ID.

A number generated by LabVIEW, which encodes the device
number and group number after you configure a group. You use
the group configuration VIs in each function group to create the
task ID, which you use when you run other VIs to specify the
boards or channels on which the VIs operate. For example, the
task ID in hex for an analog input task that uses group 2 and
device 3 is 01020003. The following table shows how the
configuration VIs encode the bits of the task ID.

Bits Purpose

31 through 28 Reserved
27 through 24 Function code

23 through 20 Reserved
19 through 16 Group number
15 through 0 Device number

The following table gives the function code definitions.

Function Code I/O Operation
1 analog input
2 analog output
3 digital port I/O
4 digital group I/O
5 counter/timer I/O

Terminal count. The highest value of a counter.

A form of counter signal generation by which the output changes
the state of the output signal from high to low, or low to high
when the counter reaches a certain value.
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top-level VI

track-and-hold

transducer excitation

trigger

U

unipolar

update

update rate

update width

VDC

VI

Vref
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VI at the top of the VI hierarchy. This term is used to distinguish
the VI from its subVls.

A circuit that tracks an analog voltage and holds the value on
command.

A type of signal conditioning that uses external voltages and
currents to excite the circuitry of a signal conditioning system
into measuring physical phenomena.

Any event that causes or starts some form of data capture.

A signal range that is either always positive or negative, but never
both (for example 0 to 10 V, not -10 to 10 V).

One or more analog or digital output samples. Typically, the
number of output samples in an update is equal to the number of
channels in the output group. For example, one pulse from the
update clock produces one update which sends one new sample
to every analog output channel in the group.

The number of output updates per second.

The number of channels in the channel list or number of ports in
the port list you use to configure an analog or digital output

group.

volts.
Volts, direct current.

Virtual instrument. A LabVIEW program; so called because it
models the appearance and function of a physical instrument.

Voltage reference.
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W

waveform
WDAQCONF . EXE
wire

write mark

© National Instruments Corporation

Glossary

Multiple voltage readings taken at a specific sampling rate.
The NI-DAQ configuration utility in Windows.
Data path between nodes.

Points to the update at which a write operation begins. Analogous
to a file I/O pointer, the write mark moves every time you write
data into an output buffer. After the write is finished, the write
mark points to the next update to be written. Because multiple
buffers are possible, you need both the buffer number and the
update number to express the position of the write mark.
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A

ACK (Acknowledge) line, 15-2
ACK (Acknowledge Input) line, 15-2
Acquire & Proc N Scans-Trig example VI,
8-6, 8-10
Acquire & Process N Scans VI, 7-11
Acquire and Average VI, 19-6 to 19-7
Acquire N-multi-ATrig example VI, 8-10
Acquire N-multi-DTrig example VI, 8-6
Acquire N-multi-Start example VI, 7-7
Acquire N Scans-ATrig example VI, 8-7 to
8-8, 8-10, 8-12 to 8-13
Acquire N Scans-DTrig example VI, 8-3 to
8-4, 8-6
Acquire N Scans example VI, 7-6
Acquire N Scans-SWTrig example VI, 8-13
acquisition rate. See external control of
acquisition rate.
ADC
limit settings effects (figure), 5-6
measurement precision for various device
ranges and limit settings (table), 5-8
range effects (figure), 5-5
resolution, 5-3 to 5-4
effects on precision (figure), 5-4
adjacent counters for counter chips (table),
25-2 to 25-3
Advanced VlIs. See also Vls.
analog output SCXI example, 19-14
to 19-15
external control of channel clock, 9-4
non-buffered handshaking, 15-5
overview, 3-6
simple buffered handshaking, 15-7 to 15-9
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Al Acquire Waveform VI
simple-buffered analog input with
multiple starts, 7-7 to 7-9
single-waveform acquisition, 7-2 to 7-3
Al Acquire Waveforms VI
multiple-waveform acquisition, 7-3
simple-buffered analog input with
graphing, 7-6 to 7-7
Al Clear VI
continuous acquisition from multiple
channels, 7-12 to 7-13
hardware-timed analog 1/O control
loops, 6-9
multiple-waveform acquisition, 7-5
SCXI temperature measurement, 19-6
to 19-7
simple-buffered analog input with
multiple starts, 7-7 to 7-9
Al Clock Config VI
external control of channel clock, 9-4
external conversion pulses, 9-4
scan clock control, 9-6 to 9-7
Al Config VI
basic circular-buffered analog input,
7-13to 7-14
basic non-buffered application, 6-4
hardware-timed analog 1/O control
loops, 6-8
interchannel delay, 9-2
multiple-channel single-point analog
input, 6-5
multiple-waveform acquisition, 7-5
one-point calibration, 20-5
simple-buffered analog input with
multiple starts, 7-7 to 7-9
Al Continuous Scan VI, 7-11 to 7-12
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Al Read One Scan VI, 6-7
Al Read VI
advantages and disadvantages of reading
backlog, A-1
basic circular-buffered analog input, 7-13
to 7-14
conditional retrieval cluster, 8-11 to 8-12
continuous acquisition from multiple
channels, 7-12 to 7-13
controlling startup times (note), 7-8
multiple-waveform acquisition, 7-5
one-point calibration, 20-5
scan clock control, 9-7
SCXI temperature measurement, 19-6
to 19-7
simple-buffered analog input with
multiple starts, 7-7 to 7-9
Al Sample Channel VI
multiple-channel single-point analog
input, 6-3
single-channel single-point analog input,
6-1to 6-2
Al Single Scan VI
basic non-buffered application, 6-4
hardware-timed analog I/O control loops,
6-8 to 6-9
improving control loop performance, 6-9
to 6-10
multiple-channel single-point analog
input, 6-4
one-point calibration, 20-5
software-timed analog 1/O control
loops, 6-6
Al Start VI
basic circular-buffered analog input, 7-13
to 7-14
continuous acquisition from multiple
channels, 7-12 to 7-13
hardware-timed analog 1/O control
loops, 6-9
multiple-waveform acquisition, 7-5
one-point calibration, 20-5
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scan clock control, 9-6 to 9-7
SCXI temperature measurement, 19-6
to 19-7
simple-buffered analog input with
multiple starts, 7-7 to 7-9
Al Waveform Scan VI
analog triggering examples, 8-7 to 8-8
conditional retrieval examples, 8-12
to 8-14
multiple-waveform acquisition, 7-4
amplification
increasing signal-to-noise ratio
(figure), 16-4
methods for minimizing noise
(note), 16-4
amplifier offset, reading, 19-4 to 19-5
AMUX-64T devices
addressing with MIO boards, A-1
analog input channel range (figure), 5-13
channel addressing with AMUX-64T,
5-12to 5-13
scanning order for DAQ devices, 5-13
to 5-17
four AMUX-64Ts (table), 5-16
one or two AMUX-64Ts
(table), 5-15
specifying number for AMUX-64T
device (table), 5-17
analog input
AMUX-64T external multiplexer
device, 5-12 to 5-17
analog input/output control loops. See
analog input/output control loops.
channel clock control, 9-3 to 9-5, 9-8
circular-buffered analog input examples,
7-13 to 7-15
continuous acquisition from multiple
channels, 7-11 to 7-13
defining signals, 5-1 to 5-3
digital triggering, 8-2 to 8-6
external control of acquisition rate, 9-1
to 9-3
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hardware triggering, 8-1 to 8-10
measurement systems, 5-3 to 5-6
memory allocation errors (Windows), A-3
to A-4
multiple-channel single point analog
input, 6-2 to 6-5
multiple waveform acquisition, 7-3 to 7-5
scan clock control, 9-5 to 9-8
SCXI application for measuring
temperature (example), 19-2 to 19-5
selecting input settings, 5-6 to 5-12
calculating code width, 5-6 to 5-7
considerations for selecting, 5-6
to 5-12
differential measurement system, 5-9
to 5-10
measurement precision for various
device ranges and limit settings
(table), 5-8
nonreferenced single-ended
measurement system, 5-11 to 5-12
referenced single-ended
measurement system, 5-10 to 5-11
signals. See analog input signals.
single-buffered analog input examples,
7-6to 7-10
single-channel single point analog input,
6-1 to 6- to 6-2
single waveform acquisition, 7-2 to 7-3
software triggering, 8-10 to 8-14
terminology, 5-17 to 5-18
triggering, 8-6 to 8-10

analog input/output control loops, 6-6 to 6-10

hardware-timed control loops, 6-7 to 6-9
improving performance, 6-9 to 6-10
overview, 6-6

software-timed control loops, 6-6 to 6-7

analog input SCXI modules

multiplexed mode, 17-4
parallel mode, 17-5
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Index

analog input signals
choosing a measurement system, 5-3
to 5-6
choosing between analog and digital
signals, 4-3
defining signals, 5-1 to 5-2
device voltage range, 5-4 to 5-5
floating signal sources, 5-3
grounded signal sources, 5-2
referenced and non-referenced, 5-2
resolution of ADC, 5-3 to 5-4
signal voltage range (limit settings), 5-5
to 5-6
types of analog signals (figure), 5-1
analog input with LabVIEW. See
AMUX-64T devices.
Analog IO Control Loop VI, 6-6 to 6-7
Analog IO Control Loop (hw timed) VI, 6-8
analog multiplexers (AMUX), 5-9. See also
AMUX-64T devices.
analog output
buffered analog output
overview, 10-1 to 10-2
waveform generation, 12-1 to 12-3
circular-buffered output, 12-3 to 12-5
multiple-immediate updates, 11-2
to 11-3
SCXI analog output application
example, 19-14 to 19-15
single-immediate updates, 11-1 to 11-2
single-point output, 10-1
analog output SCXI modules, 17-4
analog-to-digital converter (ADC). See ADC.
analog triggering
description, 8-6 to 8-7
examples, 8-7 to §-10
anlogin DAQ example file, 3-1
anlog_io.llb DAQ example file, 3-1
anlogout.llb DAQ example file, 3-2
AO Clear VI
circular-buffered output, 12-4 to 12-5
waveform generation, 12-3

LabVIEW Data Acquisition Basics Manual



Index

AO Config VI
analog output SCXI example, 19-14
circular-buffered output, 12-4 to 12-5
waveform generation, 12-3

AO Continuous Gen VI, 12-3 to 12-4

AO Generate Waveforms VI, 12-1 to 12-2

AO Group Config VI, 19-14

AO Hardware Config VI, 19-14

AO Single Update VI
analog output SCXI example, 19-15
calibrating SCXI modules for signal

generation, 20-8

AO Start VI
circular-buffered output, 12-4 to 12-5
waveform generation, 12-3

AO Update Channels VI, 11-1

AO Wait VI, 12-3

AO Waveform Gen VI, 12-2

AO Write One Update VI, 6-7
multiple-immediate updates, 11-2 to 11-3
single-immediate updates, 11-1to 11-2

AO Write VI
circular-buffered output, 12-4 to 12-5
waveform generation, 12-3

arrays
transposing, 7-7
two-dimensional (2D) arrays, 3-13 to 3-16

AUTOEXEC.BAT file, 2-10

base address switch settings (note), 2-5
breakpoints, setting, 27-4
buffered analog input, 7-1 to 7-15
buffer overflow problems with Macintosh
systems, A-5
circular-buffered analog input
continuous acquisition from multiple
channels, 7-11 to 7-13
determining adequate buffer
capacity, A-1
examples
basic circular-buffered analog
input, 7-13 to 7-14
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Cont Acq to File
(scaled).vi, 7-15
Cont Acq to Spreadsheet
File.vi, 7-15
Cont Acq&Chart
(buffered).vi, 7-14
Cont Acq&Graph
(buffered).vi, 7-15
overview, 7-10 to 7-11
how buffers work, 7-2
simple-buffered analog input
data buffer overview, 7-1 to 7-2
examples
displaying waveforms on
graphs, 7-6 to 7-7
sampling with multiple starts,
7-7t0 7-9
writing to spreadsheet file, 77-9
multiple-waveform acquisition, 7-3
to 7-5
single-waveform acquisition, 7-2
to 7-3
waiting to analyze data, 7-1 to 7-2
buffered analog output
choosing between single-point or
multiple-point generation, 4-4
circular-buffered output, 12-3 to 12-5
eliminating errors, 12-5
overview, 10-1 to 10-2
waveform generation, 12-1 to 12-3
buffered handshaking, 15-6 to 15-10
circular buffered examples, 15-9
to 15-10
simple buffered examples, 15-7 to 15-9
bulletin board support, B-1

C

calibration. See SCXI calibration.
cascading counters, 24-3, 25-2
channel addressing
AMUX-64T devices, 5-12 to 5-13
SCXI modules, 18-1 to 18-2
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VI channel, port, and counter addressing,
3-9to 3-11
channel clock, 9-3 to 9-5
channel and scan intervals using channel
clock (figure), 9-2
considerations for specific boards
(notes), 9-5
controlling externally, 9-3 to 9-5
rate parameter, 5-17
setting channel clock rate, 9-3
simultaneous control of scan and channel
clocks, 9-8
TTL signal (example), 9-3
circular-buffered analog input
continuous acquisition from multiple
channels, 7-11 to 7-13
examples
basic circular-buffered analog input,
7-13 to 7-14
Cont Acq to File (scaled).vi, 7-15
Cont Acq to Spreadsheet File.vi, 7-15
Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-15
how circular buffers work (figure), 7-10
overview, 7-10 to 7-11
circular-buffered analog output
changing waveform during generation,
12-3to 12-5
eliminating errors, 12-5
circular buffered digital I/O examples, 15-9
to 15-10
code width, calculating, 5-6 to 5-7
cold junction compensation, 19-3 to 19-4
column major order, 3-14 to 3-16
common-mode voltage
definition, 5-10
illustration, 5-10
common questions about LabVIEW data
acquisition, A-1 to A-5
conditional retrieval, 8-10. See also software
triggering.
configuration. See installation and
configuration.
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Index

Cont Acq to File (scaled).vi, 7-15
Cont Acq to Spreadsheet File.vi, 7-15
Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-15
Cont Acquire&Chart (immediate).vi, 6-4
to 6-5
continuous acquisition from multiple
channels, 7-11 to 7-13
Continuous Generation example VI, 12-4
Continuous Pulse Generator Config VI,
22-6,22-8
control loops. See analog input/output control
loops.
Convert RTD Reading VI, 19-10 to 19-11
Convert Strain Gauge Reading VI, 19-13
to 19-14
Convert Thermocouple Reading VI, 19-6
to 19-7
Count Events or Time VI, 25-3 to 25-5
counter addressing for VIs, 3-9 to 3-11
Counter Read VI, 25-6 to 25-7
controlling pulse width
measurement, 23-3
measuring frequency and period
high frequency signals, 24-6
low frequency signals, 24-4 to 24-5
Counter Start VI, 25-6 to 25-7
controlling pulse width
measurement, 23-3
dividing frequencies, 26-1 to 26-2
finite pulse train generation, 22-8
measuring frequency and period
high frequency signals, 24-6
low frequency signals, 24-4 to 24-5
single square pulse generation, 22-4
Counter Stop VI
controlling pulse width
measurement, 23-3
counting external events, 25-6 to 25-7
dividing frequencies, 26-1 to 26-2
measuring frequency and period
high frequency signals, 24-6
low frequency signals, 24-4 to 24-5
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stopping counter generations, 22-9
counter.llb DAQ example file, 3-2
counters
accuracy of counters, 22-8 to 22-9
basic functions, 21-1 to 21-4
capabilities, 21-1
choosing between counting methods, 4-5
choosing between digital or counter
interfacing, 4-3 to 4-4
counter chips used in National
Instruments devices, 21-4
counting signal highs and lows, 25-1
to 25-3
dividing frequencies, 26-2 to 26-3
events or elapsed time counting, 25-1
to 25-5
frequency and period measurement, 24-1
to 24-7
connecting counters for measuring,
24-2 to 24-3
high frequency signals, 24-5 to 24-7
how and when to measure, 24-1
to 24-2
low frequency signals, 24-4 to 24-5
gaining more control over counting
operations, 25-6 to 25-7
gating levels (figure), 21-3
pulse train generation, 22-5 to 22-8
continuous pulse train, 22-5 to 22-7
finite pulse train, 22-7 to 22-8
pulse width measurement, 23-1 to 23-4
controlling pulse width
measurement, 23-3
determining pulse width, 23-2 to 23-3
increasing measurable width
range, 23-4
square pulse generation, 22-1 to 22-5
single square pulse generation, 22-3
to 22-5
square wave generation with no counters
available, 21-5
stopping counter generations, 22-9
to 22-30
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timebase uncertainty, 22-8 to 22-9
CTR Control VI

enabling and disabling FOUT

signal, 21-5

measuring frequency and period, 24-6
CTR Mode Config VI, 21-3
current setting for VIs, 3-7
current value conventions for VIs, 3-7
customer communication, xxi, B-1 to B-2

D

daisy chaining SCXI chassis, 19-18 to 19-19
DAQ examples
list of example files, 3-1 to 3-2
locations, 3-1 to 3-2
DAQ hardware. See hardware.
DAQ VIs. See VIs.
daqgconf utility (UNIX), 2-19 to 2-20
daqgconf.cfg file, 2-20
data acquisition. See also analog input.
analog input/output control loops, 6-6
to 6-10
basic LabVIEW data acquisition
concepts, 3-1 to 3-16. See also VlIs.
data organization for analog
applications, 3-13 to 3-16
limit settings, 3-11 to 3-13
location of common DAQ
examples, 3-1 to 3-2
buffered. See buffered analog input.
common questions about LabVIEW data
acquisition, A-1 to A-5
important terms, 5-17
multiple-channel single-point, 6-2 to 6-5
single-channel single-point, 6-1 to 6-2
triggered. See triggered data acquisition.
data acquisition hardware. See hardware.
Data Acquisition palette, 3-4
data organization for analog applications,
3-13to 3-16
column major order, 3-14 to 3-16
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row major order, 3-14
two-dimensional (2D) arrays, 3-13 to 3-16
data types for LabVIEW, xx
debugging VlIs, 27-1 to 27-4
error handling, 27-2 to 27-3
execution highlighting, 27-3 to 27-4
hardware connection errors, 27-1
setting breakpoints and showing advanced
DAQ VIs, 27-4
single-stepping through VIs, 27-3
software configuration errors, 27-1
to 27-2
using Probe tool, 27-4
VI construction errors, 27-2 to 27-4
default input for VIs, 3-7
default setting for VIs, 3-7
Delayed Pulse Generator Config VI
finite pulse train generation, 22-8
measuring frequency and period, 24-6
single square pulse generation, 22-4
delays for improving control loop
performance, 6-9 to 6-10
device voltage range, 5-4 to 5-5
considerations for selecting analog input
settings, 5-6 to 5-8
description, 5-4 to 5-5
effect on ADC precision (figure), 5-5
measurement precision for various device
ranges and limit settings (table), 5-8
differential measurement system, 5-9 to 5-10
channel differential system (figure), 5-9
common mode voltage (figure), 5-10
when to use, 5-10
digital and relay SCXI modules, 17-5
Digital Buffered Handshaking VI, 15-7
Digital Clock Config VI, 15-7 to 15-8
digital DAQ example file, 3-2
digital I/O
buffered handshaking, 15-6 to 15-10
choosing between digital or counter
interfacing, 4-3 to 4-4
choosing between non-latched or latched
digital I/O, 4-5
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handshaking (latched) digital I/O, 15-1
to 15-2
immediate (non-latched) digital I/O,
14-1to 14-3
non-buffered handshaking, 15-5 to 15-6
overview, 13-1 to 13-2
SCXI application examples
digital input, 19-15 to 19-16
digital output, 19-16 to 19-18
sending out multiple digital values, 15-2
to 15-5
Digital Mode Config VI, 15-8
digital ports and lines, 13-1
digital SCXI modules, 17-6
digital triggering
definition, 8-2
description, 8-2 to 8-3
examples, 8-3 to 8-6
DIO Buffer Control VI, 15-7 to 15-9
DIO Clear VI, 15-7
DIO Config VI, 15-8
DIO Group Config VI, 15-5
DIO Port Config VI
digital input application example, 19-16
immediate digital I/O, 14-2
DIO Single Read/Write VI, 15-5 to 15-6
DIO Start VI, 15-7 to 15-8
DIO Wait VI, 15-7
Divide Config VI, 26-1 to 26-2
dividing frequencies. See frequency division.
DMA jumper settings (note), 2-5
documentation
conventions used in manual, xviii-xx
flowchart for finding information, 4-2
how to use this book, 1-1 to 1-3
organization of manual, xvii-xviii
related documentation, xxi
down counter, 26-1
Down Counter VI, 26-1 to 26-2
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E

e-mail support, B-2
Easy VIs. See also Vls.
addressing OUT and IN pins on DIO-32F
board, A-2
continuous pulse train generation, 22-6
counting events or elapsed time, 25-3
to 25-5
digital input application, 19-15
digital output application, 19-16 to 19-18
finite pulse train generation, 22-7
grouping two or more ports, A-2
immediate digital I/O, 14-1 to 14-2
limitations, 6-3
measuring frequency and period
high frequency signals, 24-5 to 24-6
low frequency signals, 24-4
multiple-channel single-point analog
input, 6-3
multiple-immediate updates, 11-2 to 11-3
multiple-waveform acquisition, 7-3
overview, 3-5
single-channel single-point analog input,
6-1to 6-2
single-immediate updates, 11-1to 11-2
single square pulse generation, 22-4
single-waveform acquisition, 7-2 to 7-3
strain gauge application, 19-13
waveform generation, 12-1 to 12-2
edges of signals, 21-2
EEPROM for storing calibration constants,
20-1 to 20-3
default load area, 20-2
factory area, 20-2
user area, 20-2 to 20-3
elapsed time counting. See events or elapsed
time counting.
electronic support services, B-1 to B-2
Error Handler Vs, 27-2
error handling
debugging VIs, 27-2 to 27-3
VlIs, 3-8 to 3-9
Event or Time Counter Config VI
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counting external events, 25-6 to 25-7
measuring frequency and period, 24-6
events or elapsed time counting, 25-1 to 25-5
adjacent counters for counter chips
(table), 25-2 to 25-3
cascading counters, 25-2
connecting counters to device
(figure), 25-1
counting events or elapsed time, 25-3
to 25-5
gaining more control over counting
operations, 25-6 to 25-7
overview, 25-1 to 25-3
execution highlighting, 27-3 to 27-4
external control of acquisition rate, 9-1 to 9-8
channel and scan intervals using channel
clock (figure), 9-2
channel clock control, 9-3 to 9-5
choosing between triggering and
external clock control, 4-4
description, 9-1 to 9-3
round-robin scanning (figure), 9-2
scan clock control, 9-5 to 9-8
simultaneous control of scan and
channel clocks, 9-8
external conversion pulses, 9-4 to 9-5

F

faxback support, B-2
filtering, 16-5
floating signal sources, 5-3
FOUT output, 21-5, 23-4
FREQ_OUT output, 21-5, 23-4
frequency and period measurement, 24-1
to 24-7
cascading counters, 24-3
connecting counters for measuring, 24-2
to 24-3
equation for obtaining
measurements, 24-2
high frequency signals, 24-5 to 24-7
how and when to measure, 24-1 to 24-2
low frequency signals, 24-4 to 24-5
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physical connections for period
measurement
high frequency signals (figure), 24-3
low frequency signals (figure), 24-3
square wave period measurement
(figure), 24-2
frequency division, 26-1 to 26-3
FTP support, B-1
Function Generator VI, 12-5
Functions palette
illustration, 3-3
locating VlIs, 3-2 to 3-4

G

gain, definition, 3-13
gains (SCXI)
description, 18-2 to 18-4
SCXI-1100 channel arrays, input limits
array, and gains (table), 18-4
GATE input, 21-2 to 21-3
gating levels (figure), 21-3
GATE input pin, 21-2
General Error Handler VI, 27-2 to 27-3
Generate Continuous Sinewave VI, 12-3
Generate Delayed Pulse VI
single square pulse generation, 22-4
stopping counter generations, 22-9
Generate N Updates example VI, 12-2
Generate Pulse Train VI
continuous pulse train generation, 22-6
finite pulse train generation, 22-7 to 22-8
stopping counter generations, 22-9
to 22-10
Get DAQ Device Information VI, 2-1
Getting Started Analog Input example VI
channel clock control, 9-3 to 9-4
reading amplifier offset, 19-4 to 19-5
reading channels from different SCXI
chassis, 19-19
scan clock control, 9-6 to 9-7
temperature sensor, 19-3
Getting Started Counters VI, 25-3
Getting Started Digital I/O VI, 14-1 to 14-2
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graphing simple-buffered analog input
(example), 7-6 to 7-7
grounded signal sources, 5-2

H

handshaking (latched) digital I/O, 15-1
to 15-10
buffered handshaking, 15-6 to 15-10
circular buffered examples, 15-9
to 15-10
simple buffered examples, 15-7
to 15-9
connecting signal lines
digital input (figure), 15-3
digital output (figure), 15-4
DAQ devices supporting digital
handshaking, 15-1
grouping ports for DIO-32F devices
(note), 15-4
non-buffered handshaking, 15-5 to 15-6
overview, 15-1 to 15-2
sending out multiple digital values, 15-2
to 15-5
hardware. See also installation and
configuration.
debugging connection errors, 27-1
LabVIEW data acquisition hardware
support
Macintosh systems (table), 2-5
Windows environment (table), 2-4
relationship between LabVIEW,
NI-DAQ, and DAQ hardware
(figure), 2-3
hardware-timed analog input/output control
loops, 6-7 to 6-9
hardware triggering, 8-1 to 8-10
analog
description, 8-6 to 8-7
examples, 8-7 to §-10
digital
description, 8-2 to 8-3
examples, 8-3 to 8-6
overview, 8-1
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How to Count VI, 25-3
How to Generate Pulses and Pulse Trains VI
dividing frequencies, 26-1
generating pulse train, 22-5 to 22-6
generating single square pulse, 22-3
How to Measure Frequency and period
VI, 24-3

IBF (Input Buffer Full) line, 15-2
immediate digital I/O, 14-1 to 14-3
immediate updates
multiple, 11-2 to 11-3
single, 11-1 to 11-2
initialization of data acquisition boards, A-3
Input Buffer Full (IBF) line, 15-2
input range, and input setting selection, 5-6
to 5-8
installation and configuration
debugging software configuration errors,
27-1t027-2
installing and configuring DAQ devices
(figure), 2-2
LabVIEW data acquisition hardware
support
Macintosh systems (table), 2-5
Windows environment (table), 2-4
Macintosh systems, 2-16 to 2-18
National Instruments devices, 2-5
relationship between LabVIEW,
NI-DAQ, and DAQ hardware
(figure), 2-3
SCXI chassis
hardware configuration, 2-20 to 2-21
software configuration
Macintosh systems, 2-25 to 2-27
Windows environment, 2-21
to 2-25
UNIX operating systems, 2-18 to 2-20
Windows environment
changing I/O page lock limit, 2-14
to 2-15
EISA bus computers, 2-9
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inserting PCMCIA cards (note), 2-5
ISA and PCMCIA bus computers,
2-6 to 2-9
LabVIEW for Windows NT, 2-14
to 2-15
multiple DAQ devices (note), 2-5
Plug and Play (switchless) DAQ
devices, 2-10
Plug and Play software, 2-10 to 2-11
user privilege level, 2-15
WDAQCONEF utility, 2-11 to 2-14
Intermediate VIs. See also VIs.
advantages, 6-4 to 6-5
circular-buffered output, 12-3 to 12-5
continuous acquisition from multiple
channels, 7-11 to 7-13
continuous pulse train generation, 22-6
to 22-7
controlling pulse width
measurement, 23-3
counting events or elapsed time, 25-6
to 25-7
dividing frequencies, 26-1 to 26-2
finite pulse train generation, 22-7 to 22-8
measuring frequency and period
high frequency signals, 24-6
low frequency signals, 24-4 to 24-5
multiple-channel single-point analog
input, 6-3
multiple-waveform acquisition, 7-4
to 7-5
non-buffered handshaking, 15-5 to 15-6
overview, 3-5 to 3-6
SCXI temperature measurement
examples, 19-6 to 19-9
simple buffered handshaking, 15-7
single-immediate updates, 11-1 to 11-2
single square pulse generation, 22-4
to 22-5
strain gauge application, 19-13
waveform generation, 12-2 to 12-3
interval scanning, 5-17
I/0 page lock limit, changing, 2-14 to 2-15

© National Instruments Corporation



IRQ jumper settings (note), 2-5
ISA bus computers, configuring, 2-6 to 2-9
isolation of transducer signals, 16-4

J

jumper settings, 2-5, 2-13

L

LabVIEW software
basic LABVIEW data acquisition
concepts, 3-1 to 3-16. See also Vls.
data organization for analog
applications, 3-13 to 3-16
location of common DAQ examples,
3-1to0 3-2
common questions about LabVIEW, A-1
to A-5
data acquisition hardware support
Macintosh systems (table), 2-5
Windows environment (table), 2-4
data types, xx
relationship between LabVIEW,
NI-DAQ, and DAQ hardware
(figure), 2-3

Windows NT considerations, 2-14 to 2-15

changing I/O page lock limit, 2-14
to 2-15
user privilege level, 2-15
latched digital I/O. See handshaking (latched)
digital I/O.
limit settings, 5-5 to 5-6
considerations for selecting analog input
settings, 5-6 to 5-8
description, 5-5 to 5-6
effect on ADC precision (figure), 5-6

measurement precision for various device

ranges and limit settings (table), 5-8
SCXI gains, 18-2 to 18-4
VI limit settings, 3-11 to 3-13
linearizing voltage levels, 16-5
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Macintosh systems
configuring DAQ devices, 2-16 to 2-18
NI-DAQ drivers, 2-3
questions and answers, A-5
SCXI chassis
hardware configuration, 2-20
to 2-21
software configuration, 2-25 to 2-27
manual. See documentation.
maximum sampling rate per channel, 7-5
Measure Frequency VI, 24-5 to 24-6
Measure Pulse Width or Period VI
determining pulse width, 23-2 to 23-3
measuring frequency and period, 24-4
measurement system
choosing, 5-3 to 5-6
differential measurement system, 5-9
to 5-10
nonreferenced single-ended
measurement system, 5-11 to 5-12
referenced single-ended measurement
system, 5-10 to 5-11
memory allocation errors (Windows), A-3
to A-4
Microsoft Windows. See Windows
environment.
multiple-channel single-point analog input,
6-2 to 6-5
multiple-immediate updates, 11-2 to 11-3
multiple-waveform acquisition
choosing between single-point and
multi-point acquisition, 4-4
procedure for acquiring, 7-3 to 7-5
multiplexed mode (SCXI)
analog input modules, 17-4
analog output modules, 17-4
channel addressing, 18-1 to 18-2
digital and relay modules, 17-5
SCXI-1200 (Windows), 17-4
My Single Scan Processing VI, 6-5
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NI-DAQ file for Macintosh, 2-3
NI-DAQ software

deciding which driver version to use, A-4

installing in UNIX, 2-19

Macintosh device drivers, 2-3

relationship between LabVIEW,
NI-DAQ, and DAQ hardware
(figure), 2-3

user privilege level in Windows NT, 2-15

versions of NI-DAQ drivers (note), 2-1
Windows device drivers, 2-3
Windows NT device drivers, 2-3
NI-PNP.EXE utility, 2-10
NI-PNP.INI file, 2-10
NIDAQ.DLL file, 2-3
NIDAQNT.DLL file, 2-3
nivisrd.386 device, A-4
non-buffered handshaking, 15-5 to 15-6
non-referenced signal sources, 5-2
nonlatched digital I/0, 14-1 to 14-3
nonreferenced single-ended (NRSE)
measurement system, 5-11 to 5-12
16-channel NRSE system (figure), 5-11
when to use, 5-12
Nyquist frequency, 5-2
Nyquist Theorem, 5-2

0

OBF (Output Buffer Full) line, 15-2
one-point calibration, 20-4 to 20-6
one-shots, 22-6

OUT output pin, 21-2

OUT signal, 21-3 to 21-4

Output Buffer Full (OBF) line, 15-2

P

parallel mode (SCXI)
analog input modules, 17-5
channel addressing, 18-1 to 18-2
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digital modules (Macintosh and
Windows), 17-6
SCXI-1200 (Windows), 17-6
parameters for VIs
common DAQ VI parameters, 3-7 to 3-8
conventions, 3-6 to 3-7
pattern generation, 15-2
PCMCIA bus computers, configuring, 2-6
to 2-9
PCMCIA cards, inserting with computer
running (note), 2-5
period measurement. See frequency and
period measurement.
Plug and Play (switchless) DAQ devices,
configuring, 2-10
Plug and Play software for configuring
devices, 2-10 to 2-11
polling for analog input, 6-10
ports
digital ports and lines, 13-1
grouping ports without
handshaking, A-2
problems accessing ports 2 or higher
(Windows), A-3
VI port addressing, 3-9 to 3-11
pressure measurement with strain gauges
(example), 19-11 to 19-14
Probe tool, 27-4
Pulse Generator Config VI, 24-6
pulse train generation, 22-5 to 22-8
continuous pulse train, 22-5 to 22-7
duty cycles, 22-2 to 22-3
finite pulse train, 22-7 to 22-8
illustration, 22-2
physical connections for generating
continuous pulse train (figure), 22-5
finite pulse train (figure), 22-7
terminology related to, 22-2
pulse width measurement, 23-1 to 23-4
controlling pulse width
measurement, 23-3
counting input signals (figure), 23-1
determining pulse width, 23-2 to 23-3
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increasing measurable width range, 23-4
measuring pulse width, 23-1 to 23-2
overview, 23-1
physical connections for determining
pulse width (figure), 23-2
Pulse Width or Period Meas Config VI
controlling pulse width
measurement, 23-3
measuring frequency and period, 24-4
to 24-5
pulsed counter signal generation, 22-1

Q

questions
about using DAQ devices, 4-3 to 4-5
LabVIEW data acquisition common
questions, A-1 to A-5

R

range of device voltage, 5-4 to 5-5
considerations for selecting analog input
settings, 5-6 to 5-8
description, 5-4 to 5-5
effect on ADC precision (figure), 5-5
measurement precision for various device
ranges and limit settings (table), 5-8
Read from Digital Line VI, 14-2
Read from Digital Port VI, 14-2
referenced signal sources, 5-2
referenced single-ended (RSE) measurement
system, 5-10 to 5-11
16-channel RSE system (figure), 5-11
relay SCXI modules, 17-5
REQ (Request) line, 15-2
Resistance-Temperature Detectors (RTDs),
19-9 to 19-11
resolution of ADC, 5-3 to 5-4
effects on ADC precision (figure), 5-4
round-robin scanning (figure), 9-2
row major order, 3-14
RSE. See referenced single-ended (RSE)
measurement system.
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RTDs for measuring temperature, 19-9
to 19-11
run_me.llb DAQ example file, 3-2

S

SC-2042 RTD device, 19-10
Scale Constant Tuner VIs, 20-7
Scaling Constant Tuner VI, 19-7
scan clock, 9-5 to 9-8
channel and scan intervals using channel
clock (figure), 9-2
devices without scan clocks (note), 9-6
input pins (table), 9-6
lack of external scan clock support in
NB-MIO-16X board, 9-7
MIO device ScanClock output
(note), 9-6
scan-clock orientation of LabVIEW, 9-2
simultaneous control of scan and
channel clocks, 9-8
scans
channel clock rate parameter, 5-17
definition, 5-17
interval scanning, 5-17
maximum scan rate, calculating, 7-5
number of samples parameter, 5-17
number of scans to acquire
parameter, 5-17
round-robin scanning (figure), 9-2
scan rate parameter, 5-17
SCXI-112x Thermocouple example VI, 19-9
SCXI-116x Digital Output VI, 19-18
SCXI-1100 One-Point Calibration
example, 20-5
SCXI-1100 Two-point calibration
example, 20-6
SCXI 1124 Update Channels VI, 19-14
SCXI-1162/1162HV Digital Input VI, 19-16
SCXI-1200 module
multiplexed mode (Windows), 17-4
parallel mode (Windows), 17-6
SCXI application examples, 19-1 to 19-19
analog input application for measuring
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temperature, 19-2 to 19-5

analog output application, 19-14 to 19-15
digital input application, 19-15 to 19-16

digital output application, 19-16 to 19-18
multi-chassis applications, 19-18 to 19-19

overview, 19-1 to 19-2

pressure measurement with strain gauges,

19-11 to 19-14
temperature measurement applications
amplifier offset, 19-4 to 19-5
sensors for cold-junction
compensation, 19-3 to 19-4
using RTDs, 19-9 to 19-11
using thermocouples, 19-2 to 19-5
VI examples, 19-5 to 19-9
SCXI Cal Constants VI
automatic calculation of calibration
constants, 20-3
calibrating SCXI modules for signal
generation, 20-8
loading saved calibration constants,
20-7, 20-8
one-point calibration, 20-5
overwriting default constants in
EEPROM, 20-2
two-point calibration, 20-6 to 20-7
SCXI calibration, 20-1 to 20-8
EEPROM for storing calibration
constants, 20-1 to 20-3
default load area, 20-2
factory area, 20-2
user area, 20-2 to 20-3
one-point calibration, 20-4 to 20-6
reasons for calibrating, 20-3 to 20-4
signal acquisition, 20-3 to 20-7
signal generation, 20-7 to 20-8
two-point calibration, 20-6 to 20-7
SCXI modules
components
chassis (figure), 17-3
illustration, 17-2
overview, 17-2
hardware configurations
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illustration, 17-1
overview, 17-1
Windows or Macintosh systems,
2-20 to 2-21
software configuration
Macintosh systems, 2-25 to 2-27
Windows environment, 2-21 to 2-25
when to use, 4-3
SCXIT operating modes, 17-3 to 17-6
multiplexed mode
analog input modules, 17-4
analog output modules, 17-4
channel addressing, 18-1 to 18-2
digital and relay modules, 17-5
SCXI-1200 (Windows), 17-4
parallel mode
analog input modules, 17-5
channel addressing, 18-1 to 18-2
digital modules (Macintosh and
Windows), 17-6
SCXI-1200 (Windows), 17-6
SCXI programming considerations, 18-1
to 18-5
channel addressing, 18-1 to 18-2
gains, 18-2 to 18-4
SCXI-1100 channel arrays, input
limits array, and gains
(table), 18-4
settling time, 18-5
SCXI Temperature Monitor VI, 19-8
SCXI Voltage example, 19-5
settling time (SCXI), 18-5
SETUP program, for ISA bus computers, 2-9
signal conditioning
amplification, 16-3 to 16-4
common transducers (table), 16-1
to 16-2
common types of signal
conditioning, 16-2
conditioning for common types of
transducers/signals (figure), 16-3
definition, 16-2
filtering, 16-5

© National Instruments Corporation



isolation, 16-4
linearization, 16-5
transducer excitation, 16-5
signal divider, 26-1
signal edges, 21-2
signal voltage range. See limit settings.
signals. See also analog input signals.
choosing between analog and digital
signal analysis, 4-3
simple-buffered analog input
data buffer overview, 7-1 to 7-2
examples
displaying waveforms on graphs, 7-6
to 7-7
sampling with multiple starts, 7-7
to 7-9
writing to spreadsheet file, 77-9
multiple-waveform acquisition, 7-3 to 7-5
single-waveform acquisition, 7-2 to 7-3
waiting to analyze data, 7-1 to 7-2
Simple Error Handler VI
analog output SCXI example, 19-15
debugging VIs, 27-2 to 27-3
multiple-channel single-point analog
input, 6-5
single-channel single-point analog input
choosing between single-point and
multi-point acquisition, 4-4
description, 6-1 to 6-2
single-ended measurement system
nonreferenced, 5-11 to 5-12
referenced, 5-10 to 5-11
single-immediate updates, 11-1 to 11-2
single-point analog output
choosing between single-point or
multiple-point generation, 4-4
overview, 10-1
single-stepping through VIs, 27-3
single-waveform acquisition, 7-2 to 7-3
software configuration errors, debugging, 27-1
to 27-2
software-timed analog input/output control
loops, 6-6 to 6-7
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software timing, 10-1
software triggering
description, 8-10 to 8-12
examples, 8-12 to 8-14
timeline of conditional retrieval
(figure), 8-11
SOURCE input
increasing measurable width range, 23-4
measuring pulse width, 23-1 to 23-2
SOURCE input pin, 21-2
spreadsheet files
Cont Acq to Spreadsheet File.vi, 7-15
simple buffered-analog input
example, 7-9
square pulse generation, 22-1 to 22-5
overview, 22-1 to 22-3
single square pulse generation, 22-3
to 22-5
Generate Delayed Pulse VI, 22-4
physical connections (figure), 22-4
using Intermediate Vs, 22-4 to 22-5
STB (Strobe Input) line, 15-2
strain gauges for measuring pressure
(example), 19-11 to 19-14
Strobe Input (STB) line, 15-2

T

technical support, B-1 to B-2
telephone and fax support, B-2
temperature measurement applications
(SCXI)
amplifier offset, 19-4 to 19-5
sensors for cold-junction compensation,
19-3 to 19-4
using RTDs, 19-9 to 19-11
using thermocouples, 19-2 to 19-5
VI examples, 19-5 to 19-9
terminal count (TC), 21-4
thermocouples for measuring temperature
(example), 19-2 to 19-5
timebase period uncertainty, 22-8 to 22-9
toggled counter signal generation, 22-1
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transducers
common transducers (table), 16-1 to 16-2
excitation, 16-5
linearization, 16-5
signal conditioning for common types of
transducers/signals (figure), 16-3
transposing arrays, 7-7
triggered data acquisition, 8-1 to 8-14
analog triggering
description, 8-6 to 8-7
examples, 8-7 to 8-10
choosing between triggering and external
clock control, 4-4
deciding which digital trigger setting to
use, A-2
digital triggering
description, 8-2 to 8-3
examples, 8-3 to 8-6
hardware triggering, 8-1 to 8-10
overview, 8-1
software triggering
description, 8-10 to 8-12
examples, 8-12 to 8-14
triggering, definition, 8-1
triggers, definition, 8-1
two-dimensional (2D) arrays, 3-13 to 3-16
two-point calibration, 20-6 to 20-7

u

UNIX operating system
installation and configuration of DAQ
devices
DAQ device configuration, 2-19
to 2-20

NI-DAQ software, 2-19
overview, 2-18 to 2-19

user privilege level, Windows NT, 2-15

Utility VIs, 3-6. See also Vls.
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v

VIs. See also specific VIs.

Advanced Vs, 3-6

channel, port, and counter addressing,
3-9to 3-11

common DAQ VI parameters, 3-7 to 3-8

crashing VIs in Windows, A-3

data organization for analog
applications, 3-13 to 3-16

debugging, 27-1 to 27-4

default and current value
conventions, 3-7

Easy VIs, 3-5

error handling, 3-8 to 3-9

finding VIs in LabVIEW, 3-2 to 3-4

Intermediate VIs, 3-5 to 3-6

limit settings, 3-11 to 3-13

organization, 3-4 to 3-5

parameter conventions, 3-6 to 3-7

SCXI examples, 19-5 to 19-9

Utility VIs, 3-6

W

Wait Until Next ms Multiple VI
improving control loop
performance, 6-10
multiple-channel single-point analog
input, 6-5
software-timed analog 1/O control
loops, 6-6
Wait (ms) VI, 6-10, 22-9
waveform generation. See buffered analog
output.
WDAQCONEF utility
configuring DAQ devices
EISA bus computers, 2-9
ISA and PCMCIA bus computers,
2-6to 2-9
testing and configuring in Windows,
2-11to 2-14
icon in Windows (figure), 2-6
locating in Windows (figure), 2-6
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WDAQCONEF.CFG file, 2-6
Wheatstone bridge, 19-12
Windows environment
installation and configuration
EISA bus computers, 2-9
inserting PCMCIA cards (note), 2-5
ISA and PCMCIA bus computers,
2-6 to 2-9
multiple DAQ devices (note), 2-5
Plug and Play (switchless) DAQ
devices, 2-10
Plug and Play software, 2-10 to 2-11
SCXI hardware, 2-20 to 2-21
SCXI software, 2-21 to 2-25
using WDAQCONEF, 2-11 to 2-14
NI-DAQ drivers, 2-3
questions and answers, A-3 to A-4
Windows 95 users (note), 2-1
Windows NT environment
LabVIEW considerations, 2-14 to 2-15
changing I/0 page lock limit, 2-14
to 2-15
user privilege level, 2-15
NI-DAQ drivers, 2-3
Write N Updates example VI
multiple-immediate updates, 11-2 to 11-3
single-immediate updates, 11-1to 11-2
Write to Digital Line VI, 14-2
Write to Digital Port VI
digital output application, 19-16 to 19-17
immediate digital I/O, 14-2
Write to Spreadsheet File VI, 7-9
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